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Commands

The Painter menu bar contains commands organized into six different menus.

For more information, select the desired menu.

File Menu

Edit Menu

Effects Menu

Options Menu

Windows Menu

Brush Stroke Menu



Brush Stroke Menu

The Brush Stroke menu includes commands that enable you to draw straight lines, draw freehand, record
and playback brush strokes and complete Painter sessions.

For more information, select the Brush Stroke menu command name.

Auto Playback Plays back a recorded brush stroke randomly until stopped.

Draw Freehand Turns on and off Freehand drawing mode.

Draw Straight Lines Turns on and off Straight Line drawing mode.

Playback Session Displays menu of recorded sessions.

Playback Stroke Plays back a recorded brush stroke each time mouse or stylus is clicked.

Record Options Let's you record session as is or record so you can change colors and tools 
later.

Record Session Records a Painter session.

Record Stroke Records a brush stroke.

Stop Playback Stops playback of a brush stroke.

Stop Recording Session Stops recording of a Painter session.



Edit Menu

The Edit menu includes commands that enable you to move an image area to and from the Clipboard, to 
delete an image area, and to undo a previous editing operation.

For more information, select the Edit menu command name.

Clear Clears selected area without affecting the Clipboard.

Copy Copies an area to the Clipboard.

Cut Cuts a selected area and moves it to the Clipboard.

Deselect Deselects portion or all of an image.

Fade Partially undoes the last operation.

Magic Wand Accesses the Magic Wand and dialog box.

Paste Pastes an area from the Clipboard.

Paste Into New Picture Pastes contents of Clipboard into a new picture.

Select All Selects the entire visible image area.

Reselect Reselects and makes active a frisket or friskets.

Set Preferences Allows setting of user preferences.

Undo Cancels the previous operation.



Effects Menu

The Effects menu includes commands that enable you to change the appearance of your image in a 
number of ways, including using third-party plug-in filters. The commands listed below are found in the 
pop-up menus called Tonal Control, Orientation, Surface Control, Focus and Esoterica.

For more information, select the Effects menu command name.

Adjust Dye Concentration Adjusts color intensity and adds surface texture.

Apply Lighting Lets you establish one or more light sources of any color from any direction
with any intensity. Requires a floating point unit.

Apply Marbling Creates marbled patterns and is based on an actual technique of pulling on
ink or pigment that floats on liquid in a pan.

Apply Screen Controls light, dark and mid-tone levels when applying textures to an 
image.

Apply Surface Texture Adds a three-dimensional surface texture to images.

AutoClone Automatically clones whole or selected part of an image.

Auto VanGogh Automatically re-renders an image with the multi-colored brush strokes of 
Van Gogh.

Blobs Makes a pattern in paint floating on liquid in a pan. Requires a floating 
point unit.

Brightness/Contrast Adjusts contrast and brightness of overall image in grayscale format.

Color Overlay Adds color and texture to your image at the same time.

Distort Allows warping of whole or selected part of an image.

Enforce Printable Colors Changes the colors in your image to printable colors.

Equalize Improves contrast, adjusting black and white points and distributing the 
pixels' brightness levels throughout the entire range of available brightness 
levels in an image.

Fill Fills whole or selected part of an image.

Flip Horizontal Flips whole or selected part of an image horizontally.

Flip Vertical Flips whole or selected part of an image vertically.

Glass Distortion Makes you image appear to be behind glass.

Grid Paper Add horizontal or vertical lines or a grid to your image.

Highpass Suppresses low frequency areas containing gradual or smooth transition of
brightness levels.

Motion Blur Makes your image appear as if it has been blurred by movement or the 
panning of a camera.

Negative Turns whole or selected part of an image into a negative.

Plug-in Filters Allows access to third-party filters, such as Aldus Gallery Effects.



Posterize Limits the number of color levels in an image.

Rotate Rotates whole or selected part of an image in user-selectable one-degree 
increments.

Scale Lets you change the dimensions of part or all of your image.

Sharpen Heightens contrast by intensifying highlights and shadows.

Soften Increases the transition from one part of image to another.

Video Legal Colors Allows setting up of colors for use with video.



File Menu

The File menu includes commands that enable you to open and save files, establish a new workspace, 
and to print.

For more information, select the File menu command name.

Acquire Access scanner interface.

Clone Clone a picture.

Close Close a picture.

Exit Exit Painter.

Export Export a picture to a foreign file type.

New Create a new picture.

Open Open a picture.

Printer Setup Set up page characteristics for printing.

Print Print a picture.

Resize Lets you change image dimensions or resolution or both.

Revert Revert changes to last saved picture.

Save Save picture using same name and file type.

Save As Save picture as a different name or file type.

Select Source Select a scanner.



Options Menu

The Options menu provides commands to choose among various Painter options. Some of the 
commands below are found in the pop-up menus called Custom Brush and Movers.

For more information, select the Options menu command name.

Brush Look Mover Allows the creation of a Brush Looks library and the moving of Brush Looks
from one library to another.

Brush Mover Allows the creation of a Brush library and the moving of brushes from one 
library to another.

Capture Texture Lets you turn brush strokes or a section of an image into a surface texture.

Delete Variant Allows you to delete the active variant.

Dry Dries the Wet Layer.

Frisket Mover Allows the creation of a Frisket library and the moving of friskets from one 
library to another.

Grid Options Opens dialog that allows you to set up size and color of a non-printing grid.

Grid Overlay Turns on and off the grid described in Grid Options. Can also be accessed 
using the Grid icon at the top of the vertical scroll bar.

Make Repeating Texture Make your own textures based on the patterns in the Patterns pop-up 
menu.

Paper Mover Allows the creation of a Paper library and the moving of paper textures 
from one library to another.

Restore Default Variant Restores modified variant to its original state.

Save Brush Allows you to create a new brush category in the Brush Palette using a 
selected image in the image window.

Save Built Variant Saves changes to default brushes.

Save Variant Lets you save a new variant.

Set Scaling Sets brush stroke scaling factors for pressure-sensitive stylus.

Session Mover Allows the creation of a Sessions library and the moving of Sessions from 
one library to another.

Set Clone Source Establish the active image as a clone source.

Tracing Paper Turns on or off tracing paper when using cloned image.

Wet Paint Turns on the Wet Layer, necessary for painting with water color.



Windows Menu

The Windows menu includes commands that enable you to open and close the Painter tool and palette 
windows, set the zoom factor of the edit windows and select between open edit windows.

For more information, select the Windows menu command name.

Brush Behavior Opens / Closes the Brush Behavior Window.

Brush Looks Opens / Closes the Brush Looks Window.

Brush Palette Opens / Closes the Brush Palette.

Brush Size Opens / Closes the Brush Size Window.

Brush Stroke Designer Opens / Closes the Brush Stroke Designer Window.

Color Palette Opens / Closes the Color Palette.

Expression Palette Opens / Closes the Expression Palette.

Fill Palette Opens / Closes the Fill Palette.

Frisket Palette Opens / Closes the Frisket Palette.

Full Screen Mode Toggle Toggles between normal screen view and full screen view.

Hide Palettes Shows/Hides palettes.

Paper Palette Opens / Closes the Paper Palette.

Toolbox Opens / Closes the Toolbox.

Zoom Factor Shows choices for reducing or enlarging image in editing window.



Glossary

Many of the terms used in Painter are described in this glossary. To get a definition on any of these topics,
click on the term.

3D Brush Strokes

Adjust Dye Concentration

Anti-Aliased

Apply Screen

Apply Surface Texture

Bitmap

Bleed

Brightness

Brush

Brush Behavior window

Buildup Methods

Clone

Clone Document

Cloner

Cloning Methods

Color Overlay

Color Palette

Color Ramp

Color Squares

Comp

Concentration

Contiguous Pixels

Continuous Tone Image

Contrast

Cover Methods

Dot Gain



Drip

Drip Cloning

Drip Methods

Equalize

EPS

Expression Palette

Fade

Feathering

Flat Cover

Frisket

Gamma

Grainy Drip

Grainy Edge Flat Cover

Grainy Edge Flat Buildup

Grainy Flat Cover

Grainy Hard Buildup

Grainy Hard Cover

Grainy Hard Cover Cloning

Grainy Hard Drip

Grainy Soft Buildup

Grainy Soft Cover

Grainy Soft Cover Cloning

Grainy Wet Abrasive

Grainy Wet Buildup

Halftone

Halftone Resolution

Hard Drip

Hard Cover Cloning

Highlights

Highpass

HSV



Image Buffer

Jitter

LPI

Luminance

Method

Mid-tones

Min Spacing

No. of Bristles

Original Luminance

Overlapping Rectangles

Paper Palette

Penetration

Pixels

Plug-ins

Posterize

PostScript

PrsPower

PrsScale

Resolution

RGB

Screen

Screen Angle

Screen Frequency

Shadows

Sharpen

Size

Soft Buildup

Soft Cover



Soft Cover Cloning

Soften

Soft Mask Colorize

Soft Paint Remover

Soft Paint Thickener

Soft Paper Color

Soft Variable Buildup

Spectrum Slider

Spot

Triangle

Use Clone Color

Variant

Vel Power

Vel Scale

Virtual Memory

Wet Fringe

Wet Methods

Wet Layer

Wet Remove Density

Zoom Box



Procedures

This topic is procedurally oriented and provides step-by-step instructions for the basic tasks performed in 
Painter. To get more information on one of these procedures, click on the desired procedure.
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Input and Output

Record and Playback



Brushes

When you want to buy a new 2B pencil, you go to the art supply store. When you want one in Painter, you
go to the Brush Palette. Choosing a tool in this window is easy. You scroll in the Brush Palette until you 
see the tool you want, then you click on its picture. You can tell which tool is currently selected by the 
black line around its picture and its name displayed below. All art supplies have some features in 
common. The following sections describe these universal characteristics.

Selecting a Variant

Tear-Off Feature

Brush Size Window

Paper Palette

Penetration and Concentration

Color Palette

Painting Tools

Drawing Tools

Method

Brush Behavior

Creating Textures

Expression Palette

Saving Variants

Saving Brushes

Brush Stroke Designer

Brush Looks



Selecting a Variant

Each brush has one or more variants or preprogrammed modifications from which to choose. To better 
understand variants, imagine buying a set of paint brushes. The different brush sizes and styles would be 
the variants.

To select a variant:

1. Click and hold in the variant pop-up menu.

2. Drag to the variant name you desire.

3. When the variant is highlighted, release the stylus or mouse button.



Tear-Off Feature

The handiest way to work is to have your tools right next to you, not across the room. In Painter, you can 
literally take tools out of the Brush Palette and place them next to your composition. 

1. Select the variant of the tool that you would like to work with.

2. Click on the art supply picture and drag it to where you would like it to be. 

3. Let go of the stylus or the mouse. Notice that the name of the variant you selected appears at the 
bottom of the window. You can move every variant out of the Brush Palette if you'd like. 

To move the window somewhere else, click and drag on its title bar. When you're done with the tool, 
clicking on its close box will remove it from the screen. However, all variants remain in the Brush Palette 
and can be chosen from there even if that variant is elsewhere on the screen.



Brush Size Window

You can determine the width of the strokes made by any of the brushes by choosing Windows: Brush 
Size (Ctrl+4), which calls up the Brush Size window. The dot in the window shows you the size of the 
stroke the tool will make. Clicking and dragging the slider to the right widens the stroke, dragging to the 
left thins it out. You can also click in the shaded area of the slider to select a new width. After you have 
resized the brush stroke, you have to click on the Build button before the new width will take effect.



Paper Palette

Many of Painter's tools interact with paper grain.

To select a paper texture:

1. Choose Windows: Paper Palette.

2. Scroll to find the paper texture you'd like.

3. Click on its picture. As in the Brush Palette, the selected paper texture has a black line around its 
picture and its name appears below.

Painter provides several paper libraries.

To access a different paper library:

1. Click on the zoom box to expand the window.

2. Click on the Library button.

3. Double click on the name of the paper library you desire. You'll see a new set of textures when you 
scroll through the    palette.

The paper you choose applies only to individual strokes, not to the entire image. This means that you can 
use a different texture with every stroke you make. You can, however, apply paper texture to your overall 
image.



Penetration and Concentration

Clicking on the Brush Palette zoom box reveals two ways to alter the appearance of strokes made by 
Painter's brushes: Penetration and Concentration. Penetration controls how much color will penetrate into
the paper for those brushes that interact with paper grain in real life such as chalk and charcoal.

Moving the Penetration slider to the right intensifies penetration into paper grain, making the color seem 
darker and letting less paper grain show through. Moving the slider to the left reduces the stroke's 
intensity, revealing more paper grain.

Concentration, meanwhile, works in one of two ways, depending on the tool. In Painter, brush strokes 
either hide underlying brush strokes or darken them toward black, depending on how the tool operates 
traditionally. So Painter's chalk strokes hide or cover what's beneath them, while those done with felt pens
build upon underlying strokes, making them darker. Increasing Concentration by moving the slider to the 
right makes hiding power brushes more opaque, and build-up brushes muddy-up toward black more 
quickly.



Color Palette

Using the Color Palette is the main way to select a color for your brush stroke. In the Color Palette you'll 
be able to select pre-set default colors or choose colors randomly, determining hue, saturation and value. 
You'll also be able to designate primary and secondary colors for your brush strokes.

Spectrum Slider

The spectrum slider is the key to the Color Palette. Clicking and dragging on the indicator reveals, and 
letting go selects, the predominant hue in the triangle. You can also select the predominant hue by 
clicking once anywhere in the spectrum slider. Clicking in the arrows at either end of the slider lets you 
home in on the exact color you're looking for. 

Triangle

The triangle offers all the available colors within a predominant hue.

The colors in the triangle are organized by the value and the saturation of the color. Values span the 
triangle from top to bottom, with the top of the triangle being the highest value, or white, the bottom the 
lowest value, or black. Saturation levels go from left to right, so dragging to the right gives you the purest 
color within the predominant hue, dragging to the left gives you muddier or grayer colors.

To select a color in the triangle:

1. Click and drag in the triangle. This turns the cursor into the Eye Dropper and places the Current Color 
Ring under it. The areas you drag over are displayed in the primary color overlapping rectangle.

To select a color:

1. If you've been dragging in the triangle, let go. The color is selected.

2. You can also just click on the triangle to select a color.

Note: To easily select black, click anywhere in the triangle, drag down below the triangle, and let up on 
the mouse or stylus. To easily select white, drag up instead of down. Whenever you launch Painter, the 
default Current Color Ring location is black.

Color Squares

The 14 squares on the right-hand side of the Color Palette are pre-set default color families. Clicking on a 
square automatically gives you the predominant hue in the Triangle to work with. These colors have been 
grouped either according to brush or category. The ones grouped by brush represent the colors available 
for the brush's real-life equivalent. So the Pencil colors correspond to those available for colored pencils.

The way the color comes out when you apply a stroke in the image window is determined by the nature of
the brush. For instance, if you have a pencil color square chosen, and you are painting with the airbrush, 
it will still resemble airbrush spray, not a pencil line.

There are also categories such as bright primaries and shades of gray. 

In Painter 2.0 the color squares are on pages that you can turn, giving you easy access to any pre-set 
color at any time, regardless of the brush that you have chosen. To select a page in the color pad, either 
click on the gray folded corner (the dog-ear) to turn the pages forward or click in the white space next to it 
to go back to previous pages.

To go directly to a palette without turning the pages: 

1. Expand the Color Palette if it isn't already by clicking in the zoom box in the upper right-hand corner.

2. Click Palette... The User Color Palettes dialog box appears.



3. Click on the Palette you wish to use.

4. Click OK or press Enter.

To choose a color to paint with from a Color Square:

1. Move the cursor over the square. The cursor will become the Eye Dropper.

2. Click on the square with the Eye Dropper.

3. You'll see the triangle colors change, reflecting the new predominant hue based on your selection. The 
Current Color Ring in the triangle will be on the color of the square that you selected.

These squares are colors that were selected in the triangle. You can pick your own color and make it a 
square as well.

To change the color of a Color Square:

1.    Pick the color in the triangle that you want to make a Color Square.

2.    Hold down the Alt key.

3.    Click in a square. The square becomes the color you selected in the triangle.

Note: When you leave that page in the Color Square palette and return to it, the colors revert to what they
were before you Alt-clicked.

Color Square Palettes

You can save color squares permanently in Painter 2.0 by creating your own Color Square palettes. This 
means that you can set up the colors for a project, for instance, and access them with any brush.

To create a new Color Square palette:

1. Expand the Color Palette if it isn't already by clicking in the zoom box in the upper right-hand corner.

2. Set up the new color squares you wish to save by Alt-clicking your preferred colors into each square as
described previously.

3. Click on Palette... The User Color Palettes dialog box appears.

4. Click on Save. The Save Palette dialog box appears.

5. Type in the name of your new palette.

6. Click OK or press Enter.

To delete a color square palette:

1. Click Palette... The User Color Palettes dialog box appears.

2. Click on the palette you wish to delete.

3. Click Delete.

Overlapping Rectangles

Brush strokes can consist of one, two, or many colors, including a primary color, a secondary color, and 
the range of colors in between. The overlapping rectangles display these primary and secondary colors. 
The front rectangle is the primary color. The back rectangle is the secondary color.

You can "turn off" the secondary color and interim color range so that your brush strokes are a solid color, 
or you can have multi-colored brush strokes.

To see how a bi-colored brush works, try the following:

1. Select the graduated brush variant of the Brush in the Brush Palette.



2. Click on the front rectangle in the Color Palette to select it.

3. Select a color by either clicking in a color square or in the triangle. The rectangle is now the color you 
selected.

4. Click on the rear rectangle and give it another color the same way.

5. Click back on the front rectangle to make it active so that you won't get confused when you go to do 
something later.

6. Click and drag in the image. You'll see your brush strokes contain the two colors you just selected.

The way to control whether a brush's strokes will have one or two colors is by choosing one of the items 
in the Color pop-up menu in the Expression Palette.

Printable Colors

Besides displaying the stroke color, in Painter 2.0 the overlapping rectangles also show you how the color
you choose will print. Your monitor displays many more colors than can actually be printed on an offset 
press. The rectangles can display the printable color that's closest to the on-screen color you select.

To view printable colors:

1.    Choose a bright blue by making sure that the selection ring is in the right-hand point of the triangle.

2. Expand the Color Palette if it isn't already by clicking on the zoom box in the upper right-hand corner.

3. Check Printable Colors Only. The on-screen color is on the left-hand side of the rectangle and the 
printable color is on the right-hand side.

Note: If the color in the color rectangle appears solid, the color is printable.

Once you check Printable Colors Only in the Color Palette, your brush strokes will be the same color as 
the right-hand side of the rectangle.

Printable Colors

If you forget to check Printable Colors Only before you paint part or all of your image, you can go in after 
the fact and change the colors to printable colors.

Here's how:

1. Select part of your image. Otherwise, Painter will apply printable colors to the entire image.

2. Choose Effects: Tonal Control: Enforce Printable Colors... The Enforce Printables dialog box 
appears.

3. Click OK or press Enter.

Video Legal Colors

Painter 2.0 also has the ability to set up colors for use in video.

1. Select part of your image. Otherwise, Painter will make all colors legal for video.

2. Choose Effects: Tonal Control: Video Legal Colors... The Video Legal colors dialog box appears.

3. Click OK or press Enter.

Painter supports both the NTSC (U.S.) and PAL (European) video systems, selectable in the System pop-
up menu in the Video Legal Colors dialog box.

Only bright yellows and cyans are not video legal.

±HSV Variability Sliders

In addition to bi-color brush strokes, Painter's brushes can be set up to paint multiple colors as well. You'll 



do this by adjusting the ±HSV color variability sliders in the Color Palette.

When you zoom open the Color Palette, you reveal the ±HSV sliders, which control ranges of hues, 
saturations and values.

Moving the ±Hue slider to the right increases the number of hues in the brush stroke. These colors are 
the ones to the left and right of the color you picked if you look at the spectrum slider.

Moving the ±Saturation slider to the right increase the range of saturations in the brush stroke.

Moving the ±Value slider to the right increases the range of luminances in the brush stroke.

Moving these sliders to the right is most useful when you're working with the Van Gogh and Seurat 
variants of the Artists brush since both imitate multi-colored brush strokes. When you choose the 
Impressionists Color Squares palette and click in any color square, you'll see the sliders have been pre-
set for you. This is also the case for the Hairy Brush Color Squares palette.

The hairy lines of this brush are in part created by the ±HSV sliders being moved to the right. When you 
choose the other Color Square palettes you'll see that the ±HSV sliders are set at zero. You can try 
different ±HSV slider settings with any of the brushes to get some interesting results.

When you move any of these sliders, only the front rectangle will preview variability. This preview also 
appears in the color squares palette if you Alt-click in a color square.



Saving Variants

To save your brush alterations as a variant of the current brush:

1. Select Options: Custom Brush: Save Variant... The Save Variant dialog box appears.

2. Type in a name for your variant, say blunt pencil as a variant to a pencil.

3. Click OK or press Enter.

You will now see Blunt Pencil in the Pencil Variant pop-up menu. A brush can have up to 32 variants.

To delete a variant:

1. Select the variant in the Variant pop-up menu.

2. Choose Options: Custom Brush: Delete Variant... Painter asks if you want to delete the variant.

3. Click Yes or No.

Save Built Variant

You can also save changes to a variant without creating a new one. For instance, you may feel that the 
stroke width for the Sharp Chalk variant would never be useful to you unless you tapered it more in the 
Brush Size window.

To save changes to an existing variant, choose Options: Custom Brush: Save Built Variant... Your 
changes are now incorporated into the variant.

You may decide, though, that the original variant was the one you wanted after all. To get back the original
variant settings, select the variant in the pop-up menu, then choose Options: Custom Brush: Restore 
Default Variant. The variant now has its original default settings.



Drawing Tools

Want to create digital drawings that resemble real-life renderings? Painter provides you with the tools, 
including Pencils, Chalk, Charcoal, Crayons, Pens and Felt Pens.

Pencils

You can use the Pencils for anything you'd use real pencils for, from rough sketches to fine-line drawings. 
Choose Pencil Colors in the Color Palette to get the best results.

To draw with the Pencils:

1. Position the cursor where you'd like to start drawing.

2. Push down on the stylus (or click the mouse) and drag using short or long strokes.

3. When you're done, let up on the stylus (or release the mouse).

Like their real-life counterparts, Pencils interact with paper texture, so you can modify your design based 
on the paper texture you select in the Paper Palette.

Because the Pencils interact with paper grain, the Penetration slider can be used with them. Dragging the
slider to the right makes the pencil stroke penetrate the paper more, resulting in shades looking darker 
and allowing less of the paper texture to show through. Moving the slider to the left reveals more paper 
grain.

If you use a stylus, pressing lightly allows more of the paper texture to show through; if you press heavily, 
the pencil will penetrate the paper grain more, making the shade appear darker, and allowing less of the 
paper texture to show through the stroke.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Penetration slider to the left before you begin a stroke.

Another quality the Pencils share is that they produce strokes that get darker as you layer them. This will 
come in handy when you're shading -- drag over an area once for highlights, repeat strokes for dark 
shadows. As you work with the Pencils you may find that strokes turn black too quickly to suit your 
illustration. Use the Concentration slider to remedy this. By moving it to the left, the strokes will stay 
lighter longer. Moving the slider to the right makes the strokes turn black more quickly.

Except for the Colored Pencils variant, the Pencils are also pressure-sensitive in terms of Concentration, 
that is, the harder you press on the stylus, the blacker your strokes will be.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Concentration slider to the left before you begin a stroke.

You can base Penetration and Concentration on the direction you drag the mouse.

One thing to keep in mind when pencil-sketching is that because the Pencil strokes muddy-up to black, 
you won't be able to add a light pencil stroke to a dark one. If you try, you'll see the stroke get darker or 
not change at all, depending on how dark the underlying line is. You can do one of two things to get a light
stroke on a dark Pencil stroke. Either pick an Eraser and erase, or pick the Chalk, which covers 
underlying strokes. You'll see you can draw a light Chalk stroke over a dark Pencil stroke.

Colored Pencils

Produces lines with semi-anti-aliased edges. Use this brush to get the same effect as using real colored 
pencils. Dragging the stylus or the mouse quickly gives you a thinner line, dragging slowly gives you a 
thicker one.

Thick & Thin Pencils



Using either the stylus or the mouse, the semi-anti-aliased line you draw with this tool will be thick or thin 
depending on the direction in which you drag. 

2B Pencil

A soft lead pencil that produces thin, anti-aliased lines. Dragging the stylus or the mouse quickly gives 
you a thinner line, dragging slowly gives you a thicker one. These thick-and-thin variations are more 
apparent if you drag the ±Size slider in the Brush Size window to the right. Don't forget to click the Build 
button before you drag in the image window.

Sharp Pencil

A hard lead pencil whose strokes are semi-anti-aliased. Dragging the stylus or the mouse quickly gives 
you a thinner line, dragging slowly gives you a thicker one. These thick-and-thin variations are more 
apparent if you drag the ±Size slider in the Brush Size window to the right. Don't forget to click the Build 
button before you drag in the image window.

500 lb. Pencil

Creates fat, semi-anti-aliased lines. Dragging the stylus or the mouse quickly gives you a thinner line, 
dragging slowly gives you a thicker one.

Single Pixel Scribbler

A one-pixel pencil point. Pressure effects concentration.

Chalk

Chalk reproduces the thick, rich texture of real-life pastels. Choose Chalk Colors, Chalk Colors 2 or 
Pastels in the Color Palette for the best results.

To draw with the Chalk:

1. Position the cursor where you'd like to start drawing.

2. Push down on the stylus (or click the mouse) and drag using short or long strokes. 

3. When you're done, let up on the stylus (or release the mouse).

The Chalk interacts with paper grain, and choosing different textures in the Paper Palette will affect Chalk 
strokes. Moving the Penetration slider to the right hides more paper grain, moving it to the left lets more 
paper texture show through. Pressing more heavily on the stylus creates a more solid stroke by 
increasing the degree of penetration into the paper grain; pressing less heavily reveals more paper 
texture. To get the same effect with the mouse, move the Penetration slider to the left before you draw 
with the Chalk. 

Layered Chalk strokes hide underlying ones. Moving the Concentration slider to the right makes the 
stroke more opaque, moving it to the left makes the stroke more transparent. The Chalk variants are also 
pressure-sensitive in terms of Concentration, that is, the harder you press on the stylus, the more opaque 
your strokes will be, the lighter you press, the more transparent they will appear. If you're using a mouse, 
you can get the same effect as pressing lightly with the stylus by moving the Concentration slider to the 
left before you begin a stroke.

You can base Penetration and Concentration on the direction you drag the mouse.

Dragging the stylus or the mouse quickly gives you a thinner line, dragging slowly gives you a thicker one.

Artist Pastel Chalk

Produces a medium width, semi-anti-aliased stroke.

Sharp Chalk

Gives you a sharper version of Artist Pastel Chalk.



Large Chalk

This is a wider version of Artist Pastel Chalk.

Charcoal 

Charcoal behaves like real charcoal and is ideal for sketching. Choose the Shades of Gray color squares 
in the Color Palette for the best results.

To draw with the Charcoal:

1. Position the cursor where you'd like to start drawing.

2. Push down on the stylus (or click the mouse) and drag using short or long strokes. 

3. When you're done, let up on the stylus (or release the mouse).

Charcoal interacts with paper grain, and choosing different paper textures changes how strokes look. 
Moving the Penetration slider to the left will allow more paper texture to show through, moving it to the 
right will increase paper penetration. 

Pressing more heavily on the stylus creates more solid strokes by increasing the degree of penetration 
into the paper grain; pressing less heavily lets more of the paper grain show through. If you're using a 
mouse, you can get the same effect as pressing lightly with the stylus by moving the Penetration slider to 
the left before you begin a stroke.

Layered Charcoal strokes hide underlying ones. Moving the Concentration slider to the right makes the 
stroke more opaque, moving it to the left makes the shade more transparent. The Charcoal variants are 
also pressure-sensitive in terms of Concentration, that is, the harder you press on the stylus, the more 
opaque your strokes will be, pressing lightly will produce more transparent strokes.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Concentration slider to the left before you begin a stroke.

You can base Penetration and Concentration on the direction you drag the mouse.

Dragging the stylus or the mouse quickly gives you a thinner line, dragging slowly gives you a thicker one.

Gritty Charcoal

Gives you a deep-toned, semi-anti-aliased stroke that is thick or thin depending on the direction in which 
you drag the stylus or mouse. 

Default

This variant produces texture-intensive, semi-anti-aliased charcoal lines.

Soft Charcoal

Use Soft Charcoal when you need soft, anti-aliased strokes.

Pen 

Drawing with the Pen variants is like drawing with ballpoint and fountain pens that never clog and never 
run out of ink. 

To draw with the pens:

1. Position the cursor where you'd like to start drawing.

2. Push down on the stylus (or click the mouse) and drag. 

3. When you're done, let up on the stylus (or release the mouse).

These pens have anti-aliased edges and behave most like their real-life counterparts when you select 
black in the Color Palette, stick to the default brush size settings and keep the Penetration and 



Concentration slider where they are. Certainly you can experiment by changing these gauges, but in the 
case of the pens, the defaults are really the optimal settings.

Fine Point

Produces ballpoint pen strokes that react to the paper texture that you choose in the Paper Palette.

Because the Fine Point pen interacts with paper grain, the Penetration slider can be used with it. 
Dragging the slider to the right makes the strokes penetrate the paper more, resulting in shades looking 
darker and allowing less of the paper texture to show through. Moving the slider to the left reveals more 
paper grain.

The Fine Point pen produces strokes that get darker as you layer them. This will come in handy when 
you're shading--drag over an area once for highlights, repeat strokes for dark shadows. As you work with 
the Fine Point pen you may find that strokes turn black too quickly to suit your illustration. Use the 
Concentration slider to remedy this. By moving it to the left, the strokes will stay lighter longer. Moving the 
slider to the right makes the strokes turn black more quickly.

Pressing heavily with a stylus will produce wider lines, pressing lightly will draw thinner lines. These thick-
and-thin variations are more apparent if you move the ±Size slider in the Brush Size window to the right. 
Don't forget to click the Build button before you drag in the image window.

You can base stroke width on the direction you drag the mouse. 

Smooth Ink Pen

Drawing with this pen is like drawing with your favorite fountain pen and ink well, minus the mess and 
fuss. Using a stylus, heavy pressure widens the stroke, light pressure produces a thin stroke. You can 
base stroke width on the direction you drag the mouse. 

The Smooth Ink Pen interacts with paper texture, so you can modify your design based on the paper 
texture you select in the Paper Palette.

Because the Smooth Ink Pen interacts with paper grain, the Penetration slider can be used with it. 
Dragging the slider to the right makes the strokes penetrate the paper more, resulting in shades looking 
darker and allowing less of the paper texture to show through. Moving the slider to the left reveals more 
paper grain.

If you use a stylus, pressing lightly allows more of the paper texture to show through; if you press heavily, 
the stroke will penetrate the paper grain more, making the shade appear darker, and allowing less of the 
paper texture to show through the stroke.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Penetration slider to the left before you begin a stroke.

The Smooth Ink Pen produces strokes that get darker as you layer them. This will come in handy when 
you're shading -- drag over an area once for highlights, repeat strokes for dark shadows. As you work with
the Smooth Ink Pen you may find that strokes turn black too quickly to suit your illustration. Use the 
Concentration slider to remedy this. By moving it to the left, the strokes will stay lighter longer. Moving the 
slider to the right makes the strokes turn black more quickly.

You can base Penetration on the direction you drag the mouse. 

Calligraphy

It's now possible to hand-letter headlines in newsletters and comps--just pick up your Calligraphy pen! 
With this variant, pressing harder creates wider strokes, pressing less heavily creates thinner lines. You 
can base stroke width on the direction you drag the mouse.

Using either the stylus or the mouse, you can also vary line width by dragging in different directions. 
Keeping the Concentration slider in its default position gives you the most ink-like lines. Strokes that you 



make with the Calligraphy pen will cover underlying strokes. 

Choose the Calligraphy Palette color squares in the Color Palette for the best results.

Pen and Ink

With the Pen and Ink variant, the width of the stroke is determined by how fast you drag your stylus or 
mouse. The faster you go, the thinner the lines will be, the slower you drag, the thicker the lines will 
appear. 

Flat Color

This variant lets you fill in large areas with strokes that hide underlying ones. The width of the Flat Color 
stroke is determined by how fast you drag your stylus or mouse. The faster you go, the thinner the lines 
will be, the slower you drag, the thicker the lines will appear. 

Scratchboard Tool

You can use this variant as a dark color on a white background, but to get the full effect, start a new 
document, click on Set Paper Color..., and choose black by dragging the indicator all the way to the right 
of the scroll bar in the Windows color picker. Then choose white in the Color Palette and you can now 
create a scratchboard design. Using the stylus you can widen lines by pressing heavily and draw thin 
ones by pressing lightly.

You can base stroke width on the direction you drag the mouse.

Scratchboard Rake

This variant is like the Scratchboard Tool in that it is very effective when you use white on a black 
background. It produces a multi-lined stroke that is ideal for creating crosshatch shading. Move the 
Concentration slider to the left for more transparent strokes, move it to the right for more opaque strokes. 
With a stylus, pressing heavily gives you a wider, denser stroke, pressing lightly gives you a thinner, more
transparent stroke. If you're using a mouse, you can get the same transparent-and-opaque effect as 
pressing lightly with the stylus by moving the Concentration slider to the left before you begin a stroke. 
You can base stroke width and Concentration on the direction you drag the mouse.

Pixel Dust

A Pen variant, Pixel Dust draws a random distribution of pixels in a spray pattern. Pressure effects 
Concentration.

Single Pixel

Another Pen variant. It draws with a single pixel. The pixel is always full value. Pressure produces no 
effect. It can be used as a single-pixel line tool with Draw Straight Lines (Ctrl+L).

Leaky Pen

This is a leaky pen. Click and drag and you'll see. The more you drag the more it leaks. Pick blue or black
first to really get the full effect. 

Felt Pens 

Digital comps are possible using the Felt Pens in Painter. The Felt Pens draw smooth, anti-aliased lines, 
and as you repeat strokes, they darken toward black, just as they do when you use real felt markers. 
Choose Marker Colors color squares in the Color Palette for the best results.

To draw with the Felt Pens:

1. Position the cursor where you'd like to start drawing.

2. Push down on the stylus (or click the mouse) and drag. 

3. When you're done, let up on the stylus (or release the mouse).



What makes the Felt Pens unique is their life-like tendency to turn to black when you layer strokes using 
either a mouse or a stylus. Also, using a stylus, pushing heavily will turn a stroke black. Press lightly with 
a stylus to get a stroke that's truer to the color you selected in the Color Palette. To slow down the 
darkening of strokes using the mouse or the stylus, either move the Concentration slider to the left or 
choose a lighter color to start out with, or a combination of both. To speed up how quickly the stroke turns 
black, move the Concentration slider to the right.

You can base Concentration on the direction you drag the mouse. 

Because Felt Pen strokes muddy-up to black, you won't be able to add a light Felt Pen stroke to a dark 
one. If you try, you'll see the stroke get darker or not change at all, depending on how dark the underlying 
line is. You can do one of two things to get a light stroke on a dark Felt Pen stroke. Either pick an Eraser 
and erase, or pick the Chalk, which covers underlying strokes. You'll see you can draw a light Chalk 
stroke over a dark Felt Pen stroke. Changing the method is another way to apply a light stroke to a dark 
one.

Fine Tip Felt Pens

Draw narrow felt marker strokes with this tool. The width of the stroke is determined by how fast you drag 
your stylus or mouse. The faster you go, the thinner the lines will be, the slower you drag, the thicker the 
lines will appear. 

Medium Tip Felt Pens

This variant draws medium-width felt marker lines. Using either a stylus or mouse, drag quickly for a thin 
stroke, slowly for a thick stroke. 

Felt Marker

The Felt Marker gives you a softer shade than the felt pens. Changing direction while you drag with either
the stylus or mouse varies the width of your lines. 

Dirty Marker

As with the Felt Marker, the Dirty Marker stroke width is determined by stylus or mouse direction. The 
Dirty Marker produces shades that turn black more quickly than those made with the Felt Marker.

Single Pixel Marker

A Felt Pens variant. Pressure effects Concentration.

Crayons

Here are the digital crayons you always wanted. 

To draw with the Crayons:

1. Position the cursor where you'd like to start drawing.

2. Push down on the stylus (or click the mouse) and drag using short or long strokes. 

3. When you're done, let up on the stylus (or release the mouse).

The crayons produce semi-anti-aliased strokes that are affected by paper texture, so choosing different 
grains in the Paper Palette will vary your crayon strokes. Moving the Penetration slider to the left will 
cause your lines to reveal more paper texture, moving it to the right will make them denser, allowing less 
of the paper grain to show.

If you use a stylus, pressing lightly allows more of the paper texture to show through; if you press heavily, 
the crayon will penetrate the paper grain more, making the shade appear darker, and allowing less of the 
paper texture to show through the stroke.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Penetration slider to the left before you begin a stroke.



Another quality the Crayons share is that they produce strokes that get darker as you layer them. This will
come in handy when you're shading--drag over an area once for highlights, repeat strokes for dark 
shadows. As you work with the Crayons you may find that strokes turn black too quickly to suit your 
illustration. Use the Concentration slider to remedy this. By moving it to the left, the strokes will stay 
lighter longer. Moving the slider to the right makes the strokes turn black more quickly.

The Crayons are also pressure-sensitive in terms of Concentration, that is, the harder you press on the 
stylus, the blacker your strokes will be, the lighter you press, the lighter in color they will appear.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Concentration slider to the left before you begin a stroke.

You can base Penetration and Concentration on the direction you drag the mouse.

Because Crayon strokes muddy-up to black, you won't be able to add a light Crayon stroke to a dark one.
If you try, you'll see the stroke get darker or not change at all, depending on how dark the underlying line 
is. You can do one of two things to get a light stroke on a dark Crayon stroke. Either pick an Eraser and 
erase, or pick the Chalk, which covers underlying strokes. You'll see you can draw a light Chalk stroke 
over a dark Crayon stroke. You can also apply a light stroke over a dark one by changing the method.

Dragging the stylus or the mouse quickly gives you a thinner line, dragging slowly gives you a thicker one.

Default

This is your basic crayon.

Waxy Crayons

This variant gives you the effect of melted crayons.



Painting Tools

Brush

Here's where your oil painting and acrylic brushes reside. All of the variants cover or hide underlying 
brush strokes. Moving the Concentration slider in the Brush Palette to the right makes brush strokes more
opaque. Moving it to the left makes them more transparent. Also, using these variants with Apply 
Surface Texture in the Effects menu gives you some great oil- or acrylic-like brush strokes.

Hairy Brush 

Simulates strokes made by a bristle brush, showing semi-anti-aliased brush hair lines. Use the Hairy 
Brush Palette color squares in the Color Palette for best results.

To paint with the Hairy Brush:

1. Position the cursor where you'd like to start painting.

2. Push down on the stylus and make a short stroke. You'll see a dotted line.

3. Let up on the stylus. Your stroke will appear.

Note: Wait till one stroke is rendered before you start another. Otherwise, the second stroke will look like 
a cluster of Seurat-style dots or not appear at all.

The stroke width is determined by how hard you press down on your stylus, just like when painting with 
an actual brush. Pressing more lightly produces a thinner stroke. Pressing more heavily makes it wider. 
You can base stroke width on the direction you drag the mouse. 

The Hairy Brush interacts with paper grain, and choosing different paper textures changes how strokes 
look. Moving the Penetration slider to the left will allow more paper texture to show through, moving it to 
the right will increase paper penetration. 

Pressing more heavily on the stylus creates more solid strokes by increasing the degree of penetration 
into the paper grain; pressing less heavily lets more of the paper grain show through. If you're using a 
mouse, you can get the same effect as pressing lightly with the stylus by moving the Penetration slider to 
the left before you begin a stroke.

Layered Hairy Brush strokes hide underlying ones. Move the Concentration slider to the right to make the 
brush strokes more opaque, move it to the left to make them more transparent. 

The Hairy Brush is also pressure-sensitive in terms of Concentration, that is, the harder you press on the 
stylus, the more opaque your strokes will be, the lighter you press, the more transparent they will appear. 
If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Concentration slider to the left before you begin a stroke.

You can base Penetration and Concentration on the direction you drag the mouse.

Making some adjustments in the Brush Behavior window changes the Hairy Brush dramatically:

To open up space between bristles, move the Amount slider under Dab Location Variability and the 
Spacing/Size slider to the right.

To add bristles to the stroke, move the No. of Bristles slider to the right.

Meanwhile, to add multiple colors to the brush stroke, click and drag the ±HSV color variability sliders to 
the right in the Color Palette.

Graduated Brush

Ideal for shading, the Graduated brush paints semi-anti-aliased brush strokes that contain one or two 



colors, depending on how hard you press on the stylus. The Graduated Brush gets its color cues from the
overlapping rectangles in the Color Palette. The front rectangle is the primary color, the rear rectangle is 
the secondary color. Pressing heavily with the stylus produces one color, pressing lightly produces the 
other. Determining color choice by stylus pressure is set up in the Expression Palette and if you're using a
mouse, you can get the same two-color effect by making adjustments in this window. For instance, you 
can base color on the direction you drag the mouse.

To assign colors to the overlapping rectangles:

1. First click on the front rectangle to select it.

2. Click on the color that you'd like in the color squares, triangle or spectrum slider. You'll see the 
rectangle change to reflect the new color.

3. Click on the rear rectangle to select it.

4. Click on the color you prefer. The rear rectangle now shows the color you selected.

5. Click back on the front rectangle so that if you change brushes, you will be drawing or painting with the 
color in the primary rectangle.

To paint with the Graduated Brush:

1. Position the cursor where you'd like to start painting.

2. Push down on the stylus (or click the mouse) and drag where you want the paint to be. Vary the 
pressure and you'll get strokes that combine your primary and secondary colors.

3. When you're done, let up on the stylus (or release the mouse). 

To get a brush stroke that's tapered at one end, move the Size and ±Size sliders in the Brush Size 
window half-way to the right and the Thinness slider a bit to the left. Then click on the Build button. Then 
when you click and drag with a stylus, vary pressure.

The stroke width is determined by how hard you press down on your stylus, just like when painting with 
an actual brush. Pressing more lightly produces a thinner stroke. Pressing more heavily makes it wider. 
You can base stroke width on the direction you drag the mouse.

The Graduated Brush interacts with paper grain, and choosing different paper textures changes how 
strokes look. Moving the Penetration slider to the left will allow more paper texture to show through, 
moving it to the right will increase paper penetration. 

Multiple Bristle Brushes

These variants are brand-new to Painter 2.0. They give you some very real-looking oil and acrylic effects 
when used with Apply Surface Texture in the Effects menu.

To paint with the Real-Time Brushes:

1. Position your cursor where you'd like your stroke to begin.

2. Click and drag where you'd like your stroke to be.

3. When you're done, let go of the stylus or mouse.

All of the real-time bristle brushes have cover in their method, so strokes from these brushes hide 
underlying ones. Move the Concentration slider to the right to make the brush strokes more opaque, 
move it to the left to make them more transparent.

Making some changes in the Brush Behavior window will produce some interesting effects:

Moving the Contact Angle to the right increases the number of bristles. Moving the No. of Bristles slider to
the left at the same time opens up the space between bristles. 

Check Spread Bristles to join the spread bristles in a point at either end of the stroke.



Move the Brush Scale slider to the right to make the stroke bigger, move it to the left to make the stroke 
smaller.

Turn Amount affects curved strokes. To see how, paint an S after you've made the adjustments described 
above. Your stroke looks like an aerial view of a highway. Move the Turn Amount slider to the right and 
paint an S. Now the stroke looks more like paint squeezed from a tube.

Move the ±HSV color variability sliders in the Color Palette to the right for some more interesting effects.

Cover Brush

The Cover Brush produces brush strokes that have soft, anti-aliased edges. Pressing heavily with the 
stylus gives you wide strokes, pressing lightly gives you narrow ones.

Pressing harder with a stylus makes brush strokes more opaque, pressing more lightly makes them more 
transparent. If you're using a mouse, you can get the same effect as pressing lightly with the stylus by 
moving the Concentration slider to the left before you begin a stroke. You can base Concentration on the 
direction you drag the mouse. 

Penetration Brush

This brush reacts to paper grain and has hard, aliased edges. Penetration Brush strokes look like acrylics 
when you apply surface texture to them using the Effects menu. 

Penetration Brush strokes interact with paper texture, so you can modify your design based on the paper 
texture you select in the Paper Palette. Dragging the Penetration slider to the right makes strokes 
penetrate the paper more, resulting in shades looking darker and allowing less of the paper texture to 
show through. Moving the slider to the left reveals more paper grain.

If you use a stylus, pressing lightly allows more of the paper texture to show through; if you press heavily, 
the Penetration Brush strokes will penetrate the paper grain more, making the shade appear darker, and 
allowing less of the paper texture to show through the stroke.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Penetration slider to the left before you begin a stroke.

Dragging quickly with the stylus or the mouse makes each bristle more narrow, dragging slowly makes 
each bristle wide.

Oil Paint

Gives you brush strokes that have hard, aliased edges. Pressing heavily produces a wide stroke, 
pressing lightly gives you a narrower stroke.

Oil Paint strokes interact with paper texture, so you can modify your design based on the paper grain you 
select in the Paper Palette. Dragging the Penetration slider to the right makes strokes penetrate the paper
more, resulting in shades looking darker and allowing less of the paper texture to show through. Moving 
the slider to the left reveals more paper grain.

If you use a stylus, pressing lightly allows more of the paper texture to show through; if you press heavily, 
the Oil Paint strokes will penetrate the paper grain more, making the shade appear darker, and allowing 
less of the paper texture to show through the stroke.

If you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Penetration slider to the left before you begin a stroke.

Pressing harder with a stylus makes brush strokes more opaque, pressing more lightly makes them more 
transparent. If you're using a mouse, you can get the same effect as pressing lightly with the stylus by 
moving the Concentration slider to the left before you begin a stroke.

Camel Hair Brush



Gives you soft, anti-aliased strokes. Dragging quickly with the stylus or the mouse makes each bristle 
more narrow, dragging slowly makes each bristle wide.

Pressing harder with a stylus makes brush strokes more opaque, pressing more lightly makes them more 
transparent. If you're using a mouse, you can get the same effect as pressing lightly with the stylus by 
moving the Concentration slider to the left before you begin a stroke.

Rough Out

Acts like a fast, dry brush and is ideal for roughing out ideas. The faster you drag your stylus, the thinner 
the lines will be, the slower you go, the thicker they will appear. 

The Rough Out brush is paper-grain sensitive. Moving the Penetration Slider to the left lets more of the 
paper grain show through. Moving it to the right makes the color penetrate deeper into the grain. Pressing
lightly on the stylus reveals more of the paper grain, pressing heavily hides more of the paper grain. If 
you're using a mouse, you can get the same effect as pressing lightly with the stylus by moving the 
Penetration slider to the left before you begin a stroke.

Big Rough Out

This is a wider version of Rough Out.

Huge Rough Out

An even wider version of Rough Out.

Digital Sumi

This variant of Brush is a multiple-bristle brush made up of single-pixel bristles. Pressure effects width.

Artists 

You can paint in the style of Vincent Van Gogh, where your brush strokes are multi-shaded, or in the style 
of Georges Seurat, where multiple dots combine to form an image, by choosing one of the variants of the 
Artists brush. 

With all the Artists variants, dragging the mouse or stylus quickly will produce narrower strokes, dragging 
slowly will give you wider strokes.

Use the Impressionists color squares in the Color Palette for best results.

You're now ready to paint with the Artists variants.

Van Gogh

One of the things that made Vincent Van Gogh's style of painting unique was his use of multi-colored 
brush strokes. The Van Gogh brush can re-create this painting style with multi-colored, anti-aliased brush 
strokes that hide underlying strokes. Use shorter strokes with this brush.

To paint with the Van Gogh Brush:

1. Position the stylus where you'd like to start painting.

2. Push down on the stylus and make a short stroke. You'll see a dotted line.

3. Let up on the stylus. In a short time your stroke will appear.

Note: Wait till one stroke is rendered before you start another. Otherwise, the second stroke will look like 
a cluster of Seurat-style dots or not appear at all.

Van Gogh brush strokes hide underlying ones. Move the Concentration slider to the left to make strokes 
more transparent, move it to the right to make them more opaque.

In the Brush Behavior window:

Moving the Dab Location Variability Amount and the Spacing/Size sliders to the right opens up some 



space between bristles.

Moving No. of Bristles to the right adds bristles to your brush. Moving it to the left subtracts them.

Seurat

Georges Seurat painted in the pointillist style, a neo-Impressionist technique of using clusters of dots to 
represent people, objects and landscapes. The Seurat brush automatically creates multi-colored anti-
aliased dot clusters for you.

To paint with the Seurat Brush:

1. Position the cursor where you'd like to start painting.

2. Push down on the stylus (or click the mouse) and drag over an area one or more times. You'll see the 
area fill with dots.

3. Let up on the stylus (or release the mouse).

You can regulate dot size with the Brush Size window. The dots will be smaller the further you move the 
Size slider to the left. The dots will grow the more you move the slider to the right. After you make a 
change, click on the Build button.

Dot clusters cover underlying dot clusters or other brush strokes. Move the Concentration slider to the left 
to make the dots more transparent, move it to the right to make them more opaque.

Impressionist

This brush re-creates the style of Joe Impressionist, Impressionism's founder. Just kidding. This brush in 
fact is like an Auto Van Gogh brush. To see how it works, follow these steps for creating a Van Gogh-
esque sun:

1. Click in the yellow Impressionists color square in the Color Palette.

2. In the image window click and drag in a circular motion several times. You now have a Van Gogh sun.

The direction that you drag your mouse or stylus will determine the brush strokes' angle.

The Impressionist variant has a Drip method, so you can use it to either spread new color around or you 
can turn the Concentration slider down and push around paint in an existing image.

Auto Van Gogh

This variant works in a clone and gives you the same results as the Impressionist variant, but gets there 
in a different way. When you drag in a clone with Auto Van Gogh, the direction of the individual brush 
dabs will be determined by the light-and-dark areas of the clone source.

Flemish Rub

Creates an effect similar to the Impressionist and Auto Van Gogh variants. The difference is that the 
Flemish Rub variant smears existing color instead of applying new color. Use this variant to apply an 
impressionistic effect to an existing image.

Liquid

We like to talk about Painter's brushes being like natural media. At first glance, the Liquid variants might 
not seem to be at all life-like. However, when you use them to create oil-painting effects, you'll see that 
these brushes look very much like paint applied with a palette knife.

Drip is the method for all of these variants, and as a result, they smear more than they paint.

To smear with the Liquid variants:

1. Position your cursor where you'd like to start your stroke.

2. Click and drag slowly. The more you push your mouse or stylus, the more the paint will smear.



3. Let up on the stylus (or release the mouse).

With the Liquid variants you can either apply new paint or smear around an existing image, including 
photographs. To push existing paint around, move the Concentration slider all the way to the left, as it is 
set up for the Distorto variant. This means you have shut off the color. If you'd like to smear with color, 
then move the Concentration slider to the right. Using a stylus, the amount of pressure you use will affect 
how much paint gets smeared. Pressing heavily spreads more paint, pressing lightly smears less paint.

Distorto

Moves paint around without adding color. Dragging the stylus or mouse quickly produces a thinner stroke,
dragging slowly gives you a wider one. 

Smeary Bristles

Smears the color you choose in the Color Palette into your image. This variant is paper-grain sensitive 
and will interact with the texture you choose in the Paper Palette. Stylus pressure affects paper-sensitivity
differently with the Drip method than the other brushes. More paper texture will be visible when you press 
more heavily, and less paper texture will be apparent when you press lightly. The Penetration slider works
the same as usual, however--move it to the left to reveal more paper texture and move it to the right to 
make the paper grain less obvious. Using the mouse, adjust the Penetration slider to get the same 
variations as changing stylus pressure.

Dragging the stylus or mouse quickly produces a thinner stroke, dragging slowly gives you a wider one. 

Total Oil Brush

This variant produces a tighter-appearing stroke than the Smeary Bristles variant, but otherwise works in 
a similar way.

Smeary Mover

This variant is similar to Smeary Bristles except that instead of smearing new paint in an image it smears 
around existing paint.

Coarse Smeary Mover

This is a semi-anti-aliased version of Smeary Mover.

Coarse Smeary Bristles

This is a semi-anti-aliased version of Smeary Bristles.

Coarse Distorto

This is a semi-anti-aliased version of Distorto.

Thick Oil

Smears with a stroke loaded with paint.

Tiny Smudge

Single-pixel, multi-bristled smudging tool.

Water Color

The Water Color brush variants produce some of the prettiest effects in Painter 2.0. Using these variants 
you'll be able to produce some very lifelike water-color paintings.

Before you paint with the Water Color variants, there are a couple of things to set up first.

Select the Water Colors color squares in the Color Palette for the best results. 

Meanwhile, when you paint with water color, you're painting in the wet layer, which is a separate layer that
floats above your image area. Painting in the wet layer lets you add color without affecting your existing 



image. This is especially useful for illustrating. You can draw your image with one of the pens and then 
color it using Water Colors. You turn on the wet layer by selecting Options: Wet Paint. When you are 
done painting you send your water-color strokes to the image layer by choosing Options: Dry (Ctrl+Y).

After you paint with the Water Color variants you'll notice that color pools on the edges just like when you 
paint with real-life water color. Before you send the color to the image layer, you can control the pooling 
for all strokes in the wet layer with the Wet Fringe slider in the Brush Behavior window. Moving it to the 
left decreases the pooling, moving it to the right increases the pooling. The way to get different pooling 
amounts for individual strokes is to adjust the Wet Fringe slider for one or more strokes, Dry them, paint 
some more water-color strokes, then adjust the Wet Fringe slider again. You can't adjust the pooling once 
you Dry strokes.

Except for Wet Eraser, all of the Water Color variants are paper-grain sensitive and interact with the 
texture you select in the Paper Palette. The Penetration slider in the Brush Palette works differently with 
the Water Color brush than the other brushes. With Water Color variants, moving the slider to the right will
make your paper texture more pronounced, moving the slider to the left will make the paint appear flatter.

You won't be able to use the selection tool, frisket tools or Ctrl+A key combination to delete in the wet 
layer. To clear the wet layer, first Dry (Ctrl+Y) and then Undo (Ctrl+Z). Another option is to use the Wet 
Eraser variant, which lets you erase water-color strokes in the wet layer.

Except for the Wet Eraser, the Water Color brush variants' stroke widths are affected by stylus pressure. 
Press more heavily for wider brush strokes, press more lightly for more narrow ones.

When you're done using the Water Color variants, turn off the wet layer by choosing Options: Wet Paint.

Simple Water

Gives you a water-color stroke without bristles.

To paint with the Simple Water variant:

1. Pick a color in the color squares.

2. Position the cursor where you'd like to start painting.

3. Push down on the stylus (or click the mouse) and drag where you want the paint to be. 

4. Pick another color and click and drag over part of the first one. Notice that the colors blend together.

5. When you're done, let up on the stylus (or release the mouse). 

Water Brush Stroke

This variant is a water-color bristle brush.

To paint with the Water Brush Stroke:

1. Position the cursor where you'd like to start painting.

2. Push down on the stylus and make a short stroke. You'll see a dotted line.

3. Let up on the stylus. Your stroke will appear.

Note: Wait till one stroke is rendered before you start another. Otherwise, the second stroke will look like 
a cluster of Seurat-style dots or not appear at all.

Making some adjustments in the Brush Behavior window changes the Water Brush Stroke dramatically:

To open up space between bristles, move the Amount slider under Dab Location Variability and the 
Spacing/Size slider to the right.

To add bristles to the stroke, move the No. of Bristles slider to the right.

Move the ±HSV color variability sliders in the Color Palette to the right to add shades to the stroke.



Wet Eraser

Erases water-color strokes in the wet layer.

To erase with the Wet Eraser:

1. Position the cursor where you'd like to start erasing.

2. Push down on the stylus (or click the mouse) and drag where you want to erase. 

3. When you're done, let up on the stylus (or release the mouse). 

The Wet Eraser is pressure-sensitive. Pressing heavily with a stylus erases more quickly, pressing lightly 
erases more slowly. If you're using a mouse, you can get the same effect as pressing lightly with the 
stylus by moving the Concentration slider to the left before you begin a stroke. You can base 
Concentration on the direction you drag the mouse.

Pure Water Brush

This variant behaves like the Water Brush Stroke except that instead of adding color to your image it adds
water.

To paint with the Pure Water Brush:

1. Position the cursor where you'd like to start painting. 

2. Push down on the stylus or mouse and make a short stroke. You'll see a dotted line. To see the effect 
of the Pure Water Brush, be sure to click and drag over an existing brush stroke in the wet layer.

3. Let up on the stylus or mouse. Your stroke will appear.

Spatter Water

Spatters water globules when you click and drag.

Broad Water Brush

Paints a wide stroke showing brush bristles. This is a real-time multiple bristle brush.

Large Water

Produces a gossamer water-color stroke.

Large Simple Water

This is a larger version of the Simple Water variant.

Diffuse Water

Edges of this brush diffuse after stroke is made.

Airbrush

Gives the illusion of a fine mist of paint being sprayed on a surface. Like using an airbrush or a spray can,
the mist will hide anything underneath it. Moving the Concentration slider to the left will make the mist 
more transparent, moving it to the right will make it more opaque. Also, when you press heavily with the 
stylus your strokes will contain more color, and when you press more lightly, they will be more 
transparent. If you're using a mouse, you can get the same effect as pressing lightly with the stylus by 
moving the Concentration slider to the left before you begin a stroke.

Dragging the stylus or mouse quickly produces thin strokes and dragging slowly gives you slightly wider 
ones.

To paint with the Airbrush:

1. Position the cursor where you'd like to start painting.



2. Push down on the stylus (or click the mouse) and drag where you want the paint to be. 

3. When you're done, let up on the stylus (or release the mouse). 

Fat Stroke

Covers a large area with a soft, anti-aliased paint stream. 

Thin Stroke

Covers less territory.

Feather Tip

Paints soft, anti-aliased lines that have varied widths. These thick-and-thin variations are more apparent 
when you widen your stroke by moving the Size slider in the Brush Size window to the right. Don't forget 
to click the Build button before you drag in the image window.

Spatter Airbrush

The Spatter Airbrush is paper-grain sensitive and produces a semi-anti-aliased brush stroke. Move the 
Penetration slider to the right to penetrate more of the paper. Move it to the left to let more of the paper 
texture show through. Pressing heavily with the stylus penetrates more paper grain, pressing lightly with 
the stylus reveals more paper texture. If you're using a mouse, you can get the same effect as pressing 
lightly with the stylus by moving the Penetration slider to the left before you begin a stroke.

Burn

Burn in photography is a way to darken selected areas of an image. Try the following to see how it works:

1. Choose a dark color in the Color Palette.

2. Choose Effects: Fill (Ctrl+F). Your image is now filled with the color you selected in the Color Palette.

3. Select the frisket Knife tool in the Toolbox and draw a circle.

4. Click back on the Brush tool in the Toolbox.

5. Choose Brush Stroke: Record Stroke.

6. With the Burn variant selected draw a line inside the frisket.

7. Choose Brush Stroke: Auto Playback. A circular section of your image is darkened.

8. Click anywhere to stop Auto Playback.

9. To clear the frisket choose Windows: Frisket Palette (Ctrl+9) and click in the first icon in the top and 
bottom rows.

Dodge

Dodge in photography is a way to lighten specific areas of an image, and in Painter this variant works in 
the opposite way as Burn. Where Burn darkens an image, Dodge lightens it. To see this work, follow the 
steps for Burn only choose a light color to fill the image with, and of course use the Dodge variant.

Single Pixel Air

Single-pixel airbrush with anti-aliased edge.



Method

Method is the foundation that every brush and every customizing technique in Painter is built on. Method, 
chosen in the pop-up menu in the zoomed-open Brush Palette, decides the nature of a brush stroke, 
which in turn determines the outcome of every other customizing technique as it acts upon, or along with, 
the method.

Each brush and each variant has a default method. It's this default method that makes the brush act like 
its real-life counterpart. And if you never change a single default method, you would still be able to use 
Painter and have many painting and drawing tools to choose from. But getting to know the methods and 
being able to vary them will give you even more options for creating new images or editing existing ones. 
Also, even if you don't change a variant's method, knowing what method is all about helps you choose 
other customizing features. For instance, knowing that grainy in the method means that the brush 
interacts with paper grain will lead you to choose unusual paper textures in the Paper Palette.

The first time you click and hold on the Method pop-up menu you might think it looks complex, but it really
is easy to work with, once you see how it's organized.

The Method pop-up menu is divided into five categories. These are:

Buildup Methods

Painting with buildup methods means that brush strokes will build up the color of those below them, 
eventually turning them black. Felt Pens are an example of build-up brushes.

Cover Methods

The cover methods, on the other hand, produce brush strokes that cover or hide underlying strokes. 
Instead of building to black, cover strokes turn more opaque the more they're repeated. The Chalk is an 
example of a cover brush.

Editing Methods

These methods edit brush strokes by either erasing them, darkening them or smearing them. The Eraser 
is an example of a brush using these methods.

Cloning Methods

These methods take a clone source and re-create it in another medium.

Watercolor Methods

These methods are the basis of the Water-Color variants.

Next, within these five sections, are some more defining characteristics.

For instance, brush strokes are either soft, flat or hard, and all have to do with the brush stroke's edges.

Soft methods produce smooth, anti-aliased strokes.

Flat methods produce strokes with hard, pixelly edges.

Hard methods provide brush strokes whose edges are semi-anti-aliased.

In a few instances you'll see the words edge and variable. Edge makes strokes thick- and sticky-looking. 
Variable means a brush stroke starts off a bit more transparently.

Last, there's the word grainy. When this word is in a method, it means the brush will react to the paper 
grain you choose in the Paper Palette.

So you put together one of the main categories and modify it with one of the other characteristics, and 



now you understand methods. For instance, Grainy Hard Cover means that a brush stroke will interact 
with paper grain, will have semi-anti-aliased edges and will produce strokes that hide underlying ones. 
This is the default method for Chalk and Charcoal.

It's good to know how to juggle methods. Lets say you want a Charcoal-looking stroke, but instead of 
hiding underlying strokes, you want brush strokes to muddy up to black. Change the method to Grainy 
Hard Buildup. Now let's say you want a smoother, anti-aliased stroke. Change the method to Grainy Soft 
Buildup. The stroke still isn't quite right -- you don't want to see paper texture. Now choose Soft Buildup. 
Your stroke has smooth, anti-aliased edges and turns black. Soft Buildup is the default setting for Medium
Tip Felt Pens.

Methods

Here are the methods and what they do. Examples of the brushes or variants that have the given method 
as the default are included.

The Buildup Methods

Soft Buildup

Medium Tip Felt Pens, Felt Pen Cloner

Anti-aliased brush strokes that build to black.

Grainy Soft Buildup 

2B Pencil, Fine Point Pen, Smooth Ink Pen

Paper-grain-sensitive anti-aliased brush strokes that build to black.

Grainy Edge Flat Buildup

Paper-grain-sensitive aliased brush strokes that build to black. The addition of the word edge means the 
strokes appear more thick and sticky.

Grainy Hard Buildup 

Colored Pencils, Thick and Thin Pencils, Sharp Pencil, 500 lb. Pencil, Crayons

Paper-grain-sensitive semi-anti-aliased brush strokes that build to black.

Soft Variable Buildup 

Fine Tip Felt Pens, Felt Marker, Dirty Marker

Anti-aliased brush strokes that build to black. Variable means a brush stroke starts off a bit more 
transparently.

Cover Methods

Flat Cover 

Calligraphy, Pen and Ink, Flat Color

Hard-edged strokes that hide underlying ones.

Soft Cover 

Drawing tools: Calligraphy, Pen and Ink, Flat Color, Scratchboard Tool, Scratchboard Rake, Leaky Pen.

Paint brushes: Airbrush, Seurat, Oil Brush Cloner, Driving Rain Cloner, Camel Hair Brush, Cover Brush, 
Van Gogh, Auto Van Gogh, Van Gogh Cloner

Editing tools: Just Add Water

Anti-aliased brush strokes that hide underlying ones.



Grainy Flat Cover

Grainy Water

Paper-grain-sensitive hard-edged brush strokes that hide underlying ones.

Grainy Soft Cover

Soft Charcoal

Paper-grain-sensitive anti-aliased strokes that hide underlying ones.

Grainy Edge Flat Cover

Frosty Water, Rough Out, Hard Oil Cloner, Penetration Brush, Oil Paint

Paper-grain-sensitive thick, sticky hard-edged strokes that hide underlying ones.

Grainy Hard Cover

Chalk, Default Charcoal,Gritty Charcoal, Hairy Brush, Graduated Brush, Hairy Cloner, Chalk Cloner, 
Spatter Airbrush

Paper-grain-sensitive semi-anti-aliased strokes that hide underlying ones.

Editing Methods

Soft Paper Color

Erasers

Takes away brush strokes and restores the paper color you chose when you created your document.

Soft Paint Remover

Bleaches, Dodge (Airbrush variant)

Bleaches out brush strokes and replaces them with white.

Soft Paint Thickener

Darkeners (Eraser variants), Burn (Airbrush variant)

Deepens the color of any part of an existing image, picking up the color from the image rather than from 
the Color Palette.

Soft Mask Colorize

This method is used for painting with a frisket or friskets present on the drawing surface but turned off in 
the Frisket Palette. The color of the stroke is a mixture between the primary and secondary colors, 
determined by the frisket (mask). When you draw over the frisket, the brush senses the frisket, and paints
with the primary color on the outside of the frisket and the secondary color on the inside. This method is 
useful for coloring cartoons.

Drip

Distorto, Melt Cloner, Impressionist, Impressionist Cloner

Smears soft strokes using either image color or the color chosen in the Color Palette.

Hard Drip

Coarse Distorto

Smears semi-anti-aliased strokes using either image color or the color chosen in the Color Palette.

Grainy Drip

Smeary Bristles, Total Oil Brush, Smeary Mover, Thick Oil, Flemish Rub



Smears paper-grain-sensitive anti-aliased strokes using either image color or the color chosen in the 
Color Palette.

Grainy Hard Drip

Coarse Smeary Mover, Coarse Smeary Bristles

Smears paper-grain-sensitive semi-anti-aliased strokes using either image color or the color chosen in the
Color Palette.

Watercolor Methods

Grainy Wet Buildup

Pure Water Brush, Spatter Water, Simple Water,Broad Water Brush, Water Brush Stroke, Large Water, 
Large Simple Water

Used in wet layer. Produces watery paper-grain-sensitive brush strokes

Grainy Wet Abrasive

Deposits color into the wet layer, so you must turn on Wet Paint before working with a brush that uses this
method. Strokes replace color under them, giving a true water-color feel.

Wet Remove Density

Wet Eraser

In the wet layer erases watercolor brush strokes.



Brush Behavior

The Brush Behavior window contains controls for further refining brush strokes and for adjusting the way 
buildup brush colors interact on screen.

Dab Location Variability

Amount

Moving the Amount slider to the right increases the randomness of brush dabs that combine to form a 
brush stroke. For the bristle brushes, this can result in the opening up of space between bristles. For non-
bristle brushes like the Crayon, for instance, moving Amount to the right increases brush dab randomness
and ultimately the stroke turns into Seurat-style dots.

Dab-to-Dab Spacing

Spacing/Size

The Spacing/Size slider controls the amount of space between the brush dabs that make up a stroke. 
Moving it to the right makes brush strokes appear less dense, which is especially useful with the bristle 
brushes, but can be a problem for one-stroke brushes like crayons. Brush dabs can get spaced out, for 
instance, when you widen brush strokes in the Brush Size window. To make the stroke look more like a 
continuous line, move the Spacing/Size slider to the left.

Min Spacing

This slider specifies the minimum spacing in pixels between dabs of paint along the brush stroke. The 
effect of moving the slider to the right is to space out paint dabs, giving you a dotted line.

Brush Paint Reservoir

Resaturation

Resaturation is the amount color that is replenished in a stroke. Moving the Resaturation slider to the right
will increase resaturation, making the color last longer through the stroke, moving it to the left will reduce 
resaturation, causing the stroke to run out of color sooner. 

Bleed

Bleed is how much colors mix together and works with the buildup method brushes. Moving the Bleed 
slider to the right increases the extent of bleed, moving it to the left reduces bleed. Also, colors will mix 
together better if you move the Concentration slider in the Brush Palette to the left. Depending on the 
color, you may get better results by moving the Resaturation slider in the Brush Behavior window to the 
left, too.

Clone Location Variability

Amount

Used only with the Cloning Methods, move the Clone Jitter Amount slider to the right to soften lines and to
make brush strokes less defined, a useful technique for re-recreating the look of oil paints. To make the 
strokes more precise, move the Clone Jitter Amount slider further to the left.

How Often

Used only with the Cloning Methods, the more you move the Clone Jitter Time slider to the left, the 
rougher your strokes will appear, which can be useful for sketches.

Water Color

Wet Fringe



The Wet Fringe slider affects the Water Color brush variants. Color pools in the edges of these brush 
strokes and moving the Wet Fringe slider to the left reduces the pooling, moving it to the right increases 
the pooling. This only works in the wet layer, turned on by choosing Options: Wet Paint.

Diffuse Amount

Use the Diffuse Amount slider to control the amount of feathering of the Water-Color strokes due to 
overwetting the brush. The color deposited in the wet layer increases the image density.

Multiple Bristles

When this box is checked, the brush acts like the Hairy Brush or Van Gogh variants. You can check this 
box when you have the Crayon selected, for instance, to turn it into a bristle brush.

New Brush Model

Checking this box, a new feature in Painter 2.0, creates real-time multiple bristle brushes like the Cover 
Brush and Oil Paint variants.

Spread Bristles

Checking Spread Bristles when New Brush Model is checked joins the spread bristles in a point at either 
end of the stroke. When Spread Bristles is unchecked, the bristles are parallel to one another.

Edge Bristle Soften

Bristles on edge of brush can either be softened or have the same opacity as the middle bristles.

No. of Bristles

Adds bristles to bristle brushes. Move the slider to the right to increase the number of hairs in a stroke.

Contact Angle

Moving the Contact Angle to the right widens strokes produced by real-time bristle brushes created by 
checking New Brush Model. Moving the No. of Bristles slider to the left at the same time opens up the 
space between bristles. Also, clicking on the different stroke silhouettes in the Brush Size window affects 
the amount of space between bristles for the New Brush Model brushes. The silhouettes represent the 
contours of individual bristles for these brushes, so the thicker the bristle, the less space there will be 
between bristles.

Brush Scale

Used with the New Brush Model brushes, moving the Brush Scale slider to the right makes strokes 
bigger, moving it to the left makes strokes smaller.

Turn Amount 

Turn Amount affects curved strokes made with New Brush Model brushes.



Creating Textures

Painter 2.0 offers you many creative alternatives for incorporating paper textures into your images, 
whether you are using them in connection with brush strokes or emblazing part or all of your image with 
them.

Paper Palette (Ctrl+6)

Your central control panel for paper textures is the Paper Palette, where all of your paper textures are 
stored and accessed. In the Paper Palette you can also edit paper grains and access other paper textures
from Painter's paper libraries.

In terms of individual brush strokes, if the word grainy appears in the Method pop-up menu, then the 
particular variant will interact with paper grain.

To open the Paper Palette choose Windows: Paper Palette (Ctrl+6).

Choosing Paper in the Paper Palette

To choose a paper texture:

1. Scroll through the Paper Palette to look for a paper texture.

2. Click on the picture of the desired paper texture to select it. A black line surrounds its picture and its 
name appears below the scroll bar.

Changing Paper Libraries

You can select Painter's other paper libraries.

1. Click on the Paper Palette's zoom box to expand the window if it isn't already.

2. Click on Library...

3. Double-click on another library to install it. You'll then see a different set of textures in the Paper 
Palette.

In Painter 2.0 you can tear off a paper texture and place it next to your image area, just as you can take a 
variant out of the Brush Palette.

1. Click on the grain's picture and drag it to where you would like it to be. 

2. Let go of the stylus or the mouse. Notice that the name of the texture you selected appears at the 
bottom of the window. You can move every texture out of the Paper Palette if you'd like. All grains reside 
in the Paper Palette and can be chosen from there even if that variant is elsewhere on the screen.

To move the window somewhere else, click and drag on its title bar. When you're done with the paper 
texture, clicking on its close box will remove it from the screen. 

You can have tear-off windows from different libraries open at the same time.

Invert Grain

If you think of paper grain as a three-dimensional landscape, color reacts to paper texture by coating the 
peaks and ignoring the valleys. By checking the Invert Grain box, color will fill the valleys and ignore the 
peaks.

Here's a trick for getting two-colored paper textures: after picking a paper texture and clicking and 
dragging in the image with one color, check Invert Grain, pick another color, then drag in the same area. 
You now have a duotone section in your image.

Scale Slider



The Scale slider also appears when you click on the grow box in the Paper Palette.

The Scale slider allows you to resize the paper grain. If you leave the slider at 100%, you will get a paper 
texture as shown in the Paper Palette. You can scale the texture down to 25% and up to 400%. You will 
find that, at the larger scales, with large brush sizes, you are able to get a very detailed texture in a 
stroke.

When you tear off a paper texture from the Paper Palette, the texture's picture reflects your Scale slider 
change.

Random Grain Brush Strokes

Checking this box randomizes how the brush interacts with paper grain, so strokes will be textured but 
won't show the exact pattern of the chosen paper. You can create textures that won't repeat using this 
option.

Capture Paper Texture

A new feature in Painter 2.0, the Capture Texture item in the Options menu lets you turn a brush stroke, 
multiple brush strokes or a section of an image into a surface texture accessible in the Paper Palette. 

To see how this works:

1. Draw or paint a stroke with any variant.

2. Select a piece of it with the Selection Tool.

3. Choose Options: Capture Texture... The Save Texture dialog box appears.

4. Move the Crossfade slider to the right to increase the amount that the area you selected repeats in the 
new texture. Changing the Crossfade slider lets you create many different versions of a texture based on 
one selection.

5. Type in the name of your new texture and click OK or press Enter.

Your texture now appears as the last item in the Paper Palette.

Make Repeating Texture

Choose Options: Make Repeating Texture... for another new feature in Painter 2.0 for making 
homemade paper textures.

Make Repeating Texture Dialog

The Preview picture will show you what your changes will look like as you make them.

Moving the Spacing slider to the right opens up space between rows and columns in the selected pattern.

Moving the Angle slider changes the direction in which the pattern rows are lined up.

The Pattern pop-up menu gives you choices for the shape of the element that makes up your pattern.

Type in the name of your new texture next to Save As. Click OK or press Enter. Your new texture 
appears as the last item in the Paper Palette.

Paper Mover

You may want to organize the Paper Palette libraries by client or by project, or you may want to create 
new libraries, or you may want to delete textures. You can do all of these by choosing Options: Movers: 
Paper Mover...

To move a texture from one library into another:

See if the library that currently appears in the left column is the one you want to move a texture from. If it 
isn't, click Close... Then click Open... and locate the library you wish to move a paper from.



Now open a library on the right-hand side that you want to move the paper to by clicking Open... and 
locating the library you want to move to.

Click on the paper in the left column that you'd like to move and click Copy.

To remove a texture, select it, then click Remove.

To rename a texture select it and click Change Name... The Change Paper Name dialog box appears. 
Type the new name then click OK or press Enter.

To start a new Paper Library, click Close on the right-hand side of the dialog box if a library is showing.

2. Click New...

3. Type a name under New Paper Texture File.

4. Click Save or press Enter.

Now you can either move existing textures into your new library as described above or you can create 
new textures using Capture Texture and Make Repeating Texture.

When you are done with the Paper Mover dialog box, click Quit or press Enter.

To delete a library, in the Finder drag it to the Trash.



Expression Palette (Ctrl+7)

Pressing heavily on a stylus achieves some amazing outcomes in Painter, but what if you're using a 
mouse? The good news is that using the Expression Palette you can choose other ways besides 
pressure to determine factors like how much your brush will show paper texture, how dense the color will 
be and how wide the brush stroke will be.

The Expression Palette is also useful for stylus and mouse users alike for inventive painting and drawing. 
For instance, in Painter 2.0 for the first time you can set up the Expression Palette so that the degree that 
colors bleed together in a clone is determined by the light-and-dark areas of the clone source. And in 
Painter 2.0 two new features--Tilt and Bearing--have been added for CalComp tablet users.

Each brush variant has default Expression settings that have been found to be most appropriate for the 
brush performance. But you may want to work with the brush in a different way, and you have that option 
in Painter.



Saving Brushes

You can add your own brush categories to Painter's Brush Palette to create a new medium or to organize 
customized settings by project, design or client. Here's how you do it:

1. First decide on a picture that will appear in the Brush Palette for your new brush. This can be newly 
created art or an image imported into Painter.

2. With the Selection Tool drag a square-shaped selection marquee around the portion of the picture that 
will appear in the Brush Palette.

3. Choose Options: Custom Brush: Save Brush... Enter a name for your brush and click OK or press 
Enter.

Your new brush and its picture now appear as the last brush in the Brush Palette.

This new brush is only a container. To have it produce strokes with particular attributes you have to now 
create and add variants to it as described above.

Brush Mover

Another of Painter's handy features is the ability to set up Brush Palettes for individual designs, projects, 
clients or fashion seasons. The Brush Mover is also useful if you'll only use three or four brushes for a 
given project and you don't want to have to scroll through all the brushes you won't be using.

Choose Options: Movers: Brush Mover... The Brush Mover dialog box appears.

To create a new brush library click New...

Under New Brush File, type in the name of your new library. Click Save or press Enter. The new brush 
library's name appears on the right-hand side of the Brush Mover dialog box.

To move brushes into your new library:

Click on the brush you wish to move.

Click Copy.

Click Change Name... to rename a selected brush. Type in the name in the Change Brush Name dialog 
box. Then click OK or press Enter.

Click Change Picture... to replace the brush's current picture. Before you do, select the image portion 
that you'll replace the brush picture with before opening the Brush mover. Then click on Change 
Picture.... Painter will ask if you want to change the current brush picture to the new one. Click OK or 
press Enter to execute the change.

Click Remove to delete a selected brush. If you remove one of Painter's default brushes by mistake, the 
only way to retrieve it is to re-load the program. If you do so, you'll lose any of the custom variants, 
brushes or papers you created.

To move a brush to an existing library, click Close to close an open library on the right-hand side of the 
dialog box, then click Open.... Locate the library you want, click on it and click Open or press Enter. Then
follow the earlier instructions for moving a brush.

When you are done making changes in the Brush Mover dialog box, click Quit or press Enter.



Brush Stroke Designer (Ctrl+8)

The Brush Stroke Designer debuts in Painter 2.0 and is a unique interactive visual key to the 
modifications you make to brush strokes.

And it's easy to use.

Here's how:

Choose Windows: Brush Stroke Designer (Ctrl+8) The Brush Stroke Designer window appears.

What you see is an example of a brush stroke on a sample background. You can change backgrounds by 
clicking in the boxes at the bottom of the window. For now, click on white. As you use the customizing 
features the brush stroke will reflect the changes. For example, choose a Chalk variant. Next choose two 
different textures in the Paper Palette. You'll see how each affects the stroke. Click on orange in the 
spectrum slider in the Color Palette--the stroke changes color. Now choose a Felt Pens variant. The 
stroke becomes solid -- that's because Felt Pens aren't affected by paper texture. You'll use a white 
background for strokes like crayons, but click in the boxes showing either tinted backgrounds or lines to 
see the smear of drip method brushes, for example. Click on the Set Colors button to assign a color from
the Color Palette to these backgrounds.

When you have the brush stroke you seek you can do one of three things: Paint or draw with the modified
brush, save your changes as a variant -- everything except paper texture and color can be saved as a 
variant -- or you can save your changes in the Brush Looks window.



Brush Looks Window (Ctrl+-)

Another brand-new feature of Painter 2.0, the Brush Looks window is the visual equivalent of the variant 
pop-up menu. The Brush Looks window offers a visual record of the changes you make to brush strokes 
using the various customizing features including the Paper Palette while the Brush Stroke Designer is 
open.

The Brush Looks window has been crammed with brush strokes that you can use right away. To access 
the Brush Looks window choose Windows: Brush Looks (Ctrl+-).

The Brush Looks window works just like the Paper and Brush Palettes. Scroll to find the look you want, 
then click on it. A black line around the picture shows a look is selected and its name appears beneath the
scroll bar.

Now click and drag in your image and the stroke resembles the look you chose in the Brush Looks 
palette.

You can use the Brush Looks window to help you learn how to use Painter. With all the customizing 
windows open, choose different brush looks. You'll see the way various gauges were set up to get the 
look you chose.

Meanwhile, you can save your customized strokes in the Brush Looks window through the Brush Stroke 
Designer.

To save a stroke from the Brush Stroke Designer in the Brush Looks window:

1. In the Brush Stroke Designer window click Save. The Name the Brush Look dialog box appears.

2. Type in the name of your brush look.

3. Click OK or press Enter. Your stroke is now a look in the Brush Looks window.

Brush Looks can be torn off and moved anywhere on your screen, just like brushes and paper textures.



Cloning

Cloning allows you to make exact copies, or use cloning to revamp images to seem as if they had been 
created with another medium. Use one of Painter's pre-set Cloner brushes or construct your own cloning 
brushes.

Creating Clones

Making Existing Document a Clone

Painting, Drawing in Cloned Image

Cloner Brushes and Variants

Turning Other Brushes Into Cloners

Fine-Tuning Cloning Methods

Tracing Paper



Creating Clones

However you use cloning, you'll start out the same way, by making a clone of your image. You can clone 
an image that you either created in Painter or one that you opened in Painter but that came from Sketcher
or other paint programs.

There are several ways to set up a clone image. The most basic is to do the following:

1. Open an existing Painter-compatible document. This document will be your source document.

2. Select File: Clone. A duplicate of your image will appear with the words Clone of preceding the original
document's name in the title bar. (When you save the file, Clone of will be replaced with C_.) An invisible 
computer link maps this clone and its source.



Making Existing Documents a Clone

Once you've worked with cloning a bit, you'll start to see the need for other ways to set up clones. For 
instance, what if you close your source and clone documents and open them again? You'll want to re-
establish the link between them when you reopen. What about working with two open documents? Can't 
one be the source and the other the clone? What if you want to go backward--that is, make a clone into 
the source document and open the original as the clone?

Using the following three functions, you can set up any two images as source and clone documents.

Clone

If you have no documents open and you want to open one as a source and a second document as a 
clone, here's what you do:

1. Open a source document the usual way using File: Open.

2. Hold down the Ctrl+Alt key and select File: Clone. The open dialog box will appear from which you will
choose the file that will be your clone document.

Your first document is now the source and the second document is the clone.

Set Clone Source

If you already have two documents open, you can establish one as the source document by clicking on it 
and choosing Options: Set Clone Source. The second document automatically becomes a clone 
document.

Shift-Click

Maybe you don't need your whole image. Maybe you just want to borrow a portion of it, or maybe you 
want to take pieces and rearrange them within the same document. You can do either using the keyboard 
in combination with the Cloners. This feature differs from Set Clone Source in that with Set Clone Source,
the source and the clone images will be in register from the top left-hand corner, whereas with Shift-Click, 
you can pick up any piece from the source and put it anywhere within the clone.

Cloning parts of an image:

1. Open the document containing the image you wish to clone from. This original document will remain 
open while you lift parts of it.

2. Open a new or existing document to transfer items from the original. You can also transfer parts of an 
image from one place to another within the same document.

3. In the Brushes Palette, select a Cloner variant, or select another tool and check Use Clone Color or 
select a cloning Method.

4. Make the original document active by clicking anywhere in it.

5. Press the Shift key and click on the portion of the image that you wish to clone.

6. Click anywhere in the clone document to make it active.

7. Drag your stylus or mouse where you want the item to appear. The area you clicked on in the source 
now begins to appear in the clone. The start of this stroke establishes the mapping between the clone and
the original.

Note: If you are trying to use this cloning technique with an existing image, remember that many of 
Painter's Brushes, like pencils and felt pens, are absorbed into the paper and turn black. Therefore, if you 
are trying to clone with one of these tools in a dark area of your image, you may not see any results. Try 



choosing pastels, chalk or one of the other tools that covers underlying colors. 



Tracing Paper

Once you have created your source and clone images, you can set up an on-screen light box using 
Painter's Tracing Paper. With Tracing Paper you can trace over a 50% ghost of an image, and turn it off 
when you're done. This lets you use part or all of the original image as a template for brush strokes in 
your new, cloned image.

Note: You can set up Tracing Paper between any image and its clone. The two must be exactly the same 
size

To set up Tracing Paper:

1. With your new clone showing, choose Edit: Select All (Ctrl+A) or choose a portion of your image with 
either the Selection Tool or the frisket Knife Tool, both in the Toolbox, and press the Backspace key. Part 
or all of your image disappears leaving a blank painting surface. However, a computer path remains 
mapping the clone to its source image.

2. Choose Options: Tracing Paper (Ctrl+T) or click in the Tracing Paper icon in the vertical scroll bar. A 
50% ghost of the original image now appears. This ghost is invisible and won't print, and you can use it as
a point of reference with any plain brush, Cloner or brush you transform into a Cloner. For information 
about how to work with the Cloners, see below.

3. After adding your brush strokes, choose Options: Tracing Paper or click again on the Tracing Paper 
icon, and the faint original image disappears and new strokes remain. Tracing Paper can be turned on or 
off as often as you wish, but keep the clone and its source image open.

Note: When you paint or draw over the ghosted area, your brush strokes will be at 50% opacity. When 
you turn off Tracing Paper you'll see your brush strokes at 100% opacity. Also note that if your source and
clone documents are different sizes, the Tracing Paper feature won't operate.

Tracing Paper

If you don't want to use Tracing Paper, you can work in your clone image using one of three other 
techniques. One way is to keep the image visible, which is useful with Auto Van Gogh. Another way is to 
clear part or all of the clone image (as outlined in the Tracing Paper section) so you can see the image 
transformation more clearly. You'll use this empty window with such brushes as pencils and felt pens 
whose colors tend to turn black quickly. With none of the image showing, however, it might be hard to tell 
where you are. A third possibility is to lighten the entire image to use it as a first layer of your work. With 
this option, the clone contains the original image, whereas with Tracing Paper, only a ghost of the original 
appears, not the image itself.

To lighten the cloned image:

1. Make the cloned document the active window by clicking anywhere in it.

2. Choose: Effects: Surface Control: Adjust Dye Concentration....The Adjust Dye Concentration dialog
box appears.

3. Move the top slider to the left until the image is as light as you would like it to be and select Uniform 
Adjustment in the Using menu.

4. Click on OK.

Your image is now as light as it was in the Adjust Dye Concentration dialog box and you can use it as the 
first layer of your new design.



Painting, Drawing in Cloned Image

Now that you have a clone of your original image, you can use Painter's brushes to re-create it in a 
different medium and you can use Painter's special effects to embellish it. Keep your original document 
open while you work in the cloned image to maintain the computer link that permits the cloning effects 
between the two documents.

Just as you can either use a variant as is or customize it, you can also get a Cloner Brush variant straight 
from the Brush Palette or you can turn any brush into a Cloner by modifying it. You can further refine the 
Cloner variants and brushes that you've turned into Cloners with Painter's other customizing functions.



Cloner Brushes and Variants

The Cloners brush and its variants in the Brush Palette are default settings that have been set up for you 
to provide the media you're most likely to want to clone with. When you click and drag in a cloned image 
with them, they pick up color from the original while you control the direction of brush strokes. Many 
behave like their plain brush counterparts, i.e., the Chalk Cloner produces the same effect as the Artist 
Pastel Chalk variant of the Chalk brush.

The following section briefly describes the variants in the Cloners variant pop-up menu in the Brush 
Palette. 

When working with the Cloners, keep in mind that if you don't like the strokes you've made, you can 
delete and try again, as long as the original document stays open. You don't use up the original image 
when you clone it.

Pencil Sketch Cloner

Imitates pencil lines. To get a quick-sketch effect with uneven lines, go to the Brush Behavior window 
(Ctrl+5) and move the How Often slider under Clone Location Variability to the left.

Felt Pen Cloner

Re-creates felt pen strokes that get darker as you draw. To keep the colors from darkening up too quickly, 
move the Concentration slider in the Brush Palette to the left.

Hairy Cloner

Paints like the Hairy Brush variant of the Brush in the Brush Palette, producing somewhat anti-aliased 
strokes that show the brush's hair lines and react to paper grain. This brush is useful with oil painting. 

Oil Brush Cloner

Gives you anti-aliased brush strokes that hide underlying ones. This is another good brush to use with oil 
painting.

To paint with the Oil Brush Cloner:

1. Position the cursor where you'd like to start painting.

2. Push down on the stylus and make a short stroke. You'll see a dotted line.

3. Let up on the stylus. In a short time your stroke will appear.

Chalk Cloner

Draws like the Artist Pastel Chalk variant of the Chalk brush.

Hard Oil Cloner

This brush gives you a harsh stroke with a hard edge that interacts with paper grain and hides underlying 
strokes. Use this brush also when you oil paint.

To paint with the Hard Oil Cloner:

1. Position the cursor where you'd like to start painting.

2. Push down on the stylus and make a short stroke. You'll see adotted line.

3. Let up on the stylus. In a short time your stroke will appear.

This brush interacts with paper texture. Choose different ones in the Paper Palette for unusual results. To 
reveal more paper texture, move the Penetration slider to the left, to hide more, move it to the right. How 



quickly you drag your stylus or mouse determines the width of the stroke. Drag slowly for thick strokes, 
quickly for thin ones. Move the Concentration slider to the left to make strokes more transparent, move it 
to the right to make them more opaque.

Van Gogh Cloner

Paints multi-colored brush strokes in the style of Vincent Van Gogh.

Melt Cloner

Melts an image so that it looks like it's dripping, and it works the way theDistorto variant in the Liquid 
brush works. When you use this brush with oil painting, it'll look like you applied paint with a palette knife. 

Driving Rain Cloner

This variant clones your image as it would look through a window during a rainstorm.

Here's how it works:

1. After you choose the Driving Rain Cloner, click and drag the stylus or the mouse and you'll see slanted 
brush strokes that look like rain drops.

2. When you're done, let go of the stylus or mouse.

To fill in your image with the Driving Rain Cloner automatically, use AutoClone.

Straight Cloner

Duplicates the original image without modification. After you choose the Straight Cloner, simply click and 
drag in your clone and you'll see your original image come through. This brush is great for getting back 
your image if you decide you prefer the original to the changes you've made.

Impressionist Cloner

The directions of your brush strokes are used to place many short dabs in varied colors based on the 
original image.



Turning Other Brushes Into Cloners

Clone Color and Cloning Methods

As you've probably gathered by now, Painter is all about choices. And how you use cloning is no 
exception. Say you don't want to use any of the variants in the Cloners brush for the kinds of work you do.
No problem. You can turn any brush into a Cloner. You can do this in one of two ways, by either checking 
Use Clone Color in the Color Palette or by choosing one of the Cloning Methods in the Method pop-up 
menu in the Brush Palette. The difference is that Use Clone Color will let the brush pick up color from the 
original while staying true to its own nature. Using a Cloning Method, on the other hand, will give you 
brush strokes that are closer in nature and color to the original than to the brush you have selected. Use 
Clone Color uses averaged samples of color from the clone source, resulting in more of an approximation
of the original. The Cloning Methods, meanwhile, use a full set of pixels from the original document, giving
you a truer copy of the original. Using Cloning Methods preserves the original image texture in the clone.

To turn a brush into a Cloner:

1. Select any brush.

2. Click on the Color Palette zoom box to reveal the Use Clone Color check box if it isn't already showing.

3. Click in the check box.

Now painting in the clone image will bring in color from the original in the style of the brush you selected.

To access the Cloning Methods:

1. Select any brush.

2. Click on the Brush Palette zoom box to reveal the Methods pop-up menu if it isn't already showing.

3. Click and hold on the Methods pop-up menu.

4. Drag to the Method you want and let go (the Cloning Methods are in the second section from the 
bottom of the pop-up menu). 

Now clicking and dragging in the cloned image will bring up your original image in the form of the chosen 
Cloning Method.

Here's a brief description of the Cloning Methods.

Hard Cover Cloning

Gives you semi-anti-aliased brush strokes that hide underlying strokes. Moving the Concentration slider to
the right makes these and the other Cloning Method brush strokes more opaque, moving the slider to the 
left makes them more transparent.

Soft Cover Cloning

Produces anti-aliased brush strokes that cover layered ones.

Hard Cover Cloning

The same as Hard Cover Cloning except that brush strokes also interact with paper grain.

Grainy Soft Cover Cloning

The same as Soft Cover Cloning except that brush strokes also interact with paper grain.

Drip Cloning

Pushes color around as if it were wet, cloning the original with distortion based on your stroke.





Fine-Tuning Cloning Methods

Brush Behavior Window

There are two sliders here under Clone Location Variability that can affect the results of the Cloning 
Methods.

Clone Location Variability

Amount sliderand Clone Location Variability

Moving this slider to the right softens the brush strokes and works best with the bristle brushes for 
creating an impressionistic effect.

How Often sliderand Clone Location Variability

With the Amount slider a bit to the right, move the How Often slider to the left to give drawing tools a 
sketchy feel.

Random Cloning checkboxin Brush Behavior window

Checking the Random Cloning box in the Color Palette lets the Cloning Methods pick up all the colors in 
the original image randomly.

AutoClone

Using a cloner brush can start to take a lot of time if you're working on a large area, and sometimes you 
might want Painter to do the strokes for you.

To fill in a cloned area automatically:

1. Select the tool you'd like to clone with. AutoClone works best with the Driving Rain Cloner and the 
Seurat tool. Don't forget to check the Use Clone Color box in the Brush Palette if you want the Seurat tool
to pick up color from the source document.

2. Select all or part of your image.

3. Select Effects: Esoterica: AutoClone.

Painter will apply dabs of paint automatically to the selected area in five-second intervals. To vary the 
color of the dots more, move the ±H, ±S and ±V Color Variability sliders in the Color Palette to the right to 
15% each.

4. When the right amount of the clone has filled in to suit your design, shut off AutoClone by clicking 
anywhere in the image area.

5. Choose Edit: Deselect (Ctrl+D).

Note: If you apply AutoClone to a big area, the paint may fill smaller rectangular tiles one at a time. If you 
click to stop the AutoClone, it will stop where it left off. It won't automatically finish the final tile of the 
overall selected area. To fill in non-rectangular areas, you can use AutoClone with friskets.

AutoCloneslowing down

When you use AutoClone with the Felt Pen Cloner and other tools that turn black as you repeat strokes, 
areas darken rapidly. You can slow down the color buildup and still use AutoClone by dimming your 
original image.

Note: AutoClone works with the Seurat tool in original images, too. Just select the Seurat tool, the area 
and the color you want to fill it with, and choose Effects: AutoClone. Multiple dots will fill the area. This is
great for creating new textures in color.



Cloning with recorded strokes

Document cloning also can be automated with the Record Brush Stroke feature, which can be especially 
useful for filling in backgrounds.

Here's how to quickly fill in a clone using automatic playback of a recorded stroke:

1. Record a brush stroke by choosing a tool, selecting Brush Stroke: Record Stroke (Ctrl+[) and 
dragging in the cloned image.

2. Select the cloned image or part of it.

3. Choose Brush Stroke: Auto Playback. Your recorded brush stroke will automatically fill in the area 
you selected.

4. Click the mouse or press on your stylus to stop the auto playback.

Auto Van Gogh

In Painter 2.0 it's possible to automatically re-render an image with the multi-colored brush strokes that 
were Vincent Van Gogh's signature artistic style. That is, you can choose the Artists brush variant Auto 
Van Gogh with this command. Painter will fill in the brush strokes for you.
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Eraser

Painter gives you two kinds of erasers: the Eraser variants, which erase back to the paper color you 
chose when you started your new document, and the Bleach variants, which erase to white. Other Eraser 
variants, called darkeners, increase density.

To use the erasers, bleaches and darkeners:

1. Position the cursor where you'd like to start erasing.

2. Push down on the stylus (or click the mouse) and drag using short or long strokes.

3. When you're done, let up on the stylus (or release the mouse).

With all the eraser and bleach variants, when you press more heavily on your stylus, you'll erase more, 
the more lightly you press, the less you'll erase. For a similar effect with the mouse or stylus, move the 
Concentration slider to the left to erase less, move it to the right to erase more.

Darkeners

Lightening and deleting part or all of an image are just a couple of Painter's editing capabilities. You can 
darken part or all of your image using the Darkening variants.

To darken your image:

1. Position the cursor where you'd like to start darkening.

2. Push down on the stylus (or click the mouse) and drag using short or long strokes.

3. When you're done, let up on the stylus (or release the mouse).

With all the Darkener variants, moving the Concentration slider to the right will darken areas more quickly,
moving it to the left will darken areas more slowly. Pressing heavily with a stylus will darken an area more 
quickly, pressing lightly will darken areas more slowly. To get the same effect with the mouse, move the 
Concentration slider to the right for darker strokes, and to the left for slower darkening. You can base 
Concentration on the direction you drag the mouse. 



Water

Water smudges and dilutes strokes made by any painting or drawing tool.

To smudge with the Water:

1. Position the cursor where you'd like to start smearing.

2. Push down on the stylus (or click the mouse) and drag using short or long strokes.

3. When you're done, let up on the stylus (or release the mouse).

With all the Water variants, the harder you press on your stylus, the more apparent the smear will be. For 
a similar effect with the mouse, move the Concentration slider to the left for less smear, move it to the 
right for more smear. Adjusting the Concentration slider works with the stylus, too.

To adjust smear width, move the Size slider in the Brush Size window and click Build.

Just Add Water

Smudges with smooth, anti-aliased strokes. This variant will remove paper grain from strokes when it 
smears. Just Add Water reacts to the velocity of your stroke.

Grainy Water

This variant reacts to paper grain. It is ideal for smearing existing textured strokes because it helps them 
maintain their graininess. It can also be used to add some texture to smooth strokes. The smear will 
reflect whatever texture you choose in the Paper Palette.

Frosty Water

Smears with a hard-edged, brittle stroke. Try choosing different textures in the Paper Palette for some 
interesting results.

Tiny Frosty Water

A sharpened version of Frosty Water.

Big Frosty Water

A large brush version of Frosty Water.

Single Pixel Water

The tiniest level of water brush available, similar to wetting a single hair and using it to smear an image.

Water Spray

This variant sprays pixels of water onto the image.

Water Rake

Multi-bristle water applicator.



Toolbox

Painter has a toolbox, but it is a bit different from the toolboxes in other graphics programs in that it 
doesn't hold the software's painting and drawing tools. As we mentioned, the tools reside in a separate 
window, the Brush Palette.

There is a brush tool, however, and clicking on it lets you use tools accessed in the Brush Palette.

The Toolbox also has what have become standard graphics tools -- the Magnifier or Zoom Tool, the 
Grabber, the Eye Dropper, the Selection Tool and the Paint Bucket.

Clicking on the Toolbox's zoom box reveals additional, not-so-standard tools.

Here's where you'll find tools that you'll use to create, move and rotate friskets, in addition to importing 
TrueType and Type 1 fonts as friskets.



Changing View of an Image

There are two ways to zoom in and out of your image in Painter.

Using the Toolbox

To zoom in on an area:

1. Click on the Magnifier Tool in the Toolbox.

2. Click in the part of the image that you'd like to enlarge. The image grows in the same increments as 
those that appear in the Zoom Factor item in the Windows menu. The view is displayed in the title bar 
next to the document's name.

To zoom out of the area with the Magnifier Tool selected:

1. Hold down the Ctrl key. The plus sign in the middle of the Magnifier Tool turns to a minus sign.

2. Click in the area you wish to reduce. The image will shrink in the same increments as the ones that 
appear in the menu. In the title bar you'll see the percentage view of your image.

Using the menu

1. Choose Windows: Zoom Factor.

2. Scroll to the zoom factor you seek. You can see anywhere from 8.3% to 1200% of your image in 
Painter.

3. When you have highlighted the desired zoom factor, let go of the stylus or the mouse. In the title bar 
you'll see the percentage view of your image.

Shortcut: Access the Magnifier Tool when you have another tool selected by pressing Ctrl+Spacebar for 
zooming up and    Alt+Ctrl+Spacebar for zooming down.



Moving Around in an Image

To use the Grabber Tool:

1. Click on the Grabber Tool in the Toolbox to select it.

2.    Click and drag the stylus or mouse on the image area. You'll see the image move.

3.    When you are done, let go of the mouse or the stylus.

Shortcut: With the Brush Tool selected in the Toolbox, hold down the Spacebar to access the Grabber 
Tool.



Eye Dropper Tool

If you want to pick up a color from an existing image and use it elsewhere, you can do so with the Eye 
Dropper. The Eye Dropper can also be used on open but non-active windows.

1. Select the Eye Dropper in the Toolbox.

2. Click on the front Overlapping Rectangle in the Color Palette to make it active if it isn't already.

3. Move the cursor to the color you wish to pick up. The cursor is in the shape of the Eye Dropper.

4. Click on the color. The front Overlapping Rectangle    shows this color.

5. Click on the Brush in the Toolbox to select it and start    painting.

Note: You can sample colors with the Eye Dropper in non-active windows.

Shortcut: With the Brush Tool, Selection Tool or Paint Bucket selected in the Toolbox, you can access the
Eye Dropper by holding down the Ctrl key.

Image Clone

Another way to pick up a color from your image is to use cloning.

1. Select a Cloner in the Brush Palette, check Use Clone Color in the Color Palette or select a Cloning 
Method.

2. Hold down the Shift key and click on the color you'd like to lift.

3. Click and drag in the image where you'd like to place the color.

Note: You're actually cloning the image, so you'll be filling in a copy of the image as you drag.



Selecting and De-Selecting

You can select rectangular pieces of your image using the Selection Tool, or you can select irregular 
areas by using the Frisket tools.

To select a rectangular portion of an image:

1. Click on the Selection Tool in the Toolbox to choose it.

2. Click and drag with the stylus or the mouse in the part of the image you wish to select.

3. When you are done, let go of the mouse or stylus.

To de-select a portion of an image:

Click outside of the selected area while the Selection Tool is still selected or choose Edit: Deselect 
(Ctrl+D).

To select an entire image:

Choose Edit: Select All (Ctrl+A). Double-clicking the Selection Tool will select all of the visible image.

To de-select the entire image:

Double-click on the Selection Tool or choose Edit: Deselect (Ctrl+D).

Re-select

The Reselect item in the Edit menu works just with friskets.

Shortcut: You can adjust any corner of a selection made by the Selection Tool by pressing the Shift key 
as you click and drag. Make a square marquee by pressing the Shift-Ctrl key as you drag.



Undo

To undo your most recent change, select Edit: Undo (Ctrl+Z).



Revert

Another way to undo changes is to choose File: Revert. This will bring you back to the most recently 
saved version of your image. The idea is to do a save before you try anything tricky, or you may lose the 
changes you made up to that point! Also, revert doesn't work on untitled, and therefore unsaved, 
documents (because you haven't saved it yet!).

To Revert:

1. Choose File: Revert.

2. Click Yes to lose changes.



Fade

Fade is an editing technique in Painter to undo part of your most recent change. Fade can partially undo 
any just-completed operation.

To do a fade:

1. Select Edit: Fade... The Fade Last Operation dialog box appears. 

2. Move the slider until the preview reflects the amount you'd like to fade.

3. Click OK.



Clear

To clear part or all of your image:

1. Select a portion of you image or all of it.

2. Choose Edit: Clear.

The area you selected will fill with the paper color that you chose in the New Picture Size dialog box when
you created your document.



Cut, Copy and Paste

Cut, Copy and Paste commands in the Edit menu work the way they do in other programs. 

To cut or copy:

1. Select the area that you would like to cut or copy.

2. Choose Edit: Cut (Ctrl+X) or Edit: Copy (Ctrl+C). When you choose Cut, the paper color that you 
selected in the New Picture Size dialog box when you created your document fills the selected area.

To place the cut or copied section, choose Edit: Paste (Ctrl+V).



Paste Into New Picture

Choosing Edit: Paste into New Picture automatically creates a new document containing the cut or 
copied section. Feature is useful for cropping.



Moving a Selection

When you select something in Painter it    can be moved anywhere in your image by clicking and dragging
on it with the Selection Tool.

To move a selection:

1. Select a portion of an image.

2. Click inside the selection and drag the stylus or mouse to move the selection.

3. When you are done, let go of the mouse or the stylus.

4. Click outside the selection or choose Edit: Deselect (Ctrl+D) to drop the floating selection.

Note: With your cursor inside the selection, press the Alt key to leave a copy behind when picking up a 
floating selection. The Delete key removes a floating selection. Most operations work directly on floating 
selections.



Virtual Private Scrap

Painter has a virtual private scrap, a kind of clipboard. Cut, Copy, Paste and Paste Into New Picture will 
work on a selection of any size.



Delete

To delete a portion of the image, first select that portion and then press the Backspace key. The paper 
color that you selected in the New Picture Size dialog box when you created your document fills the 
selected area.



Drawing or Painting Straight Lines

Here's how you create a straight line in Painter:

1. Select the brush you'd like to use.

2. Choose Brush Stroke: DrawStraight Lines (Ctrl+L).

3. Click the stylus or mouse where you'd like your stroke to start. You'll see an origin point marker.

4. Click and hold where you want your stroke to finish. You'll notice a thin line connecting the two points. 
Before you let go, you can move the stylus or mouse around and place the finishing point exactly where 
you want it.

5. Let go. Painter fills in a straight line between the two points.

6. Continue to draw more lines in the same fashion, if you wish. When you are done, press the Enter key 
if you want Painter to draw a line from where you left off to the origin point. If you don't want to connect 
the points, choose Brush Strokes: Draw Straight Lines (Ctrl+L), or Brush Strokes: Draw Freehand 
(Ctrl+K) if you wish to return to free-flowing drawing. 

Note: To constrain your line to a 45° or 90° angle, hold down the Shift+Ctrl keys as you click your second
point. Lines automatically are constrained to a grid if the grid is turned on.



Grid Overlay

Painter 2.0 gives you a grid layer to help guide your brush strokes. To activate the grid choose Options: 
Grid Overlay, or click the grid icon on the right side of your image window. Your image now has a non-
printing grid. When you paint or draw with the grid turned on you'll see your brush strokes at 50% opacity. 
When you turn off the grid, the strokes will be at 100% opacity.

Grid

You can set up the grid to suit your working style by choosing Options: Grid Options... Tab between the 
following fields to reach them quickly.

Grid Format

Click and hold on the pop-up menu to determine if your grid will be rectangular, or have just vertical or 
horizontal lines.

Horiz. Spacing

Determines the amount of space between horizontal lines. Unit of measure can be in pixels, inches, 
centimeters, points, picas and columns.

Vert. Spacing

Determines the amount of space between vertical lines. Uses the same unit of measure as Horiz. 
Spacing.

Line Thickness

Sets the width of grid lines. Uses the same unit of measure as Horiz. Spacing and Vert. Spacing.

Grid Color

Click on the color square to change the color of the grid lines. Choose a color in the Color Picker, then 
click OK or press Enter. The default color is a light blue.

Background

Click on the color square to change the grid's background color. Choose a color in the Color Picker, then 
click OK or press Enter. The default color is white.



Resize

Painter 2.0 lets you change existing image dimensions or resolution or both.

To resize an image:

1. Choose File: Resize... The Resize Image dialog box appears.

The bottom half of the box shows you the current image size. You'll assign new image dimensions in the 
top half of the box.

2. Type in a new width or height. The other dimension will change proportionally.

3. Type in a new resolution if desired.

4. Check the constrain box if you want to freeze the amount of disk space the file occupies.

5. Click OK or press Enter.

The image now reflects your changes. Units of measure available are pixels, inches, centimeters, picas, 
points, columns and percent.



Image Size Information

To find out how big your current image is and how well it fits on paper, click and hold on the i (the 
international symbol for information) in the bottom left-hand corner of your image window. The window 
shows you how your image fits on the page size and orientation that are designated in the Page Setup 
dialog box, in addition to graying out your non-printing area around the edge of the page. If you change 
your image's resolution or dimensions by choosing File: Resize..., you can use the i window to see how 
the changes affect the way the image fits on the page.



Color Overlay

Use Color Overlay to add color and texture to your image at the same time.

1. Select the color you'd like to fill the area with.

3. Select the area you'd like to fill. Otherwise, Painter applies Color Overlay to the entire image.

4. Choose Effects: Surface Control: Color Overlay....

5. Decide on a model.

Dye Concentration means the paper absorbs the color.

Hiding Power means the color covers what's beneath it. 

6. Move the slider until the preview reflects your preferred opacity.

7. In the Using Menu:

Uniform Color

Will add a flat tint to your image.

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette (if the Paper Palette is already 
open, different textures may be chosen while Apply Color dialog is open).

Image Luminance

Creates texture based on the image's brightness.

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

8. Click OK or press Enter.



Adjust Dye Concentration

You'll use Adjust Dye Concentration to adjust color intensity and to add surface texture. It can be used to 
lighten an underexposed photo, or to darken an overexposed one, since it works by adjusting pigments.

1. Select the area you'd like to adjust. Otherwise, Painter will adjust the entire image.

2. Choose Effects: Surface Control: Adjust Dye Concentration... The Adjust Dye Concentration dialog 
box appears.

3. In the Using menu:

Uniform Adjustment

Will adjust color without adding a texture.

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette.

Image Luminance

Creates texture based on the image's brightness.

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

4. Adjust the sliders.

When you choose Uniform Adjustment, moving the Maximum slider above 100% increases color density. 
A value below 100% decreases it. Moving the Minimum slider has no effect. With the other Using menu 
items selected, both sliders are operable.

Here's how the sliders work:

If you think of texture as peaks and valleys, the Maximum slider controls the dye on peaks and the ximum
as high as 800%. The lower you set Minimum, which can be as low as 0%, the higher the contrast will be 
between peaks and valleys. The higher the Minimum slider, the flatter the paper will appear.

5. Click OK or press Enter.



Apply Lighting

A new feature in Painter 2.0, Apply Lighting lets you establish one or more light sources of any color from 
any direction with any intensity for part or all of your image. Apply Lighting requires a floating point unit 
(FPU).

1. Select part of your image. Otherwise, Painter will apply lighting to your entire image.

2. Choose Effects: Surface Control: Apply Lighting...

In the upper left is a preview of how the changes you make in this dialog box affect your image. In the 
lower left is a scrolling palette of lighting choices that have been set up for you. The palette works like the 
Paper Palette and the Brush Palette. When you first open the dialog, Plain Light is selected, it has a black
line around it and its name appears under the scroll bar. Click in each of the choices and you'll see how 
they look in the preview.

3. After you find a lighting effect that appeals to you, click OK or press Enter and Painter will apply it to 
your image.

Apply Lighting

You can use the controls in the Apply Lighting dialog box to achieve other lighting effects. The preview will
show your changes, so you can just play around and see what happens. The following sections tell you 
what the controls mean.

Note: Standard camera-based principles apply to editing lighting. For example, if you turn up the lights, 
you may have to adjust exposure.

Light Source

In your preview you see one or more indicators, depending on the effect you selected in the scrolling 
palette. The small part of the indicator points to your light source, the large part shows where the light 
actually is.

To move the indicator, click and drag on its large end.

To change the light source direction, click and drag on the small end.

To create another indicator, click anywhere else.

You can click once on an indicator to select it. To remove it, press Backspace or Delete.

Here's what the sliders control:

Brightness is like a dimmer knob. Moving it to the left turns down the light source, moving it to the right 
increases brightness.

Distance controls how far the big circle in the indicator is from the light source. If you move the light 
source closer, you may have to change the image's exposure (see below).

Elevation is your light's angle. At 90° the light is shining straight down, and at 1° it's very shallow.

Spread is the light beam's width.

Exposure is the image's brightness as in photography. Moving the slider to the left decreases exposure, 
moving it the right increases exposure.

Ambient is the surrounding light in an image. Moving the slider to the left gives you stark lighting, moving 
it to the right softens the light.

Light Color



Click in the square and choose a color for your light source in the Color Picker. Then click OK or press 
Enter.

Ambient Light Color

Click in the square and choose a color for you surrounding light in the Color Picker. Click OK or press 
Enter. 

Lighting Effect

Once you have completed your changes, click Save, type in a name for your new lighting effect and click 
OK or press Enter. It is now a choice in the palette and can be used with any image.

When you are done making changes in the Apply Lighting dialog box, click OK or press Enter.

Note: While not as slow as ray-tracing, this effect is one of the more time-consuming effects in Painter 
2.0.



Apply Surface Texture

Another Painter sleight of hand is the ability to add a three-dimensional surface texture to your image. 
You'll use this option for something as simple as adding a paper texture or a complex move like creating 
an oil painting.

Adding a Paper TextureTexture

1. Choose a paper grain in the Paper Palette that you would like to add to your image. 

2. Select a portion of your image. Otherwise, Painter will apply surface texture to the entire image.

3. Choose Effects: Surface Control: Apply Surface Texture... The Apply Surface Texture dialog box 
appears.

4. Choose Paper Grain in the Using pop-up menu. You'll see in the preview that the paper you chose in 
the Paper Palette now covers your image (if the Paper Palette is already open, different textures may be 
chosen while Apply Surface Texture dialog is open).

5. Moving the Amount slider controls how much surface texture is applied to the image, and when the 
slider is all the way to the right, the maximum amount is applied.

6. Check Shiny for a tinselly, aluminum-foil effect.

7. Clicking in the buttons above Light Direction changes highlight and shadow locations.

8. When the preview shows the image is the way you want it to be, click OK or press Enter.

Note: We have been asked if you can apply a paper texture when you first create an image and then 
paint or draw over it. You can, but the paper is erasable, which is good if you want to make changes to the
paper, but not good if you only want to edit a stroke and not the paper. Generally you'll add the paper 
texture as the last step, not the first step, in developing your image.

The next question usually is how do you create brush strokes that show the paper texture. The answer is 
that the brushes that react to paper grain pick up the texture that you choose in the Paper Palette, not the 
paper that you add using Apply Surface Texture. 

Image Luminance

Follow the above steps except choosing a paper texture, and in the Using menu choose Image 
Luminance instead of Paper Grain. Painter uses the image's brightness to determine where to add 
surface texture.

Other Using Menu Choices

The 3D Brush Strokes item makes brush strokes appear to be three-dimensional, giving them the illusion 
of oil paints (the difference between the clone and the original becomes 3D texture). Original Luminance 
gives you an embossing effect. These two choices only work in a cloned image and are dim if you are 
working in an original image.

The Frisket choice produces surface texture around the edges of a frisket.



Apply Screen

Apply Screen is another way to add texture to your image. It combines luminance, the chosen paper 
texture in the Paper Palette and the three colors you pick in the Apply Screen dialog box to produce the 
textured effect. Apply Screen adds a three-color screen to your image.

To use Apply Screen:

1. Select an area. Otherwise, Painter will apply the screen to the entire image.

2. Choose Effects: Surface Control: Apply Screen... The Apply Screen dialog box appears.

3. Click on each square to call up the Windows Color Picker. Click on the color you prefer, then click OK 
or press Enter.

4. Moving the Threshold 1 slider determines how much of the top and middle squares' color will be in the 
image. Moving it to the left increases the amount of the top color, moving it to the right increases the 
amount of the middle color.

5. Moving the Threshold 2 slider determines how much of the middle and bottom squares' colors will be in
the image. Moving the slider to the left increases the amount of the middle color, moving it to the right 
increases the amount of the bottom color.

6. In the Using menu:

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette (if the Paper Palette is already 
open, different textures may be chosen while Apply Screen dialog is open).

Image Luminance

Creates texture based on the image's brightness. Similar to a three-level posterization.

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

7. Click OK or press Enter.



Brightness/Contrast

The Brightness/Contrast window adjusts the contrast and brightness of your overall image in the RGB 
format, whereas Adjust Dye Concentration converts the image to a dye density domain and adjusts it 
there. To adjust the RGB contrast and brightness of your image or of a portion of the image:

1. Select part of your image. Otherwise, Painter applies Brightness/Contrast adjustments to the entire 
image.

2. Choose Effects: Tonal Control: Brightness/Contrast...

3. Click and drag in the upper slider to adjust image contrast.

4. Click and drag in the lower slider to adjust image brightness.

The image is redrawn when you let up on your mouse or stylus.

You can reset the sliders to normal by clicking the Reset button. To save your changes, click Apply.



Equalize

The Equalize effect improves contrast, adjusting black and white points and distributing the pixels' 
brightness levels throughout the entire range of available brightness levels. To achieve this, Painter 
creates a histogram showing the number of pixels for each brightness level value. Equalize allows 
gamma adjustment, which lightens or darkens an image without changing highlights or shadows.

To equalize:

1. Select part of your image. Otherwise, Painter equalizes the entire image.

2. Choose Effects: Tonal Control: Equalize.... The Equalize dialog box appears containing a histogram.

3. Click the Apply button to automatically equalize the selection.

You'll see that the image now appears crisper.

You can make contrast appear even starker by manually setting the black and white points.

To set the white and black points manually:

1. Inside the Equalize dialog box, drag the small white triangle under the histogram to the left and drag 
the black triangle to the right. Now, any values in the image located to the right of the white marker 
become white, any values to the left of the black marker become black. Your changes will be apparent 
while you're still in the dialog box.

2. Click Apply to apply changes.

You can also adjust the image's gamma in the Equalize dialog box. To do so:

1. Move the Brightness slider to the right to increase gamma, which makes the image darker. Move the 
slider to the left to decrease gamma, making the image lighter. Changing the gamma adjusts only the 
midtones of an image and leaves the white and black areas untouched. Your changes will be apparent 
while you're still in the dialog box.

2. Click Apply to apply changes. 

To cut down on the time it takes to compute a histogram in the Equalize Shades dialog box, you can 
select an area of your image that represents the range of grayscale shades in the entire image. If you are 
happy with the results, check the Apply to Entire Image box and Painter will equalize the entire image. 
Click Apply to affect the selection only.



Posterize

To adjust the number of color levels in your image:

1. Select part of your image. Otherwise, Painter posterizes the entire image.

2. Select Effects: Tonal Control: Posterize.... The Posterize dialog box appears.

3.    Enter a number of levels. The lower the number you enter, the more dramatic the effect will be.

4.    Click OK or press Enter.

Note: To posterize an image combined with a paper grain, use Apply Screen. To posterize to two levels 
and adjust the threshold level, use Equalize.



Negative

Choose Effects: Tonal Control: Negative to turn part or all of your image into a negative.



Rotate

To rotate a selection:

1. Select part of your image. Otherwise, Painter will rotate your entire image.

2. Choose Effects: Orientation: Rotate... The Rotate Selection dialog box appears.

3. Enter the angle you'd like or click and drag on a corner of your selection. The numerical value of the 
angle is reflected in the Rotate Selection dialog box.

4. Click OK or press Enter.    The image is left floating until it is de-selected.



Scale

Scale lets you change the dimensions of part or all of your image.

1. Select part of your image or Painter will scale the entire image.

2. Choose Effects: Orientation: Scale...

3. Either click and drag on your selection handles or enter the percentages that you'd like to increase or 
decrease your selection by.

4. Check Constrain Aspect Ratio to maintain your selection's proportions. Unchecking this item lets you 
change horizontal and vertical measurements independently.

5. Checking Preserve Center keeps the item anchored in its location.

6. Click OK or press Enter. The image is left floating until it is de-selected.



Distort

This menu item lets you contort the shape of a selection. To do so:

1. Select part of your image.

2. Choose Effects: Orientation: Distort.... You'll see two things happen. The selection now has handles 
around it, and the Distort Selection dialog box appears.

3. Click and drag on the handles to reshape the selection.

4. Check the Better (Slower) box if you'd like a more accurate rendering of your changes, although it will 
take longer. Checking this box is particularly useful in highly distorted cases.

5. Click OK or press Enter. You'll see a dialog box telling you Painter is distorting your selection. The 
image is left floating until it is de-selected.



Flip Horizontal

To flip an image horizontally:

1. Select part of your image. Otherwise, Painter will horizontally flip your entire image.

2. Choose Effects: Orientation: Flip Horizontal.

3. Your selection is now the mirror image of itself.



Flip Vertical

To flip an image vertically:

1. Select part of your image. Otherwise, Painter will vertically flip your entire image.

2. Choose Effects: Orientation: Flip Vertical.

3. Your selection is now the vertical mirror image of itself.



Sharpen

This effect heightens contrast by intensifying highlights and shadows.

To sharpen:

1. Select part of your image. Otherwise, Painter sharpens the entire image.

2. Choose Effects: Focus: Sharpen...

Radius

How much of the edge of an element is affected is determined here. The further the slider is to the right, 
the wider the affected area will be.

Highlight

Determines the intensity of the bright areas. The further the slider is to the right, the brighter the highlight 
will be.

Shadow

Determines the depth of the shadows. The further the slider is to the right, the darker the shadows will be.



Soften

This effect increases the transition from one part of your image to another, enhancing the anti-aliasing of 
strokes.

1. Select an area. Otherwise, Painter softens the entire image.

2. Choose Effects: Focus: Soften.... The Soften dialog box appears.

3. The further the slider is to the right, the more steps there will be between one image element and 
another, which will mean more blurring. 

4. Click OK or press Enter. 



Glass Distortion

Using this effect, another bit of Painter magic, you can put your image behind glass.

1. Select part of your image. Otherwise, Painter will distort your entire image.

2. Choose Effects: Focus: Glass Distortion. The Glass Distortion dialog box appears.

3. Adjust the Amount slider. The further you move it to the right, the more distorted your image will be.

4. Adjust the Variance slider. The further you move it to the right, the more your image will break up, kind 
of like glass shattering.

5. In the Using menu:

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette.

Image Luminance

Creates texture based on the image's brightness.

3D Brush Strokes

Creates three-dimensional texture by comparing the difference between the source document and the 
cloned document. 

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

6. Click OK or press Enter.



Marbling

This effect creates marbled patterns and is based on an actual technique of pulling on ink or pigment that 
floats on liquid in a pan called the Size. The marbling is achieved by dragging a rake through the liquid in 
various directions. The controls here are similar to those used by real-life marblers.

To marble your image:

1. Select part of your image or Painter will marble the entire image.

2. Choose Effects: Esoterica: Apply Marbling... The Apply Marbling dialog box appears.

3. The preview shows you the direction of the marbling, which you can change by clicking in the buttons 
on the right.

4. Adjust the sliders. Here's what they do:

Spacing

The space between rake teeth. The higher the spacing, the more dispersed the marbling will be.

Offset

How much the rake will shift each time it passes over the image. The higher the offset, the more complex 
the marbling effect looks.

Waviness

Determines how deep the waves are. The lower the amount, the flatter the waves will be.

Wavelength

Controls the wave's curve. You lengthen the curve's period    by moving the slider to the right.

Phase

Decides in which point in the wave's period it starts.

Pull

Controls how much the ink is pulled by the rake. The further the slider is to the right, the more intense the 
pull is. Changes in this slider aren't reflected in the preview's rake display.

Quality

You can improve the quality (anti-aliasing) of the marbling, but the further you move the slider to the right, 
the longer the marbling will take.

When you have completed your adjustments, click OK or press Enter.



Blobs

This effect is similar to marbling in that it involves making a pattern in paint floating on liquid in a pan. It 
takes whatever you copy (or uses the current color if Clipboard is empty) and puts it in a swirling pattern 
by placing blobs into the liquid image. Called a Stone pattern, this is used as a starting point in marbling. 
Blobs requires a floating point unit (FPU).

To use Blobs:

1. The first time you try this effect, select a recognizable element.

2. Choose Edit: Copy (Ctrl+C).

3. Select a 2-inch square blank area in your image.

4. Choose Effects: Esoterica: Blobs... The Create Marbling Stone Pattern dialog box appears.

5. The first field is number of blobs. For this test, enter 20.

6. Min Size and Max Size designate blob size. For now, set Min Size at 50 and Max Size at 60.

7. Subsample creates the anti-aliasing steps. Enter 8 for this test.

8. Click OK or press Enter. You'll see a swirling pattern using the element you copied.

Hint: Try using a circular frisket shaded like a sphere (instead of a recognizable element) using the 
Airbrush before choosing Edit: Copy.



Highpass

Highpass suppresses low frequency areas containing gradual or smooth transitions of brightness levels. 
This leaves high frequency areas, or just the edges of an image, containing stark shifts between 
brightness levels. You can make the Highpass more pronounced by using the Equalize command.

To use Highpass:

1. Select an image area. Otherwise, Painter highpasses the entire image.

2. Choose Effects: Esoterica: Highpass... The Highpass dialog box appears.

3. The Radius slider determines the amount that the low frequency areas will be suppressed. This value 
defines a radius in pixels around each pixel in the selected image area. With the slider to the left, larger 
amounts of low frequency information are suppressed; with the slider to the right, smaller amounts of low 
frequency information are suppressed.

4. Click OK or press Enter.



Grid Paper

Using Grid Paper in the Effects menu, you can add horizontal or vertical lines or a grid to part or all of 
your image that is fully editable and blendable with the rest of your design. The idea is the same as Grid 
Overlay. The difference is that Grid Overlay is a transparent, non-printing layer that floats above your 
image like Tracing Paper. Grid Paper, on the other hand, is an effect that becomes part of your image.

To add Grid Paper:

1. Select part of your image. Otherwise, Painter will apply Grid Paper to your entire image.

2.    Select Effects: Esoterica: Grid Paper. The Grid Options dialog box appears.

3. Set the following:

Grid Format

Click and hold on the pop-up menu to determine whether your grid will have squares, vertical lines or 
horizontal lines.

Horiz. Spacing

Determines the amount of space between horizontal lines.

Vert. Spacing

Determines the amount of space between vertical lines.

Line Thickness

Sets the width of grid lines.

Grid Color

Click on the color square to change the color of the grid lines. Choose a color in the Color Picker, then 
click OK or press Enter.

Background

Click on the color square to change the grid's background color. Choose a color in the Color Picker, then 
click OK or press Enter.

4. Click OK or press Enter.



Motion Blur

Makes your images appear as if it has been blurred by movement or the panning of a camera.

1. Select an area. Otherwise, Painter puts the whole image into motion.

2. Choose Effects: Focus: Motion Blur...

3. Set the following sliders:

The further the Radius slider is to the right, the faster the image will appear to be moving.

Angle sets the direction in which the image seems to travel.

Thinness blurs the image in a direction perpendicular to the angle you choose with the Angle slider.

4. Click OK or press Enter.



Plug-ins

Here's how you access third-party plug-ins from within a document:

1. Select all or part of your image.

2. Choose Effects: Plugin Filters.

3. You will see a list of your plug-ins. You can now use them to edit your image.



Using Friskets

A frisket is a mask that you place on artwork to shield certain areas during painting or retouching. 
Painter's friskets can also be used to make selections.

Frisket Palette

Creating a Frisket

Polygon Frisket

Frisket from EPS

Selecting Friskets

Frisket Maneuvers

Friskets Editing Friskets

Negative Friskets

Smoothing Friskets

Text as a Frisket

Feathered Frisket

Saving a Frisket

Frisket Library

Setting Frisket Color

Friskets as Selections

Magic Wand

Special Effects

Repeated Brush Strokes



Frisket Palette

The Frisket Palette is where you'll control friskets, even if the window isn't showing. It's especially 
important because it's where you'll turn your friskets on and off.

If you understand the Frisket Palette you won't confuse it with the role of the frisket Pointer tool, a 
powerful new frisket-editing feature.

Open the Frisket Palette by choosing Windows: Frisket Palette (Ctrl+9), or by clicking on the Toolbox's 
zoom box, then double-clicking on the Knife tool or the Frisket Line tool.

The top row of icons next to the pencil represents how the frisket affects painting or image-editing. 
Clicking in the first box shuts off the frisket, clicking in the second protects the area inside the frisket, and 
clicking in the third protects the area outside the frisket.

The bottom row of icons next to the eye is your directory to what you'll see when you're painting or image-
editing. When you click in the first box, the frisket can't be seen, but works based on which icon in the top 
row you selected. When this and the box above it are outlined, the frisket is shut off. Clicking the second 
box displays the frisket as a color overlay. The third box shows the outline of your frisket as a selection 
marquee.

The Image Window

You can access the Frisket Palette icons without opening the Frisket Palette by clicking and holding in the
bottom left-hand corner of your image window. Notice that the first icon corresponds to the top-row icons, 
the one next to it corresponds to the bottom row of icons in the Frisket Palette.

The Edit Menu

You can also use the Edit menu to turn friskets on and off. To see how this works, click on the Knife tool 
and draw a frisket by clicking and dragging in your image window. The last icons in the Frisket Palette are
automatically outlined. This means that your frisket looks like a selection marquee and you can paint 
inside of the frisket. 

Now choose Edit: Deselect (Ctrl+D). Notice that the frisket disappears and that the first icon in each row 
of the Frisket Palette is outlined. You just shut off your frisket. Now choose Edit: Reselect (Ctrl+R). Your 
frisket returns and the last icons in the Frisket Palette are again outlined, turning your frisket back on.



Creating a Frisket

In Painter 2.0, you have the choice between freehand friskets and straight-line friskets. You can also 
import type as a frisket.

To draw a freehand frisket:

1. Click on the Knife tool to select it.

2. Click and drag on the area where you'd like your frisket to be. If you don't like the shape of your frisket, 
you can draw another and Painter will replace the first one. The first frisket still exists, it's just inactive. If 
it's close to the shape you need, you can edit it or resize it.



Polygon Frisket

To create polygon friskets:

1. Select the Frisket Line tool.

2. Click where you want your frisket to begin. An origin mark appears. Click again where you want the 
other end of the line to be. If you click and hold, an invisible rubber band shows you where your line will 
be. You can move the mouse or stylus while continuing to click and hold to position the line exactly where 
you want it. Continue to click, creating the sides of the polygon. To constrain the line angle to 45° or 90°, 
press the Shift key as you click.

3. To complete the frisket, press the Enter key on the keypad. A line is drawn from your ending point to 
the origin point and the polygon becomes a frisket. If you click your end point on your start point, pressing 
Enter finishes the frisket and gives you the selection marquee.

Note: If you zoom up the size of your image, the Frisket tool behaves as it did at 100%. This allows you to
create very precise friskets if, for instance, you are working on a photograph and need to mask out a very 
intricate area. Also, The straight-line friskets are constrained to the grid if the grid is turned on.



Frisket from EPS

To import a frisket from an EPS file:

1. Click on the Library... button at the bottom of the Frisket Palette. A dialog box will appear.

2. Click Open EPS and the Open dialog box appears.

3. Locate the EPS file you wish to import as a frisket. Double-click the file name, or click once on its name
and then click Open. The new frisket appears in your image window. It can be saved to a frisket library.

When you're done creating your frisket, you're ready to draw or paint. Just click in the Toolbox to select 
the Brush tool and then select a tool in the Brush Palette and begin. You can also apply an effect.



Selecting Friskets

The frisket Pointer tool is a selection tool. To see how it works, use either the Knife or Frisket Line tool to 
draw a frisket, then draw two more holding down the Ctrl key. Then click on the Pointer tool. You'll see 
little boxes around your friskets. These are selection handles, and when you see them around a frisket, it 
means the frisket is active. You'll use these selection handles to manipulate your frisket. When you de-
select a frisket, you're making it inactive, but you're not shutting it off and you're not deleting it. That's a 
separate step, as you'll see in a moment. Now draw three friskets in a row without holding down the Ctrl 
key. Then select the Pointer tool. The last frisket you drew has selection handles and it is active, the first 
two appear but they are inactive.

Here's the rule: Friskets that are selected using the Pointer Tool are used as masking friskets when 
using any other tool, especially the brush.

To Select an Inactive Frisket:

Click on it with the frisket Pointer tool.

To Deselect an Active Frisket:

Either click anywhere outside of it, or choose Edit: Deselect (Ctrl+D).

Note: Here's the difference between Edit: Deselect (Ctrl+D) when you're using the Pointer tool and 
either the Knife or Frisket Line tool: When you de-select with the Pointer tool chosen, your friskets are still
turned on. Check the Frisket Palette and you'll see that the icons in the last row are outlined. Deselect 
with the Knife or Frisket Line tools chosen, however, and your frisket is shut off, as the Frisket Palette 
shows. Also, Edit: Reselect (Ctrl+R) only works when you de-select with the Knife or Frisket Line Tool, 
not the Pointer Tool. Another thing that might be confusing is when you have the Pointer Tool selected you
see the friskets, but when you go to the Frisket Line, Knife or Brush tools, they disappear. This is because
you de-selected them with the Pointer Tool. If you select one or more friskets with the Pointer Tool, they'll 
be visible when you go back to the Frisket Line, Knife or Brush tools.

Selecting, De-selecting Multiple Friskets with the Pointer Tool
To select more than one frisket at a time, hold down the Shift key, select the frisket Pointer Tool and click 
on the friskets you wish to make active. Or choose the frisket Pointer Tool and click and drag a selection 
marquee to touch the friskets you wish to select. To de-select a frisket while keeping others active, hold 
down the Shift key, select the frisket Pointer Tool and click on the friskets you wish to deactivate. Click on 
the edge of a frisket to select it if there is a complex overlapping of friskets.

Selecting and De-selecting All Friskets
There are a couple of ways to select all friskets:

Choose Edit: Select All (Ctrl+A), or click and drag a selection marquee around the friskets with the 
Pointer Tool.

To de-select all friskets:

With all    click with the frisket Pointer Tool anywhere outside of the friskets.

To Delete a Frisket

Select it with the frisket Pointer Tool, then press Delete or Backspace. Deleting a frisket means it's gone 
forever, unless you saved it. Shutting it off in the Frisket Palette means you can turn it back on by clicking 
in the other boxes in the Frisket Palette.

Note: If you forget to click on the frisket Pointer Tool, when you press Delete or Backspace, Painter will 
remove the area within the frisket, not just the frisket itself.





Frisket Maneuvers

The following maneuvers happen with the frisket Pointer Tool selected. They work on individual friskets or
on groups.

To Move

Click and drag on the frisket.

To Resize

Click and drag on a corner or side selection handle. Shift-clicking and dragging on a corner handle will 
resize a frisket proportionally.

To Rotate

Ctrl-click on a corner handle, then drag.

To Skew

Ctrl-click on a side handle, then drag.

To Copy

Press the Alt key, then click and drag on a selected frisket.



Friskets Editing Friskets

You can use friskets to cut pieces out of intersecting friskets in Painter 2.0. This is a handy tool for effects 
such as opening up an area within a frisket, in essence punching a hole in the frisket, and for creating 
layered shapes or image sections.

The way this works is by turning an intersecting frisket into a negative frisket so that it cuts a section out 
of a positive one, and you can do this in one of two ways. You can either use the plus and minus buttons 
in the bottom of the Frisket Palette or you can use the Alt+Ctrl keys. You'll use the Frisket Palette buttons
for more complex frisket-editing maneuvers, and you'll use the keyboard for more simple moves, as you'll 
see in the next sections.

Note: Negative friskets can only be used to eat holes out of positive friskets.



Negative Friskets

Take a minute to go through the following steps and you'll see an illustration of the use of negative friskets
to create layers.

1. Select the Knife Tool and draw a frisket of any shape. Notice that the Frisket Palette defaults to the last 
settings in each row, meaning you can paint inside of your frisket which is displayed as a selection 
marquee.

2. Draw a second frisket and make it overlap the first frisket. Both friskets are positive.

3. Preview the friskets as a color using the middle button in the eye row in the frisket palette. Notice that 
the two friskets appear as one shape.

4. View the friskets as a marquee again. Select the frisket on the right with the Frisket Pointer Tool. Click 
once on the Negative button in the Frisket Palette. The frisket is now displayed as a red marquee.

5.    Again view the frisket as a color. This time you see that the negative frisket takes a bite out of the 
positive frisket. 

Using the Keyboard

You can also create a negative frisket using the keyboard. You'll use this method when you first draw a 
negative frisket or if you only need one. For designs with more friskets, and to switch friskets from positive
to negative and back, use the Frisket Palette buttons.

Let's say you want to punch a hole in a frisket. Here's how to do it:

1. Draw a frisket.

2. With the Knife Tool or the Frisket Line Tool selected, hold down the Ctrl+Alt keys. A small minus sign 
appears next to the cursor.

3. While holding down the keys, draw inside the first frisket. You now have a frisket with a hole in it. When 
you paint across the two friskets with a brush, there will be color inside the frisket but not inside the hole.



Smoothing Friskets

To smooth the edges of a frisket:

1. Click on the Pointer Tool and click on a frisket to select it.

2. Click on the Frisket Smoother button next to the minus button at the bottom of the Frisket Palette.

Repeat the above steps to make the effect more pronounced.



Text as Frisket

Adding type to your images is now possible in Painter 2.0. You can import True Type and Type 1 fonts as 
friskets, then you can manipulate them the same as you do other friskets. 

To create a type frisket:

1. Double-click on the Frisket Text Tool in the toolbox. The Text Specifications dialog box appears.

2. Either click on Import Type 1 or Import TrueType to choose a typeface. If you click on Import Type 1, 
you will get a dialog box. Locate the outline font you wish to import and either double-click on it or 
highlight it and click Open or press Enter. If you click Import TrueType, the Import TrueType Font dialog 
box will appear. Choose the font you'd like in the pop-up menu and click OK or press Enter.

3. The name of the font you chose now appears next to the word Font in the Text Specifications dialog 
box.

4. Type in the Points text box the size that you'd like your text to be. If, after you input the type, you're not 
happy with the size, you can either resize it as you would resize any frisket, or you can delete it and re-
input the font at a different size.

5. After you decide on a type size, click OK or press Enter. Your cursor is now an I-beam. Click an 
insertion point and type.

6. When you are done, you will see your type is in the form of a frisket. You can now use it just like any 
other frisket.

Note: You can kern type by holding down and clicking and dragging on one or more letters with the frisket
Pointer Tool, or nudge selected characters with keyboard arrow keys.



Feathered Frisket

Some airbrush artists using traditional tools lift a frisket slightly to achieve a feathered edge when 
painting. By using the Feather slider at the bottom of the Frisket Palette, you can feather a frisket (even 
after you have created it).

If you leave the Feather slider all the way to the left, no feathering is done and the frisket has a one-pixel-
wide edge with anti-aliasing. Moving the slider to the right will increase the feathering, centered on the 
frisket edge.

The feathering setting stays with a frisket when it is moved or rotated. Also, the Feather Slider remains in 
the same position until you change it, and applies to new and existing friskets. However, the feathering 
setting will not be saved when you save a frisket in the Frisket Library.



Saving a Frisket

If you create a frisket that you'll use again, you can save it in a frisket library.

To save a frisket:

1. Click on the Library... button at the bottom of the Frisket Palette. A dialog box will appear.

2. Click Save and the Save Frisket dialog box appears.

3. Type your frisket's name.

4. Click OK or press Enter. The new frisket is now part of the library.

Note: Use the Frisket Pointer Tool to select the friskets you want to save.

To save a frisket as an EPS file:

1. With the Frisket Pointer Tool, select the frisket or friskets you wish to save.

2. Click on the Library... button at the bottom of the Frisket Palette. A dialog box will appear.

3. Click Save EPS and a Save dialog box appears.

4. Locate the disk on which you want to save the EPS file. Type in a file name then click OK or press 
Enter. The frisket is saved as an EPS file.

Note: The EPS file you just saved can be opened in most other illustration programs that support the EPS
file format.



Frisket Library

To access an existing frisket:

1. Click the Library... button.

2. Double-click the name of the frisket you wish to use, or click on the frisket name and then click OK or 
press Enter.

The frisket appears in the painting window.

You can delete a frisket from the Frisket Library by clicking on the frisket's name and clicking Delete.

Painter comes with 27 friskets already in the Frisket Library. The number or numbers following the frisket 
name denotes the frisket size in pixels. For rectangles and ellipses (ovals), the height and width are 
given. For circles, the diameter is given. For polygons, the diameter and number of sides are given. For 
stars, the diameter and number of points are given.

New Frisket Libraries

You can set up your own custom libraries to separate your friskets by category.

To create a new library:

1. Select Options: Movers: Frisket Mover... The Frisket Mover dialog box appears.

2. Click New... to start a new library.

3. Type in the name of your library under New Frisket File. Click Save or press Enter. The name of your 
new library appears on the right-hand side of the Frisket Mover dialog box.

To copy friskets from an existing library:

1. Click on the frisket you would like to copy in the left column and click Copy. If you want to copy a frisket
from a different existing library, click Close, then click Open..., locate the library you prefer, then click 
Open or press Enter.

To remove a frisket:

1. Click on the frisket you want to delete.

2. Click Remove.

To change a frisket name:

1. Click on the frisket you want to rename.

2. Click Change Name...

3. Type in a new name.

4. Click OK or press Enter.

When you are done making changes in the Frisket Mover dialog box, click Quit.

To add new friskets to a library, follow the steps in the section entitled Saving a Frisket.

If you don't see the library you want to add friskets to:

1. After you click Library... in the Frisket Palette, click Open Library...

2. Locate the library you wish to work with.

3. Double-click on the library or click Open or press Enter.



To delete a frisket library:

In the Finder, click and drag its icon to the trash.



Setting Frisket Color

If you work with your frisket as a color overlay (the middle icon in the eye row in the Frisket Palette) rather
than as a selection (the third icon in the eye row), you may want to change its color to contrast with your 
work area.

To set frisket color:

1. Click in the square in the lower left-hand corner of the Frisket Palette.

2. Select the color you'd like to make your frisket in the Color Picker.

3. Click OK or press Enter.

The frisket is now the color you selected. 

Note: You'll only see this if you have the middle icon checked in the eye row of the Frisket Palette.

When you select a tool in the Brush Palette, if the cursor is the same color as the frisket, you can change 
the cursor color by selecting Edit: Set Preferences... and clicking in one of the color rectangles.

Transparent Friskets

Another new feature in Painter 2.0 is the ability to make a frisket transparent in the color mode. Here's 
how:

1. Create a frisket.

2. Click in the middle icon in the eye row of the Frisket Palette to show the frisket as a color.

3. Check Transparent Frisket in the Frisket Palette. You can now see your image through your frisket.



Friskets as Selections

Friskets can be used to make selections, that is, when you draw a frisket, the area within it is now 
selected, and you can perform any task that you can perform on a selection that you made with the 
Selection Tool. When you use friskets as selections, the results have anti-aliased edges. 

When you use a frisket as a selection, you'll display it as a marquee (sometimes called marching ants), 
chosen by clicking the last icon in the eye row in the Frisket Palette. When so displayed, a frisket-selected
area may be moved as a floating selection by clicking and dragging on it with the Selection Tool, the Knife
Tool or the Frisket Line Tool. You can copy the selection easily by pressing the Alt key while you click and
drag. When a frisket-selected area is cut or copied, it may then be pasted into any image window.

You can apply special effects to the frisket-selected areas. If, for instance, you would like to add texture to
part of your image using Paper Grain in the Apply Surface Texture item in the Effects menu, you can 
select the piece of your image by drawing a frisket. The paper texture will be added to the area within the 
frisket.



Magic Wand

A new addition to Painter 2.0 is the Magic Wand. Instead of selecting areas by drawing a shape over 
them, the Magic Wand makes a selection according to pixel color. Pixels come in related groups of colors 
based on hue, saturation and value. You can adjust Painter to accept a narrow or wide range of pixels 
within a color group, or to expand beyond the color group, which in turn selects more of the image.

To select a portion of your image with the Magic Wand:

1. Select Edit: Magic Wand.... The Magic Wand dialog box appears and the cursor becomes a magic 
wand.

2. Click in the area you want to select. The HSV sliders in the Magic Wand window adjust to reflect the 
color of the pixels in the area you dragged in. Then the area fills with a frisket overlay. If the color is 
uniform, then the area is fully selected, and you're done. Click OK or press Enter. The area is now 
surrounded with a frisket selection marquee. 

If, however, the color isn't uniform, then only a piece of the total area you want to select has the frisket 
overlay on it. To add to the selected area, you have to tell Painter that you want to add pixels to the 
selection, and the way to do that is to increase the HSV levels so more color groups are included. You 
can do this in one of two ways. You can either click and drag around with the Magic Wand in the area you 
want to select, picking up more pixel color and changing the HSV sliders automatically to add colors, or 
you can adjust the HSV sliders manually by clicking and dragging on them.

Click and drag at either end of the sliders to adjust the range of colors to be included. Or click and drag in 
the center of a range--this will maintain the range but will alter the colors to be included. When the correct 
amount of your image is selected, click OK or press Enter. The area is now surrounded by a frisket 
selection marquee.



Special Effects

While you can use a frisket to select a piece of your image that you will then apply an effect to, you can 
also use the frisket to actually create the special effect itself. This is done in the Using menus that are 
included in most of the items in the Effects menu.

The Using menus let you decide how Painter will come up with a given texture. With Paper Grain 
selected, for instance, Painter will use a paper texture that you chose in the Paper Palette as the basis for
the effect, whether it's Glass Distortion or Apply Screen. 

In each of these Using menus, Frisket is a choice for creating texture. What this choice does is create 
texture based on the edge of the frisket.

Let's use Apply Surface Texture as an example. The following steps will apply to any menu item in the 
Effects menu that offers a Using menu.

1. Create a new document.

2. Click on Set Paper Color... in the New Picture Size dialog box and choose a sky blue.

3. Click OK or press Enter.

4. Draw a frisket with the Knife Tool.

5. Choose Windows: Frisket Palette (Ctrl+9) if it isn't showing already, and move the Feather slider to 6.

6. Choose Edit: Deselect. Your frisket disappears, but it still exists.

7. Draw a selection marquee with the Selection Tool around the area where your frisket was.

8. Choose Effects: Surface Control: Apply Surface Texture.

9. Select Frisket in the Using menu.

10. Click OK or press Enter.

11. You'll now see a texture where the edge of your frisket is, as if it is embossed into your image.



Repeated Brush Strokes

Use friskets with Auto Playback to constrain recorded brush strokes within or around a specific area of 
your image.

1. Record your brush stroke by choosing Brush Stroke: Record Stroke. Then paint the stroke you wish 
to record.

2. Draw a frisket or friskets. 

3. Choose Brush Stroke: Auto Playback.

If the frisket or friskets are set to protect the outside, the brush strokes will play back randomly inside the 
frisket. If they are set to protect the inside, the strokes will play back outside the frisket or friskets. Unlike 
an area selected with the Selection Tool, the brush strokes will not overlap the edges of a frisket.



Input and Output

You can print to any PostScript or GDI device with Painter, including high-resolution imagesetters. 

PostScript Setup

Printer/Press Dot Gain

Monitor Gamma

Screen Frequency

Angle

Spot Type

Print Dialog Box

GDI Printing

Color PostScript

Separations

Black and White PostScript

Printer Settings File

Save as EPS

Image Size Information

Scanning with Painter



PostScript Setup

There are several controls for you to consider when you choose File: PostScript Setup.... These controls 
have no effect and should not be used if you are printing to a non-PostScript printer.



Printer/Press Dot Gain

Dot Gain is the amount any halftone dot will grow when it is printed. Depending on the type of printing 
press, paper and ink you use, halftone dots will grow, causing your image to become darker than you 
wished. To account for this dot gain, Painter allows you to enter a percentage of dot gain, which will adjust
the halftone dots so they print at the size you intended. For example, if a 50% dot on film grows to 70% 
after it is printed, then the dot gain is 20%. If the dot gain setting is too high, the printed results will be too 
light. If the dot gain percentage is too low, then the printed results will be too dark. Your print shop should 
be able to tell you what the dot gain will be on a specific job. Typically, web offset presses have dot gains 
of around 25% and sheetfed presses have dot gains of 5% to 10%. 



Monitor Gamma

The gamma, or brightness, of your monitor and the printing gamma must be the same if what you print 
out will look like what you see on your monitor.

If you haven't used a third-party optical hardware calibration device to change your monitor's gamma, 
then you're pretty safe leaving the Monitor Gamma at the 1.8 default setting. If you do use one of these 
calibration devices, we recommend that you set it to 1.8. If, however, you've set your monitor to another 
gamma, change the Monitor Gamma in PostScript Setup to the same number. 



Screen Frequency

Screen frequency represents the fineness of the halftone screen grid, which is made up of rows of dots. 
This grid is measured in lines per inch (lpi). The higher the lpi is, the crisper the image will be.

If you are printing a separation, Painter lets you set the screen frequency for the four process colors: 
cyan, magenta, yellow and black.



Angle

This is the angle at which your halftone screen rests on your image. When printing separations, these 
angles can be set for each of the process colors.



Spot Type

The Spot Type pop-up menu gives you options for the shape of the dots that together make up your 
halftone screen grid.



Print Dialog Box

Once you have set up your printing controls, you will access the Painter Print dialog box, File: Print 
(Ctrl+P). The top half of the dialog box contains the standard Windows print commands. The bottom lists 
the four printing methods Painter supports.



GDI Printing

Check this radio button if your printer uses color or black-and-white Windows Graphic Device Interface. A 
common GDI printer is the Hewlett-Packard PaintJet. You cannot print separations to GDI printers, nor 
does Printer/Press Dot Gain, Spot Type or screen frequencies have any affect on printer output.



Color PostScript

Among Color PostScript printers are the QMS ColorScript and Tektronix color thermal printers. These 
printers are affected by Printer/Press Dot Gain, Spot Type, Screen Frequency and Angle. Check Color 
PostScript if you have one of these printers.



Separations

You can print separations from Painter with any PostScript device, most commonly with high-resolution 
imagesetters. Good separations depend on the right screen frequency and angle. Printer/Press Dot Gain 
and Spot Type are also crucial for producing quality color separations. Check with your imagesetting 
service bureau about what kind of setup is necessary for the kind of equipment you are outputting files to. 
Check Separations if you are printing separations directly from Painter.

Painter places a color bar,registration marks and color name on each of the four separated plates. If you 
wish to print negatives of your separation, check the Negative box in Windows' Advanced Options. 
However, if you are using a service bureau to printer your separations, check with them on the proper 
setup for their equipment.



Black and White PostScript

Check this box if you are printing on a black-and-white PostScript laser printer.



Printer Settings File

Painter includes a Printer Settings file (PRINTER.STG) that contains color calibration information for 
obtaining a quality color separation on a high-resolution imagesetting device.

The Printer Settings dot gain is set to 16%, Screen Frequency for all four process colors is 133 lpi, and 
Angle is set to 15° for cyan, 75° for magenta, 0° for yellow, and 45° for black.



Save as EPS

Remember, when you save a file as EPS-DCS, Painter will use the Printer Settings file in your Painter 
folder to make the separation files. If you wish to use the screen angles and frequency in the PostScript 
Setup dialog box, check the box next to Use PostScript Setup settings in the EPS Save As Options dialog
box.

Note: Although Painter will use the PostScript Setup dialog box information for screen angles and 
frequency, Painter still uses the color separation data in the Printer Settings file.



Image Size Information

To find out how big your current image is and how well it fits on the printer bed of the printer that is 
selected in the Print Setup, click and hold on the i (for information) in the bottom left-hand corner of your 
image window. The window shows you how your image fits on the page size and orientation that are 
designated in the Printer Setup dialog box, in addition to graying out your non-printing area around the 
edge of the page. If you change your image's resolution or dimensions by choosing File: Resize..., you 
can use the i window to see how the changes affect the way the image fits on the page.



Scanning with Painter

You can scan from within Painter using TWAIN, a general method for acquiring any raster image, which is
supported by several software applications and scanner manufacturers.

To access your scanner, you must first tell Painter which scanner you will be using. Choose File: Select 
Source.... A dialog appears allowing you to select any scanner with a TWAIN driver available on your 
system. Choose the scanner you wish to use. After you have chosen a scanner, select File: Acquire..., 
which brings up your scanner's software interface.

For TWAIN to work, you must have the TWAIN source manager, a file called TWAIN.DLL, in your 
Windows system directory. TWAIN.DLL comes with scanners whose software supports TWAIN. If your 
scanner doesn't include TWAIN.DLL, ask your scanner manufacturer how you can get a copy. Fractal 
Design cannot supply you with TWAIN.DLL.

If TWAIN.DLL is not in your Windows system directory, Acquire and Select Source menu items will be 
grayed out.



Color

Because Painter offers drawing and painting tools that closely resemble their natural-media counterparts, 
you'll work with color in Painter using the HSV (Hue, Saturation, Value) color system even though your 
images will be saved in the RGB (Red, Green, Blue) or CMYK (Cyan, Magenta, Yellow, Black) color 
models. 

Color Palette

Eye Dropper Tool

Soft Mask Colorize

Fill Palette



Soft Mask Colorize

Soft Mask Colorize, a Method in the pop-up menu in the Brush Palette, gives you another alternative for 
choosing color. this method is used for painting with a frisket or friskets present on the drawing surface 
but turned off in the Frisket Palette. When you draw over the frisket, the brush "senses" the frisket mask, 
and paints with the primary color on the outside of the frisket and the secondary color on the inside. The 
word "Soft" in the Method lets you know that the edges of the brush strokes will be anti-aliased.



Record and Playback

You're too busy to have to repeatedly apply brush strokes. Let Painter do it for you. And Painter will also 
record and playback entire sessions. Just turn on the recorder before your start painting, and stop the 
recorder when you're finished. You can play back your work of art whenever you wish.

Additionally, you may play a recording session back at a higher or lower resolution than the original. 
Painter will automatically rescale all of your recorded brush sizes, paper textures, mask feathering, etc.

Recording Individual Strokes

Recording Sessions

Creating Playback Libraries

Playing Back Session at New Resolution



Recording Individual Strokes

To record a brush stroke:

1. Choose Brush Stroke: Record Stroke.

2. Make a brush stroke in the usual manner. The stroke is now recorded.

To play back a stroke:

1. Choose Brush Stroke: Playback Stroke.

2. Click anywhere in the image window. The brush stroke will be played back each time you click.

The stroke will play back with any of the drawing or painting tools regardless of which brush you recorded 
it with. If you had Pencils selected when you recorded the stroke, and then switch to the Airbrush, for 
example, when you click in the image area, the recorded stroke will be played back using Airbrush. Also, 
the stroke will be whatever color you select in the Color Palette.

To go back to normal strokes, choose Brush Stroke: Stop Playback.

To automatically apply multiple copies of the recorded brush stroke within a selection:

1. Select part of your image with the Selection Tool or your whole image (Ctrl+A) and choose Brush 
Stroke: Auto Playback. The brush strokes appear randomly within the selection.

2. Click the mouse or press on your stylus to stop the auto playback.

Notice how the automatic brush strokes sometimes extend outside the selected area. This happens 
because the stroke is rendered from the center of the stroke. To restrict the strokes to playing back just in 
the selected area, use a frisket instead of the Selection Tool.



Recording Sessions

Painter also provides a way to record an entire work session.

To record a session:

1. Choose Brush Stroke: Record Options...

With Record Initial State checked, you have the option of saving your session as is, including the specific 
brushes, colors and paper textures you use when record the session. If you uncheck Record Initial State, 
Painter will remember just the brush, color and texture you have selected when you start a recording 
session. You can decide on a different brush, color and paper texture each time you play back the 
recorded session.

2. Choose Brush Stroke: Record Session....

3. Draw or paint as many strokes as you like, and use any of Painter's other features and effects.

4. When you're done, choose Brush Stroke: Stop Recording Session. The Name the Session dialog 
box will appear. Type in a name and click OK. You can record an unlimited number of sessions.

To play back the session:

1. Choose Brush Stroke: Playback Session... You'll see a dialog box that lists the sessions you have 
recorded.

2. To pick a session, double-click on it, or click once, then click Playback or press return. Painter plays 
back the recorded strokes.

To stop a playing session midway, press Ctrl-. (Ctrl key and a period).



Creating Playback Libraries

You can set up recorded session libraries so you can organize your sessions by client or by month, for 
instance.

To create a new Record Sessions library:

1. Select Brush Stroke: Playback Session... The Recorded Sessions dialog box appears.

2. Click on Open Library...

3. In the dialog box that appears click on New.

4. A dialog box will open that says Create File. Type a name and either click on Save or press Enter. The 
name you just typed now appears above the Open Library... radio button. Any new sessions that you 
record will go into this library until you open or create another library.

To Open an Existing Library:

1. Choose Brush Stroke: Playback Session...

2. Click on the Open Library... radio button.

3. Double click on the library you wish to open or click once on it and click on Open or press Enter. The 
library name now appears over the Open Library... radio button and a list of recorded sessions appears.



Playing Back Session at New Resolution

There may be a time when you want to record a session in one resolution and play it back at a higher 
resolution. You can do this in Painter, but you must follow specific steps.

To record a session to be played back at a different resolution:

1. Open a new document before you start recording.

2. Before painting or drawing, choose File: Select All (Ctrl+A).

3. You may immediately choose File: Deselect All (Ctrl+D) or draw inside the selected area.

4. Choose Brush Stroke: Record Session.

5. Proceed with your session.

When you are done drawing, record your session as described earlier.

To play back a session at a different resolution:

1. Before playing back the recorded session, create a new document with a different resolution 
(adjustable in the New Picture Size dialog box) but whose dimensions are the same as the recorded 
session you are about to play back.

2. Before playing back the session, choose File: Select All (Ctrl+A). Your session will play back inside 
this selection marquee. If you want the session to play back proportionally to your original session, the 
new picture must have the same dimensions as the recorded session.

3. Choose Brush Stroke: Automatic Playback, and choose the session you wish to play back.

Note: You may also play back a session within a selection at any resolution if the session was recorded 
after first selecting the entire image. In fact, a session recorded this way may be played back in many 
selections in the same image.



Windows

A description of the various kinds of windows used in Painter is contained in the following topics.    For 
more information, click on the topic.

Tool & Palette Windows

Edit Window



Tool & Palette Windows

The tool and palette windows supply the core of functionality in Painter.    For more information on how to 
use these windows, click on the topic next to the desired window.

Brush Palette

Brush Size

Fill Palette

Frisket Palette

Paper Palette

Color Palette

Toolbox

Brush Behavior

Expression Palette

Brush Stroke Designer

Brush Looks



Edit Windows

Sometimes referred to as the Image Window, this is the area where you paint and draw in Painter. Scroll 
bars run along the right and bottom of the window. At the top is the title bar, where the name of file is 
located. In the bottom-left corner is the Frisket Palette shortcut. By clicking on the frisket icons, you can 
change the frisket protection from inside to outside to off, and change how you view a frisket. You also 
can access image size information and resolution by clicking on i while holding down your mouse button 
or stylus. The Edit Window's zooming and closing features work like those in any other Windows 
application.



Brush Size

The Brush Size window contains many features for getting the exact width, tip and angle that you want for
your brush strokes. 

The picture in the upper right-hand corner of the Brush Size window represents brush stroke width and 
shows you how some of the changes you make in this window will affect your brush.

Before your changes to the various gauges described in this section can take effect, you'll have to click on
the Build button. 

Stroke Contour
The six illustrations in the upper left section of the Brush Size window show you the possible silhouettes 
of your stroke as if you were holding it up like a telescope.

The silhouette represents the spread of color in the stroke. So the first silhouette shows the stroke will 
have a concentrated amount of color in its center and will have less color at its edges.

Sliders
When you first open the Brush Size window you see two sliders. When you click in the zoom box, you 
expand the Brush Size window to reveal the rest of the Brush Size window's sliders. Here's what the 
sliders mean:

Size
Controls the width of your brush stroke. Bring the slider further to the right to make your brush wider, drag 
to the left to make it more narrow.

±Size
Controls the stroke's proportion from narrow to wide. When you move this slider to the right, you'll see the
brush width dot split in two. The inner, black circle shows the minimum stroke width. The outer, gray circle
shows the maximum stroke width. The further you drag the slider to the right, the more vast the difference
will be between the thinnest portion of your stroke and its widest point.

%Size
Controls the transition between the thin and thick sections of a stroke. The further the slider is to the left, 
the smoother the transition. The further it is to the right, the more abrupt the transition will appear.

Angle sliders
These sliders work together to determine brush dab direction. Brush strokes are made up of individual 
brush dabs and you can control the direction of these dabs and their frequency. 

Angle and Thinness
The Angle slider determines the angle of individual color dabs that combine to produce a brush stroke. 
The Thinness slider works in tandem with the Angle slider to establish the angle for the color dabs. Move 
the Thinness slider to the left. The brush width dot becomes an ellipse. Now, moving the Angle slider 
moves the brush width dot in different directions or angles and moving the Thinness slider adjust its width,
showing you what individual brush dabs will look like.

Ang Rng
Is the range of angles that a brush will contain. Setting this slider to 180° means you'll get every angle 
between 0° and 180° in your stroke.

Ang Step
This slider controls the angle resolution in brushes with Ang Rng less than zero. Setting this slider at 5° 



means that you get angles every 5°. The lower this slider is set, then, the more brush dab angles your 
brush will contain. The higher you set it, the fewer angles the brush will contain.



Fill Palette

If you want to fill an area, a selection or frisket with color, you can use the Paint Bucket in the Toolbox or 
the Fill item in the Effects menu. 

Using the Fill Palette 

To access the Fill Palette, double-click on the Paint Bucket in the Toolbox, or choose Windows: Fill 
Palette (Ctrl+0).

At the top of the Fill Palette is a scrollable list of pictures showing what gets filled when you click with the 
Paint Bucket in the image window. Click once on the picture to select it--your choice will be listed right 
beneath the scroll bar. These options include:

Contiguous Pixels

All similar-colored pixels next to the pixel you click will be filled. Click and drag with the Paint Bucket to 
collect a set of colors to fill.

Selection

The area designated with the Selection Tool will be filled.

Frisket

The area within a frisket or friskets is filled. The fill has anti-aliased edges, feathered if specified in the 
Frisket Palette.

Entire image

The entire image is filled.

You'll choose the nature of your fill at the bottom of the Fill Palette using the Fill With radio buttons. Your 
options are:

Flat Color

The designated area is filled with the primary color as reflected in the front overlapping rectangle in the 
Color Palette.

Color Ramp

The designated area is filled with a blend of the primary and the secondary colors as reflected in the 
overlapping rectangles in the Color Palette.

Clone Source

The area is filled with the designated part of a clone source.

You can set up the color ramp (or blend) by changing the primary or secondary colors in the Color 
Palette. You can preview the color ramp in the Ramp Direction area of the Fill Palette. You can ramp the 
colors in one of eight directions by clicking in the radio buttons surrounding the preview.

When you're done adjusting the Fill Palette, click with the Paint Bucket in the desired area to fill it with the 
new color.



Brush Stroke Auto Playback Command

Plays back a recorded brush stroke within a selection randomly until

stopped.

To automatically apply multiple copies of the recorded brush stroke within a selection:

1. Select an area using the Selection Tool and choose Brush Stroke: Auto Playback. The brush strokes 
appear randomly within the selection.

2. Click the mouse or press on your stylus to stop the auto playback.

Notice how the automatic brush strokes sometimes extend outside the selected area. This happens 
because the stroke is rendered from the center of the stroke. You can also automatically play back a 
recorded stroke within or outside of a frisket or friskets.



Brush Stroke Draw Freehand Command

Choosing this command allows you to draw or paint in Painter with free-flowing lines and curves.



Brush Stroke Draw Straight Lines Command

Choosing this command allows you to draw or paint in Painter using straight lines. Any of the brushes can
be used while Straight Line drawing is turned on. To constrain a straight line to a 45- or 90-degree angle, 
hold down the shift key.



Brush Stroke Playback Session Command

This command allows you to play back a recorded session.

1. Choose Brush Stroke: Playback session... You'll see a dialog box that lists the sessions you have 
recorded.

2. To pick a session, double-click on it, or click once, then click Playback. Painter plays back the recorded 
strokes.



Brush Stroke Playback Stroke Command

After a brush stroke has been recorded, it may be played back using this command.

To play back a stroke:

1. Choose Brush Stroke: Playback (Ctrl+]).

2. Click anywhere in the image window. The brush stroke will be played back each time you click.

The stroke will play back with any of the drawing or painting tools regardless of which art supply you 
recorded it with. If you had Pencils selected when you recorded the stroke, and then switch to the Spray 
Can, for example, when you click in the image area, the recorded stroke will be played back using Spray 
Can. 



Brush Stroke Record Options Command

With Record Initial State checked, you have the option of saving your session as is, including the specific 
brushes, colors and paper textures you use when record the session. If you uncheck Record Initial State, 
Painter will remember just the brush, color and texture you have selected when you start a recording 
session. You can decide on a different brush, color and paper texture each time you play back the 
recorded session.



Brush Stroke Record Session Command

Painter also provides a way to record an entire Painter session.

To record multiple strokes:

1. Choose Brush Stroke: Record Session.

2. Draw or paint as long as you like using any tools and shades you'd like.

3. When you are done, choose Brush Stroke: Stop Recording Session. The Name the Session dialog 
box will appear. Type in a name and click OK.



Brush Stroke Record Stroke Command

You're too busy to have to repeatedly apply strokes. Let Painter do it for you. 

To record a brush stroke:

1. Choose Brush Stroke: Record (Ctrl+[).

2. Make a brush stroke in the usual manner. The stroke is now recorded.



Brush Stroke Stop Playback Command

After recording a stroke in Painter, it will continue to play back each time you click your mouse or stylus 
until you choose Brush Stroke: Stop Playback.



Brush Stroke Stop Recording Session Command

When you are done recording a Painter session, choose Brush Stroke: Stop Recording Session. The 
Name the Session dialog box will appear. Type in a name and click OK.



Edit Clear Command

Clears a selected image from the Edit Window without changing the contents of the Clipboard.



Edit Copy Command

Copies a selected image from the Edit Window and copies it to the Clipboard.



Edit Cut Command

Cuts a selected image from the Edit Window and copies it to the Clipboard.



Edit Deselect Command

Deselects a selected area.



Edit Fade Command

Fade is an editing technique in Painter to undo part of your most recent change. Fade can partially undo 
any recent maneuver, but it comes in particularly handy when a tint that you've added to your image is too
dark and you want to lighten it up.

To do a fade:

1. Select Edit: Fade... The Fade Last Operation dialog box appears. 

2. Move the Undo Amount slider and view the effect in the preview window.

3. Click OK.



Edit Magic Wand Command

A new addition to Painter 2.0 is the Magic Wand. Instead of selecting areas by drawing a shape over 
them, the Magic Wand makes a selection according to pixel color. Pixels come in related groups of colors 
based on hue, saturation and value. You can adjust Painter to accept a narrow or wide range of pixels 
within a color group, or to expand beyond the color group, which in turn selects more of the image.

To select a portion of your image with the Magic Wand:

1. Select Edit: Magic Wand.... The Magic Wand dialog box appears and the cursor becomes a magic 
wand.

2. Click in the area you want to select. The HSV sliders in the Magic Wand window adjust to reflect the 
color of the pixels in the area you dragged in. Then the area fills with a frisket overlay. If the color is 
uniform, then the area is fully selected, and you're done. Click OK or press Enter. The area is now 
surrounded with a frisket selection marquee. 

If, however, the color isn't uniform, then only a piece of the total area you want to select has the frisket 
overlay on it. To add to the selected area, you have to tell Painter that you want to add pixels to the 
selection, and the way to do that is to increase the HSV levels so more color groups are included. You 
can do this in one of two ways. You can either click and drag around with the Magic Wand in the area you 
want to select, picking up more pixel color and changing the HSV sliders automatically to add colors, or 
you can adjust the HSV sliders manually by clicking and dragging on them.

Click and drag at either end of the sliders to adjust the range of colors to be included. Or click and drag in 
the center of a range--this will maintain the range but will alter the colors to be included. When the correct 
amount of your image is selected, click OK or press Enter. The area is now surrounded by a frisket 
selection marquee.



Edit Paste Command

Pastes whatever is on the Clipboard into the active Edit Window.



Edit Paste Into New Picture Command

Pastes whatever is on the Clipboard into a new untitled Edit Window.



Edit Select All Command

Selects the visible portion of the active Edit Window. Useful when doing automatic cloning, or to select a 
large area at once for cutting, clearing or copying.



Edit Reselect Command

Reselects and turns back on a frisket.



Edit Set Preferences Command

Access the Painter Preferences dialog box by choosing Edit: Set Preferences.

To tell Painter to access a different brush, paper or frisket library as the default, type the name of the one 
you wish in the text boxes next to Brushes, Paper Grains or Frisket Library respectively.

You can have your cursor appear to be a triangle or single pixel by checking the appropriate radio button 
next to Drawing Cursor.

And you can determine the direction the cursor will point by clicking on a button in the circle above 
Orientation. You can select a cursor "color" that will stand out even in the dark areas of your image by 
clicking in the appropriate rectangle above Color. The upper-left cursor selection has a one-pixel white 
border surrounding it, The cursor next to it is outline, the cursor in the bottom-left is gray and the last 
cursor is solid black.

You can select the disk volume that Painter will put its temporary file on by choosing the volume name 
from the Temp File Volume pop-up menu.

These preferences become the default settings until you change them.



Edit Undo Command

Undoes your last action.



File Acquire Command

To acquire a scanner:

After telling Painter which TWAIN-compatible scanner you have by using the File: Select Source 
command, choose File: Acquire to bring up your scanner's software interface.



File Clone Command

To make a copy:

1. Open an existing Painter-compatible document

2. Select File: Clone.

You can then re-create the image using pencils, pastels, or any of Painter's drawing or painting tools. You 
do so by dragging your cursor in the cloned image and re-rendering it with the characteristics of the brush
you selected. 



File Close Command

This command allows you to close the active Painter document. If the document has been changed since 
it was last saved, Painter will ask if you wish to save the changes before closing it. If the document has 
not been changed, Painter will immediately close the document.



File Exit Command

Quits the Painter application after closing all the open files. If you haven't saved the files, Painter will ask 
you if you wish to do so before exiting.



File Export Command

Allows you to access third-party plug-ins that let you export foreign file types.



File New Command

This dialog box lets you determine image-area dimensions, image resolution and paper color. It also 
designates how much RAM or combination of RAM and hard-disk space the document will require. The 
saved size of the document is approximately one half of this number.

The Resolution Text Field

Resolution refers to the number of dots per inch (dpi) that make up an image.

Width and Height

The width and height default settings of 640 x 480 pixels represent the dimensions of a 13-inch monitor at
75 dpi. If you keep these dimensions in pixels, changing the pixels per inch will affect the document's 
dimensions. If you switch to inches or to another finite measuring system, changing the pixels per inch 
won't affect the dimensions.

Storage

The Image Size tells you how much RAM or hard-disk space the document you are creating will occupy. 

Changing Values and Measuring Systems

When you start a new document, the width field is highlighted in the New Picture Size dialog box. Press 
Tab to go from one field to another.

The default settings are in pixels. To change the default measuring systems:

1. Click and hold on one of the fields to the right of the numbers. 

2. Drag to select the measuring system you prefer. For height and width you can choose from pixels, 
inches, centimeters, points, picas and columns. Columns are two-inch columns and you can indicate how 
many columns wide and tall you'd like your image area to be. Resolution can be determined in pixels per 
inch or pixels per centimeter.

Paper Color

The New Picture Size dialog box also lets you choose a paper shade for your image. To select a shade:

1. Click Set Paper Shade. You'll see the standard Windows Color Window. 

2. Choose the shade you wish.

3. Click OK.

When you have finished making adjustments in the New Picture Size dialog box, click OK or press Enter. 
A new, untitled document window will appear.



File Open Command

Painter supports its own Raster Image File Format (.RIF), Aldus Tagged Image File Format (.TIF), 
Windows Bitmap (.BMP), ZSoft PC Paintbrush (.PCX) and TrueVision Targa (.TGA), and will open files 
saved in any one of them. This means you can open documents created in other paint programs and 
saved in one of these formats, and use Painter to add brush strokes, tints or paper textures to them. Or 
you can use these documents as the basis for completely new Painter images.

To open an existing document created in Painter or in another program:

1.    Choose File: Open.

2.    Locate the file you wish to open. For every document, regardless of the program it was created in, 
Painter lists in this dialog box the file's dimensions, how much space it takes up in memory and its file 
format.

3.    To open the document, do one of three things: click on Open, double-click on the file name or press 
Enter.



File Printer Setup Command

This command accesses the dialog box that lets you choose your printer and its parameters, such as 
page size, orientation, paper source, percentage of size, number of copies and handshake.



File Print Command

Accesses a dialog that lets you set up parameters for printing, such as print quality, number of copies, etc.



File Resize Command

To resize an image:

1. Choose File: Resize... The Resize Image dialog box appears.

The bottom half of the box shows you the current image size. You'll assign new image dimensions in the 
top half of the box.

2. Type in a new width or height. The other dimension will change proportionally.

3. Type in a new resolution if desired.

4. Check the constrain box if you want to freeze the amount of disk space the file occupies.

5. Click OK or press Enter.

The image now reflects your changes. Units of measure available are pixels, inches, centimeters, picas, 
points, columns and percent.



File Revert Command

After a warning dialog asking if you want to revert, Painter reverts to the last-saved version of an open 
file.



File Save Command

Allows you to save the active Edit Window in any of the file formats Painter supports: its own Raster 
Image File Format (.RIF), Aldus Tagged Image File Format (.TIF), Windows Bitmap (.BMP), ZSoft PC 
Paintbrush (.PCX), encapsulated PostScript (.EPS) and TrueVision Targa (.TGA).



File Save As Command

Allows you to save a previously saved file with a different name or in a different file format, including 
Painter's own Raster Image File Format (.RIF), Aldus Tagged Image File Format (.TIF), Windows Bitmap 
(.BMP), ZSoft PC Paintbrush (.PCX), encapsulated PostScript (.EPS) and TrueVision Targa (.TGA).



File Select Source Command

To select a scanner:

1. Select File: Select Source. A dialog appears allowing you to select any scanner with a TWAIN driver 
available on your system.

2. Choose the scanner you wish to use.

After you have chosen a scanner, you must select File: Acquire, which brings up your scanner's software
interface.



Options Brush Look Mover Command

Another brand-new feature of Painter 2.0, the Brush Looks window is the visual equivalent of the variant 
pop-up menu. The Brush Looks window offers a visual record of the changes you make to brush strokes 
using the various customizing features including the Paper Palette while the Brush Stroke Designer is 
open.

The Brush Looks window has been crammed with brush strokes that you can use right away. To access 
the Brush Looks window choose Windows: Brush Looks (Ctrl+-).

The Brush Looks window works just like the Paper and Brush Palettes. Scroll to find the look you want, 
then click on it. A black line around the picture shows a look is selected and its name appears beneath the
scroll bar.

Now click and drag in your image and the stroke resembles the look you chose in the Brush Looks 
palette.

You can use the Brush Looks window to help you learn how to use Painter. With all the customizing 
windows open, choose different brush looks. You'll see the way various gauges were set up to get the 
look you chose.

Meanwhile, you can save your customized strokes in the Brush Looks window through the Brush Stroke 
Designer.

To save a stroke from the Brush Stroke Designer in the Brush Looks window:

1. In the Brush Stroke Designer window click Save. The Name the Brush Look dialog box appears.

2. Type in the name of your brush look.

3. Click OK or press Enter. Your stroke is now a look in the Brush Looks window.

Brush Looks can be torn off and moved anywhere on your screen, just like brushes and paper textures. 



Options Brush Mover Command

Another of Painter's handy features is the ability to set up Brush Palettes for individual designs, projects, 
clients or fashion seasons. The Brush Mover is also useful if you'll only use three or four brushes for a 
given project and you don't want to have to scroll through all the brushes you won't be using.

Choose Options: Movers: Brush Mover... The Brush Mover dialog box appears.

To create a new brush library click New...

Under New Brush File, type in the name of your new library. Click Save or press Enter. The new brush 
library's name appears on the right-hand side of the Brush Mover dialog box.

To move brushes into your new library:

Click on the brush you wish to move.

Click Copy.

Click Change Name... to rename a selected brush. Type in the name in the Change Brush Name dialog 
box. Then click OK or press Enter.

Click Change Picture... to replace the brush's current picture. Before you do, select the image portion 
that you'll replace the brush picture with before opening the Brush mover. Then click on Change 
Picture.... Painter will ask if you want to change the current brush picture to the new one. Click OK or 
press Enter to execute the change.

Click Remove to delete a selected brush. If you remove one of Painter's default brushes by mistake, the 
only way to retrieve it is to re-load the program. If you do so, you'll lose any of the custom variants, 
brushes or papers you created.

To move a brush to an existing library, click Close to close an open library on the right-hand side of the 
dialog box, then click Open.... Locate the library you want, click on it and click Open or press Enter. Then
follow the earlier instructions for moving a brush.

When you are done making changes in the Brush Mover dialog box, click Quit or press Enter.

To remove a brush library, select it in the Finder and drag it to the trash.



Options Capture Texture Command

A new feature in Painter 2.0, the Capture Texture item in the Options menu lets you turn a brush stroke, 
multiple brush strokes or a section of an image into a surface texture accessible in the Paper Palette. 

To see how this works:

1. Draw or paint a stroke with any variant.

2. Select a piece of it with the Selection Tool.

3. Choose Options: Capture Texture... The Save Texture dialog box appears.

4. Move the Crossfade slider to the right to increase the amount that the area you selected repeats in the 
new texture. Changing the Crossfade slider lets you create many different versions of a texture based on 
one selection.

5. Type in the name of your new texture and click OK or press Enter.

Your texture now appears as the last item in the Paper Palette.



Options Delete Variant Command

To delete a variant:

1. Select the variant in the Variant pop-up menu.

2. Choose Options: Custom Brush: Delete Variant... Painter asks if you want to delete the variant.

3. Click Yes or No.

Save Built Variant

You can also save changes to a variant without creating a new one. For instance, you may feel that the 
stroke width for the Sharp Chalk variant would never be useful to you unless you tapered it more in the 
Brush Size window.

To save changes to an existing variant, choose Options: Custom Brush: Save Built Variant... Your 
changes are now incorporated into the variant.

You may decide, though, that the original variant was the one you wanted after all. To get back the original
variant settings, select the variant in the pop-up menu, then choose Options: Custom Brush: Restore 
Default Variant. The variant now has its original default settings.



Options Dry Command

When you paint with water color, you're painting in the wet layer, which is a separate layer that floats 
above your image area. Painting in the wet layer lets you add color without affecting your existing image. 
This is especially useful for illustrating. You can draw your image with one of the pens and then color it 
using Water Colors. You turn on the wet layer by selecting Options: Wet Paint. When you are done 
painting you send your water-color strokes to the image layer by choosing Options: Dry (Ctrl+Y).



Options Frisket Mover Command

You can set up your own custom libraries to separate your friskets by category.

To create a new library:

1. Select Options: Movers: Frisket Mover... The Frisket Mover dialog box appears.

2. Click New... to start a new library.

3. Type in the name of your library under New Frisket File. Click Save or press Enter. The name of your 
new library appears on the right-hand side of the Frisket Mover dialog box.

To copy friskets from an existing library:

1. Click on the frisket you would like to copy in the left column and click Copy. If you want to copy a frisket
from a different existing library, click Close, then click Open..., locate the library you prefer, then click 
Open or press Enter.

To remove a frisket:

1. Click on the frisket you want to delete.

2. Click Remove.

To change a frisket name:

1. Click on the frisket you want to rename.

2. Click Change Name...

3. Type in a new name.

4. Click OK or press Enter.

When you are done making changes in the Frisket Mover dialog box, click Quit.

To add new friskets to a library, follow the steps in the section entitled Saving a Frisket.

If you don't see the library you want to add friskets to:

1. After you click Library... in the Frisket Palette, click Open Library...

2. Locate the library you wish to work with.

3. Double-click on the library or click Open or press Enter.

To delete a frisket library:

In the Finder, click and drag its icon to the trash.



Options Grid Options Command

You can set up the grid to suit your working style by choosing Options: Grid Options... Tab between the 
following fields to reach them quickly.

Grid Format

Click and hold on the pop-up menu to determine if your grid will be rectangular, or have just vertical or 
horizontal lines.

Horiz. Spacing

Determines the amount of space between horizontal lines. Unit of measure can be in pixels, inches, 
centimeters, points, picas and columns.

Vert. Spacing

Determines the amount of space between vertical lines. Uses the same unit of measure as Horiz. 
Spacing.

Line Thickness

Sets the width of grid lines. Uses the same unit of measure as Horiz. Spacing and Vert. Spacing.

Grid Color

Click on the color square to change the color of the grid lines. Choose a color in the Color Picker, then 
click OK or press Enter. The default color is a light blue.

Background

Click on the color square to change the grid's background color. Choose a color in the Color Picker, then 
click OK or press Enter. The default color is white.



Options Grid Overlay Command

Using Grid Paper in the Effects menu, you can add horizontal or vertical lines or a grid to part or all of 
your image that is fully editable and blendable with the rest of your design. The idea is the same as Grid 
Overlay. The difference is that Grid Overlay is a transparent, non-printing layer that floats above your 
image like Tracing Paper. Grid Paper, on the other hand, is an effect that becomes part of your image.



Options Make Repeating Texture Command

The Preview picture will show you what your changes will look like as you make them.

Moving the Spacing slider to the right opens up space between rows and columns in the selected pattern.

Moving the Angle slider changes the direction in which the pattern rows are lined up.

The Pattern pop-up menu gives you choices for the shape of the element that makes up your pattern.

Type in the name of your new texture next to Save As. Click OK or press Enter. Your new texture 
appears as the last item in the Paper Palette.



Options Paper Mover Command

You may want to organize the Paper Palette libraries by client or by project, or you may want to create 
new libraries, or you may want to delete textures. You can do all of these by choosing Options: Movers: 
Paper Mover...

To move a texture from one library into another:

See if the library that currently appears in the left column is the one you want to move a texture from. If it 
isn't, click Close... Then click Open... and locate the library you wish to move a paper from.

Now open a library on the right-hand side that you want to move the paper to by clicking Open... and 
locating the library you want to move to.

Click on the paper in the left column that you'd like to move and click Copy.

To remove a texture, select it, then click Remove.

To rename a texture select it and click Change Name... The Change Paper Name dialog box appears. 
Type the new name then click OK or press Enter.

To start a new Paper Library, click Close on the right-hand side of the dialog box if a library is showing.

2. Click New...

3. Type a name under New Paper Texture File.

4. Click Save or press Enter.

Now you can either move existing textures into your new library as described above or you can create 
new textures using Capture Texture and Make Repeating Texture.

When you are done with the Paper Mover dialog box, click Quit or press Enter.

To delete a library, in the Finder drag it to the Trash.



Options Restore Default Variant Command

You may decide after saving a new variant over a default variant that the original variant was the one you 
wanted after all. To get back the original variant settings, select the variant in the pop-up menu, then 
choose Options: Custom Brush: Restore Default Variant. The variant now has its original default 
settings.



Options Save Brush Command

You can add your own brush categories to Painter's Brush Palette to create a new medium or to organize 
customized settings by project, design or client. Here's how you do it:

1. First decide on a picture that will appear in the Brush Palette for your new brush. This can be newly 
created art or an image imported into Painter.

2. With the Selection Tool drag a square-shaped selection marquee around the portion of the picture that 
will appear in the Brush Palette.

3. Choose Options: Custom Brush: Save Brush... Enter a name for your brush and click OK or press 
Enter.

Your new brush and its picture now appear as the last brush in the Brush Palette.



Options Save Built Variant Command

You may save changes to a variant without creating a new one. For instance, you may feel that the stroke
width for the Sharp Chalk variant would never be useful to you unless you tapered it more in the Brush 
Size window.

To save changes to an existing variant, choose Options: Custom Brush: Save Built Variant... Your 
changes are now incorporated into the variant.



Options Save Variant Command

To save your brush alterations as a variant of the current brush:

1. Select Options: Custom Brush: Save Variant... The Save Variant dialog box appears.

2. Type in a name for your variant, say blunt pencil as a variant to a pencil.

3. Click OK or press Enter.

You will now see Blunt Pencil in the Pencil Variant pop-up menu. A brush can have up to 32 variants.



Options Set Scaling Command

When you draw with natural media, the amount of pressure you use with a tool determines how dense 
and how wide your strokes are. Using a pressure-sensitive stylus with Painter gives you this same kind of 
flexibility when you work with your computer. How much each of us bears down on a drawing or painting 
tool is different, and in Painter you can actually program the computer to react to your individual touch just
by clicking and dragging in the Set Scaling dialog box. 

To access the Set Scaling dialog box, select Options: Set Scaling. 

To set how sensitive the stylus will be to your hand pressure, just move the stylus across the scratch pad 
area at a normal speed and with a normal amount of pressure.

Note: There will be times that you will want to draw with an especially light touch. You may find that if you 
press too lightly in the image area that no stroke appears. You can fix this by going into Set Scaling and 
dragging your stylus very lightly across the scratch pad area. You'll find that when you then try to drag in 
your image area, it will take less pressure to produce a stroke.

Just as your signature varies, so will the way you work with the stylus at any given time, so you'll set up 
Set Scaling each time you launch Painter. When you exit Painter, the Set Scaling sliders go back to their 
default settings. 



Options Session Mover Command

Choose Options: Movers: Session Mover... The Session Mover dialog box appears.

To create a new session library click New...

Under New Session File, type in the name of your new library. Click Save or press Enter. The new 
session library's name appears on the right-hand side of the Session Mover dialog box.

To move sessions into your new library:

Click on the session you wish to move.

Click Copy.

Click Change Name... to rename a selected session. Type in the name in the Change Session Name 
dialog box. Then click OK or press Enter.

Click Remove to delete a selected .

To move a session to an existing library, click Close to close an open library on the right-hand side of the 
dialog box, then click Open.... Locate the library you want, click on it and click Open or press Enter. Then
follow the earlier instructions for moving a session.

When you are done making changes in the Session Mover dialog box, click Quit or press Enter.



Options Set Clone Source Command

If you already have two documents open, you can establish one as the source document by clicking on it 
and choosing Options: Set Clone Source. The second document automatically becomes a clone 
document.

Shift-Click

Maybe you don't need your whole image. Maybe you just want to borrow a portion of it, or maybe you 
want to take pieces and rearrange them within the same document. You can do either using the keyboard 
in combination with the Cloners. This feature differs from Set Clone Source in that with Set Clone Source,
the source and the clone images will be in register from the top left-hand corner, whereas with Shift-Click, 
you can pick up any piece from the source and put it anywhere within the clone.



Options Tracing Paper Command

Once you have created your source and clone images, you can set up an on-screen light box using 
Painter's Tracing Paper. With Tracing Paper you can trace over a 50% ghost of an image, and turn it off 
when you're done. This lets you use part or all of the original image as a template for brush strokes in 
your new, cloned image.

Note: You can set up Tracing Paper between any image and its clone. The two must be exactly the same 
size.



Options Wet Paint Command

When you paint with water color, you're painting in the wet layer, which is a separate layer that floats 
above your image area. Painting in the wet layer lets you add color without affecting your existing image. 
This is especially useful for illustrating. You can draw your image with one of the pens and then color it 
using Water Colors. You turn on the wet layer by selecting Options: Wet Paint. When you are done 
painting you send your water-color strokes to the image layer by choosing Options: Dry (Ctrl+Y).



Windows Brush Behavior Command

The Brush Behavior window contains controls for further refining brush strokes and for adjusting the way 
buildup brush colors interact on screen.



Windows Brush Looks Command

Another brand-new feature of Painter 2.0, the Brush Looks window is the visual equivalent of the variant 
pop-up menu. The Brush Looks window offers a visual record of the changes you make to brush strokes 
using the various customizing features including the Paper Palette while the Brush Stroke Designer is 
open.

The Brush Looks window has been crammed with brush strokes that you can use right away. To access 
the Brush Looks window choose Windows: Brush Looks (Ctrl+-).

The Brush Looks window works just like the Paper and Brush Palettes. Scroll to find the look you want, 
then click on it. A black line around the picture shows a look is selected and its name appears beneath the
scroll bar.

Now click and drag in your image and the stroke resembles the look you chose in the Brush Looks 
palette.

You can use the Brush Looks window to help you learn how to use Painter. With all the customizing 
windows open, choose different brush looks. You'll see the way various gauges were set up to get the 
look you chose.



Windows Brush Palette Command

When you want to buy a new 2B pencil, you go to the art supply store. When you want one in Painter, you
go to the Brush Palette. Choosing a tool in this window is easy. You scroll in the Brush Palette until you 
see the tool you want, then you click on its picture. You can tell which tool is currently selected by the 
black line around its picture and its name displayed below.



Windows Brush Size Command

You can determine the width of the strokes made by any of the brushes by choosing Windows: Brush 
Size (Ctrl+4), which calls up the Brush Size window. The dot in the window shows you the size of the 
stroke the tool will make. Clicking and dragging the slider to the right widens the stroke, dragging to the 
left thins it out. You can also click in the shaded area of the slider to select a new width. After you have 
resized the brush stroke, you have to click on the Build button before the new width will take effect.



Windows Brush Stroke Designer Command

The Brush Stroke Designer debuts in Painter 2.0 and is a unique interactive visual key to the 
modifications you make to brush strokes.

And it's easy to use.

Here's how:

Choose Windows: Brush Stroke Designer (Ctrl+8) The Brush Stroke Designer window appears.

What you see is an example of a brush stroke on a sample background. You can change backgrounds by 
clicking in the boxes at the bottom of the window. For now, click on white. As you use the customizing 
features, the brush stroke will reflect the changes. For example, choose a Chalk variant. Next choose two 
different textures in the Paper Palette. You'll see how each affects the stroke. Click on orange in the 
spectrum slider in the Color Palette--the stroke changes color. Now choose a Felt Pens variant. The 
stroke becomes solid -- that's because Felt Pens aren't affected by paper texture. You'll use a white 
background for strokes like crayons, but click in the boxes showing either tinted backgrounds or lines to 
see the smear of drip method brushes, for example. Click on the Set Colors button to assign a color from
the Color Palette to these backgrounds.

When you have the brush stroke you seek you can do one of three things: Paint or draw with the modified
brush, save your changes as a variant -- everything except paper texture and color can be saved as a 
variant -- or you can save your changes in the Brush Looks window.



Windows Color Palette Command

Using the Color Palette is the main way to select a color for your brush stroke. In the Color Palette you'll 
be able to select pre-set default colors or choose colors randomly, determining hue, saturation and value. 
You'll also be able to designate primary and secondary colors for your brush strokes.



Windows Expression Palette Command

Pressing heavily on a stylus achieves some amazing outcomes in Painter, but what if you're using a 
mouse? The good news is that using the Expression Palette you can choose other ways besides 
pressure to determine factors like how much your brush will show paper texture, how dense the color will 
be and how wide the brush stroke will be.

The Expression Palette is also useful for stylus and mouse users alike for inventive painting and drawing. 
For instance, in Painter 2.0 for the first time you can set up the Expression Palette so that the degree that 
colors bleed together in a clone is determined by the light-and-dark areas of the clone source. And in 
Painter 2.0 two new features--Tilt and Bearing--have been added for CalComp tablet users.

Each brush variant has default Expression settings that have been found to be most appropriate for the 
brush performance. But you may want to work with the brush in a different way, and you have that option 
in Painter.



Windows Fill Palette Command

If you want to fill an area, a selection or frisket with color, you can use the Paint Bucket in the Toolbox or 
the Fill item in the Effects menu. 

Using the Fill Palette 

To access the Fill Palette, double-click on the Paint Bucket in the Toolbox, or choose Windows: Fill 
Palette (Ctrl+0).

At the top of the Fill Palette is a scrollable list of pictures showing what gets filled when you click with the 
Paint Bucket in the image window. Click once on the picture to select it--your choice will be listed right 
beneath the scroll bar. These options include:

Contiguous Pixels

All similar-colored pixels next to the pixel you click will be filled. Click and drag with the Paint Bucket to 
collect a set of colors to fill.

Selection

The area designated with the Selection Tool will be filled.

Frisket

The area within a frisket or friskets is filled. The fill has anti-aliased edges, feathered if specified in the 
Frisket Palette.

Entire image

The entire image is filled.

You'll choose the nature of your fill at the bottom of the Fill Palette using the Fill With radio buttons. Your 
options are:

Flat Color

The designated area is filled with the primary color as reflected in the front overlapping rectangle in the 
Color Palette.

Color Ramp

The designated area is filled with a blend of the primary and the secondary colors as reflected in the 
overlapping rectangles in the Color Palette.

Clone Source

The area is filled with the designated part of a clone source.

You can set up the color ramp (or blend) by changing the primary or secondary colors in the Color 
Palette. You can preview the color ramp in the Ramp Direction area of the Fill Palette. You can ramp the 
colors in one of eight directions by clicking in the radio buttons surrounding the preview.

When you're done adjusting the Fill Palette, click with the Paint Bucket in the desired area to fill it with the 
new color.



Windows Frisket Palette Command

The Frisket Palette is where you'll control friskets, even if the window isn't showing. It's especially 
important because it's where you'll turn your friskets on and off.

If you understand the Frisket Palette you won't confuse it with the role of the frisket Pointer tool, a 
powerful new frisket-editing feature.

Open the Frisket Palette by choosing Windows: Frisket Palette (Ctrl+9), or by clicking on the Toolbox's 
zoom box, then double-clicking on the Knife tool or the Frisket Line tool.

The top row of icons next to the pencil represents how the frisket affects painting or image-editing. 
Clicking in the first box shuts off the frisket, clicking in the second protects the area inside the frisket, and 
clicking in the third protects the area outside the frisket.

The bottom row of icons next to the eye is your directory to what you'll see when you're painting or image-
editing. When you click in the first box, the frisket can't be seen, but works based on which icon in the top 
row you selected. When this and the box above it are outlined, the frisket is shut off. Clicking the second 
box displays the frisket as a color overlay. The third box shows the outline of your frisket as a selection 
marquee.



Windows Full Screen Mode Toggle Command

Painter allows you to maximize the application and document windows if they are not already maximized, 
and hide the scroll bars so the entire area below the title bar and menu bar is devoted to the image.

To turn on and off full-screen mode:

1. Press Ctrl+M. Your image becomes maximized and centered on your screen without scroll bars.

2. Press Ctrl+M again to return to its previous state.

All Painter features (except the information button on the scroll bar) work when in the full-screen mode.



Windows Hide Palettes Command

You can hide all open palettes during a Painter session.

To hide and    unhide open palettes:

1. Press Ctrl+H. All open palettes disappear.

2. Press Ctrl+H again to unhide palettes.

Note: Any tear-off brushes, textures and Looks remain in view when palettes are hidden.



Windows Paper Palette Command

Many of Painter's tools interact with paper grain.

To select a paper texture:

1. Choose Windows: Paper Palette.

2. Scroll to find the paper texture you'd like.

3. Click on its picture. As in the Brush Palette, the selected paper texture has a black line around its 
picture and its name appears below.

Painter provides several paper libraries.

To access a different paper library:

1. Click on the zoom box to expand the window.

2. Click on the Library button.

3. Double click on the name of the paper library you desire. You'll see a new set of textures when you 
scroll through the    palette.

The paper you choose applies only to individual strokes, not to the entire image. This means that you can 
use a different texture with every stroke you make. You can, however, apply paper texture to your overall 
image.



Windows Toolbox Command

Painter has a toolbox, but it is a bit different from the toolboxes in other graphics programs in that it 
doesn't hold the software's painting and drawing tools. As we mentioned, the tools reside in a separate 
window, the Brush Palette.

There is a brush tool, however, and clicking on it lets you use tools accessed in the Brush Palette.

The Toolbox also has what have become standard graphics tools -- the Magnifier or Zoom Tool, the 
Grabber, the Eye Dropper, the Selection Tool and the Paint Bucket.

Clicking on the Toolbox's zoom box reveals additional, not-so-standard tools.

Here's where you'll find tools that you'll use to create, move and rotate friskets, in addition to importing 
TrueType and Type 1 fonts as friskets.



Windows Zoom Factor Command

1. Choose Windows: Zoom Factor.

2. Scroll to the zoom factor you seek. You can see anywhere from 8.3% to 1200% of your image in 
Painter.

3. When you have highlighted the desired zoom factor, let go of the stylus or the mouse. In the title bar 
you'll see the percentage view of your image.



Effects Adjust Dye Concentration Command

You'll use Adjust Dye Concentration to adjust color intensity and to add surface texture. It can be used to 
lighten an underexposed photo, or to darken an overexposed one, since it works by adjusting pigments.

1. Select the area you'd like to adjust. Otherwise, Painter will adjust the entire image.

2. Choose Effects: Surface Control: Adjust Dye Concentration... The Adjust Dye Concentration dialog 
box appears.

3. In the Using menu:

Uniform Adjustment

Will adjust color without adding a texture.

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette.

Image Luminance

Creates texture based on the image's brightness.

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

4. Adjust the sliders.

When you choose Uniform Adjustment, moving the Maximum slider above 100% increases color density. 
A value below 100% decreases it. Moving the Minimum slider has no effect. With the other Using menu 
items selected, both sliders are operable.

Here's how the sliders work:

If you think of texture as peaks and valleys, the Maximum slider controls the dye on peaks and the 
Minimum slider controls dye in the valleys. You can set Maximum as high as 800%. The lower you set 
Minimum, which can be as low as 0%, the higher the contrast will be between peaks and valleys. The 
higher the Minimum slider, the flatter the paper will appear.

5. Click OK or press Enter.



Effects Apply Lighting Command

A new feature in Painter 2.0, Apply Lighting lets you establish one or more light sources of any color from 
any direction with any intensity for part or all of your image. Apply Lighting requires a floating point unit 
(FPU).

1. Select part of your image. Otherwise, Painter will apply lighting to your entire image.

2. Choose Effects: Surface Control: Apply Lighting...

In the upper left is a preview of how the changes you make in this dialog box affect your image. In the 
lower left is a scrolling palette of lighting choices that have been set up for you. The palette works like the 
Paper Palette and the Brush Palette. When you first open the dialog, Plain Light is selected, it has a black
line around it and its name appears under the scroll bar. Click in each of the choices and you'll see how 
they look in the preview.

3. After you find a lighting effect that appeals to you, click OK or press Enter and Painter will apply it to 
your image.



Effects Apply Marbling Command

This effect creates marbled patterns and is based on an actual technique of pulling on ink or pigment that 
floats on liquid in a pan called the Size. The marbling is achieved by dragging a rake through the liquid in 
various directions. The controls here are similar to those used by real-life marblers.

To marble your image:

1. Select part of your image or Painter will marble the entire image.

2. Choose Effects: Esoterica: Apply Marbling... The Apply Marbling dialog box appears.

3. The preview shows you the direction of the marbling, which you can change by clicking in the buttons 
on the right.

4. Adjust the sliders. Here's what they do:

Spacing

The space between rake teeth. The higher the spacing, the more dispersed the marbling will be.

Offset

How much the rake will shift each time it passes over the image. The higher the offset, the more complex 
the marbling effect looks.

Waviness

Determines how deep the waves are. The lower the amount, the flatter the waves will be.

Wavelength

Controls the wave's curve. You lengthen the curve's period    by moving the slider to the right.

Phase

Decides in which point in the wave's period it starts.

Pull

Controls how much the ink is pulled by the rake. The further the slider is to the right, the more intense the 
pull is. Changes in this slider aren't reflected in the preview's rake display.

Quality

You can improve the quality (anti-aliasing) of the marbling, but the further you move the slider to the right, 
the longer the marbling will take.

When you have completed your adjustments, click OK or press Enter.



Effects Apply Screen Command

Apply Screen is another way to add texture to your image. It combines luminance, the chosen paper 
texture in the Paper Palette and the three colors you pick in the Apply Screen dialog box to produce the 
textured effect. Apply Screen adds a three-color screen to your image.

To use Apply Screen:

1. Select an area. Otherwise, Painter will apply the screen to the entire image.

2. Choose Effects: Surface Control: Apply Screen... The Apply Screen dialog box appears.

3. Click on each square to call up the Windows Color Picker. Click on the color you prefer, then click OK 
or press Enter.

4. Moving the Threshold 1 slider determines how much of the top and middle squares' color will be in the 
image. Moving it to the left increases the amount of the top color, moving it to the right increases the 
amount of the middle color.

5. Moving the Threshold 2 slider determines how much of the middle and bottom squares' colors will be in
the image. Moving the slider to the left increases the amount of the middle color, moving it to the right 
increases the amount of the bottom color.

6. In the Using menu:

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette (if the Paper Palette is already 
open, different textures may be chosen while Apply Screen dialog is open).

Image Luminance

Creates texture based on the image's brightness. Similar to a three-level posterization.

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

7. Click OK or press Enter.



Effects Apply Surface Texture Command

Another Painter sleight of hand is the ability to add a three-dimensional surface texture to your image. 
You'll use this option for something as simple as adding a paper texture or a complex move like creating 
an oil painting.

Adding a Paper Texture

1. Choose a paper grain in the Paper Palette that you would like to add to your image. 

2. Select a portion of your image. Otherwise, Painter will apply surface texture to the entire image.

3. Choose Effects: Surface Control: Apply Surface Texture... The Apply Surface Texture dialog box 
appears.

4. Choose Paper Grain in the Using pop-up menu. You'll see in the preview that the paper you chose in 
the Paper Palette now covers your image (if the Paper Palette is already open, different textures may be 
chosen while Apply Surface Texture dialog is open).

5. Moving the Amount slider controls how much surface texture is applied to the image, and when the 
slider is all the way to the right, the maximum amount is applied.

6. Check Shiny for a tinselly, aluminum-foil effect.

7. Clicking in the buttons above Light Direction changes highlight and shadow locations.

8. When the preview shows the image is the way you want it to be, click OK or press Enter.

Note: We have been asked if you can apply a paper texture when you first create an image and then 
paint or draw over it. You can, but the paper is erasable, which is good if you want to make changes to the
paper, but not good if you only want to edit a stroke and not the paper. Generally you'll add the paper 
texture as the last step, not the first step, in developing your image.

The next question usually is how do you create brush strokes that show the paper texture. The answer is 
that the brushes that react to paper grain pick up the texture that you choose in the Paper Palette, not the 
paper that you add using Apply Surface Texture. 

Image Luminance

Follow the above steps except choosing a paper texture, and in the Using menu choose Image 
Luminance instead of Paper Grain. Painter uses the image's brightness to determine where to add 
surface texture.

Using Menu Choices

The 3D Brush Strokes item makes brush strokes appear to be three-dimensional, giving them the illusion 
of oil paints (the difference between the clone and the original becomes 3D texture). Original Luminance 
gives you an embossing effect. These two choices only work in a cloned image and are dim if you are 
working in an original image.

The Frisket choice produces surface texture around the edges of a frisket.



Effects AutoClone Command

Using a cloner brush can start to take a lot of time if you're working on a large area, and sometimes you 
might want Painter to do the strokes for you.

To fill in a cloned area automatically:

1. Select the tool you'd like to clone with. AutoClone works best with the Driving Rain Cloner and the 
Seurat tool. Don't forget to check the Use Clone Color box in the Brush Palette if you want the Seurat tool
to pick up color from the source document.

2. Select all or part of your image.

3. Select Effects: Esoterica: AutoClone.

Painter will apply dabs of paint automatically to the selected area in five-second intervals. To vary the 
color of the dots more, move the ±H, ±S and ±V Color Variability sliders in the Color Palette to the right to 
15% each.

4. When the right amount of the clone has filled in to suit your design, shut off AutoClone by clicking 
anywhere in the image area.

5. Choose Edit: Deselect (Ctrl+D).

Note: If you apply AutoClone to a big area, the paint may fill smaller rectangular tiles one at a time. If you 
click to stop the AutoClone, it will stop where it left off. It won't automatically finish the final tile of the 
overall selected area. To fill in non-rectangular areas, you can use AutoClone with friskets.



Effects Auto VanGogh Command

In Painter 2.0 it's possible to automatically re-render an image with the multi-colored brush strokes that 
were Vincent Van Gogh's signature artistic style. That is, you can choose the Artists brush variant Auto 
Van Gogh with this command. Painter will fill in the brush strokes for you.



Effects Blobs Command

This effect is similar to marbling in that it involves making a pattern in paint floating on liquid in a pan. It 
takes whatever you copy (or uses the current color if Clipboard is empty) and puts it in a swirling pattern 
by placing blobs into the liquid image. Called a Stone pattern, this is used as a starting point in marbling. 
Blobs requires a floating point unit (FPU).

To use Blobs:

1. The first time you try this effect, select a recognizable element.

2. Choose Edit: Copy (Ctrl+C).

3. Select a 2-inch square blank area in your image.

4. Choose Effects: Esoterica: Blobs... The Create Marbling Stone Pattern dialog box appears.

5. The first field is number of blobs. For this test, enter 20.

6. Min Size and Max Size designate blob size. For now, set Min Size at 50 and Max Size at 60.

7. Subsample creates the anti-aliasing steps. Enter 8 for this test.

8. Click OK or press Enter. You'll see a swirling pattern using the element you copied.

Hint: Try using a circular frisket shaded like a sphere (instead of a recognizable element) using the 
Airbrush before choosing Edit: Copy.



Effects Brightness/Contrast Command

The Brightness/Contrast window adjusts the contrast and brightness of your overall image in the RGB 
format, whereas Adjust Dye Concentration converts the image to a dye density domain and adjusts it 
there. To adjust the RGB contrast and brightness of your image or of a portion of the image:

1. Select part of your image. Otherwise, Painter applies Brightness/Contrast adjustments to the entire 
image.

2. Choose Effects: Tonal Control: Brightness/Contrast...

3. Click and drag in the upper slider to adjust image contrast.

4. Click and drag in the lower slider to adjust image brightness.

The image is redrawn when you let up on your mouse or stylus.

You can reset the sliders to normal by clicking the Reset button. To save your changes, click Apply.



Effects Color Overlay Command

Use Color Overlay to add color and texture to your image at the same time.

1. Select the color you'd like to fill the area with.

3. Select the area you'd like to fill. Otherwise, Painter applies Color Overlay to the entire image.

4. Choose Effects: Surface Control: Color Overlay....

5. Decide on a model.

Dye Concentration means the paper absorbs the color.

Hiding Power means the color covers what's beneath it. 

6. Move the slider until the preview reflects your preferred opacity.

7. In the Using Menu:

Uniform Color

Will add a flat tint to your image.

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette (if the Paper Palette is already 
open, different textures may be chosen while Apply Color dialog is open).

Image Luminance

Creates texture based on the image's brightness.

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

8. Click OK or press Enter.



Effects Distort Command

This menu item lets you contort the shape of a selection. To do so:

1. Select part of your image.

2. Choose Effects: Orientation: Distort.... You'll see two things happen. The selection now has handles 
around it, and the Distort Selection dialog box appears.

3. Click and drag on the handles to reshape the selection.

4. Check the Better (Slower) box if you'd like a more accurate rendering of your changes, although it will 
take longer. Checking this box is particularly useful in highly distorted cases.

5. Click OK or press Enter. You'll see a dialog box telling you Painter is distorting your selection. The 
image is left floating until it is de-selected.



Effects Enforce Printable Colors Command

If you forget to check Printable Colors Only before you paint part or all of your image, you can go in after 
the fact and change the colors to printable colors.

Here's how:

1. Select part of your image. Otherwise, Painter will apply printable colors to the entire image.

2. Choose Effects: Tonal Control: Enforce Printable Colors... The Enforce Printables dialog box 
appears.

3. Click OK or press Enter.



Effects Equalize Command

The Equalize effect improves contrast, adjusting black and white points and distributing the pixels' 
brightness levels throughout the entire range of available brightness levels. To achieve this, Painter 
creates a histogram showing the number of pixels for each brightness level value. Equalize allows 
gamma adjustment, which lightens or darkens an image without changing highlights or shadows.



Effects Fill Command

The Fill item in the Effects menu is an alternative way to change a selection's color.

1. Select the color in the Color Palette that you'd like to fill the area with.

2. Select part of your image. Otherwise, Painter will fill your entire image.

3. Choose Effects: Fill (Ctrl+F). The area is now the color in the Primary Color Rectangle.



Effects Flip Horizontal Command

To flip an image horizontally:

1. Select part of your image. Otherwise, Painter will horizontally flip your entire image.

2. Choose Effects: Orientation: Flip Horizontal.

3. Your selection is now the mirror image of itself.



Effects Flip Vertical Command

To flip an image vertically:

1. Select part of your image. Otherwise, Painter will vertically flip your entire image.

2. Choose Effects: Orientation: Flip Vertical.

3. Your selection is now the vertical mirror image of itself.



Effects Glass Distortion Command

Using this effect, another bit of Painter magic, you can put your image behind glass.

1. Select part of your image. Otherwise, Painter will distort your entire image.

2. Choose Effects: Focus: Glass Distortion. The Glass Distortion dialog box appears.

3. Adjust the Amount slider. The further you move it to the right, the more distorted your image will be.

4. Adjust the Variance slider. The further you move it to the right, the more your image will break up, kind 
of like glass shattering.

5. In the Using menu:

Paper Grain

Will produce texture based on a paper you choose in the Paper Palette.

Image Luminance

Creates texture based on the image's brightness.

3D Brush Strokes

Creates three-dimensional texture by comparing the difference between the source document and the 
cloned document. 

Original Luminance

Adds texture in a cloned image based on the source document's brightness. 

Frisket

Adds texture around a Frisket.

6. Click OK or press Enter.



Effects Grid Paper Command

Using Grid Paper in the Effects menu, you can add horizontal or vertical lines or a grid to part or all of 
your image that is fully editable and blendable with the rest of your design. The idea is the same as Grid 
Overlay. The difference is that Grid Overlay is a transparent, non-printing layer that floats above your 
image like Tracing Paper. Grid Paper, on the other hand, is an effect that becomes part of your image.

To add Grid Paper:

1. Select part of your image. Otherwise, Painter will apply Grid Paper to your entire image.

2.    Select Effects: Esoterica: Grid Paper. The Grid Options dialog box appears.

3. Set the following:

Grid Format

Click and hold on the pop-up menu to determine whether your grid will have squares, vertical lines or 
horizontal lines.

Horiz. Spacing

Determines the amount of space between horizontal lines.

Vert. Spacing

Determines the amount of space between vertical lines.

Line Thickness

Sets the width of grid lines.

Grid Color

Click on the color square to change the color of the grid lines. Choose a color in the Color Picker, then 
click OK or press Enter.

Background

Click on the color square to change the grid's background color. Choose a color in the Color Picker, then 
click OK or press Enter.

4. Click OK or press Enter.



Effects Highpass Command

Highpass suppresses low frequency areas containing gradual or smooth transitions of brightness levels. 
This leaves high frequency areas, or just the edges of an image, containing stark shifts between 
brightness levels. You can make the Highpass more pronounced by using the Equalize command.

To use Highpass:

1. Select an image area. Otherwise, Painter highpasses the entire image.

2. Choose Effects: Esoterica: Highpass... The Highpass dialog box appears.

3. The Radius slider determines the amount that the low frequency areas will be suppressed. This value 
defines a radius in pixels around each pixel in the selected image area. With the slider to the left, larger 
amounts of low frequency information are suppressed; with the slider to the right, smaller amounts of low 
frequency information are suppressed.

4. Click OK or press Enter.



Effects Motion Blur Command

Makes your images appear as if it has been blurred by movement or the panning of a camera.

1. Select an area. Otherwise, Painter puts the whole image into motion.

2. Choose Effects: Focus: Motion Blur...

3. Set the following sliders:

The further the Radius slider is to the right, the faster the image will appear to be moving.

Angle sets the direction in which the image seems to travel.

Thinness blurs the image in a direction perpendicular to the angle you choose with the Angle slider.

4. Click OK or press Enter.



Effects Negative Command

Choose Effects: Tonal Control: Negative to turn part or all of your image into a negative.



Effects Plug-in Filters Command

Here's where you access third-party plug-ins from within a document:

1. Select all or part of your image.

2. Choose Effects: Plugin Filters.

3. You will see a list of your plug-ins. You can now use them to edit your image.



Effects Posterize Command

To adjust the number of color levels in your image:

1. Select part of your image. Otherwise, Painter posterizes the entire image.

2. Select Effects: Tonal Control: Posterize.... The Posterize dialog box appears.

3.    Enter a number of levels. The lower the number you enter, the more dramatic the effect will be.

4.    Click OK or press Enter.

Note: To posterize an image combined with a paper grain, use Apply Screen. To posterize to two levels 
and adjust the threshold level, use Equalize.



Effects Rotate Command

To rotate a selection:

1. Select part of your image. Otherwise, Painter will rotate your entire image.

2. Choose Effects: Orientation: Rotate... The Rotate Selection dialog box appears.

3. Enter the angle you'd like or click and drag on a corner of your selection. The numerical value of the 
angle is reflected in the Rotate Selection dialog box.

4. Click OK or press Enter.    The image is left floating until it is de-selected.



Effects Scale Command

Scale lets you change the dimensions of part or all of your image.

1. Select part of your image or Painter will scale the entire image.

2. Choose Effects: Orientation: Scale...

3. Either click and drag on your selection handles or enter the percentages that you'd like to increase or 
decrease your selection by.

4. Check Constrain Aspect Ratio to maintain your selection's proportions. Unchecking this item lets you 
change horizontal and vertical measurements independently.

5. Checking Preserve Center keeps the item anchored in its location.

6. Click OK or press Enter. The image is left floating until it is de-selected.



Effects Sharpen Command

This effect heightens contrast by intensifying highlights and shadows.

To sharpen:

1. Select part of your image. Otherwise, Painter sharpens the entire image.

2. Choose Effects: Focus: Sharpen...

Radius

How much of the edge of an element is affected is determined here. The further the slider is to the right, 
the wider the affected area will be.

Highlight

Determines the intensity of the bright areas. The further the slider is to the right, the brighter the highlight 
will be.

Shadow

Determines the depth of the shadows. The further the slider is to the right, the darker the shadows will be.



Effects Soften Command

This effect increases the transition from one part of your image to another, enhancing the anti-aliasing of 
strokes.

1. Select an area. Otherwise, Painter softens the entire image.

2. Choose Effects: Focus: Soften.... The Soften dialog box appears.

3. The further the slider is to the right, the more steps there will be between one image element and 
another, which will mean more blurring. 

4. Click OK or press Enter.



Effects Video Legal Colors Command

Painter 2.0 also has the ability to set up colors for use in video.

1. Select part of your image. Otherwise, Painter will make all colors legal for video.

2. Choose Effects: Tonal Control: Video Legal Colors... The Video Legal colors dialog box appears.

3. Click OK or press Enter.

Painter supports both the NTSC (U.S.) and PAL (European) video systems, selectable in the System pop-
up menu in the Video Legal Colors dialog box.

Only bright yellows and cyans are not video legal.





Painter Keys

The keyboard topics below describe what keyboard equivalents are provided in Painter.    Choose from 
the following list to review these keys:

      Menu Keys  
      System Keys  
      Window Keys  
      Painter Keys  



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.

Letter key Chooses the menu, or menu item, whose underlined letter matches the 
one you type.

Alt+letter key Pulls down the menu whose underlined letter matches the one you type.

LEFT or RIGHT ARROW Moves among menus.

UP or DOWN ARROW Moves among menu items.

Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are using.

Key(s) Function

Ctrl+Esc Switches to the Task List.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are 
running as icons.

Alt+PrtSc Copies the entire screen to Clipboard.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.

ALT+Hyphen Opens the Control menu for a document window.

Alt+4 Closes a window.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are 
running as icons.

Alt+ENTER Switches a non-Windows application between running in a window and 
running full screen.

DIRECTION key Moves a window when you have chosen Move from the Control menu.
Or, changes the size of a window when you have chosen Size from the 
Control menu.



Painter Keys

Key(s) Function

Ctrl+[ Records brush stroke.

Ctrl+] Plays back brush stroke.

Ctrl+\ Stops play back of brush stroke.

Ctrl+/ Choose last-used effect.

Ctrl+; Chooses second-to-last-used effect.

Ctrl+- Opens/closes Brush Looks window.

Ctrl+A Select All.

Ctrl+C Copy.

Ctrl+D Deselect.

Ctrl+F Fill.

Ctrl+G Turns on/off Grid Overlay.

Ctrl+H Hides/shows open palettes.

Ctrl+K Activates/deactivates Freehand drawing mode.

Ctrl+L Activates/deactivates Straight Line drawing mode.

Ctrl+M Full Screen Mode toggle.

Ctrl+N Opens New Picture Size dialog.

Ctrl+O Opens file directory.

Ctrl+P Opens Print dialog.

Ctrl+Q Exits Painter.

Ctrl+R Reselect.

Ctrl+S Opens Save dialog.

Ctrl+T Turns on/off Tracing Paper.

Ctrl+V Paste.

Ctrl+W Closes the Edit Window.

Ctrl+X Cut.

Ctrl+Z Undo.

Ctrl+1 Opens/closes Toolbox.

Ctrl+2 Opens/closes Brush Palette.

Ctrl+3 Opens/closes Color Palette.

Ctrl+4 Opens/closes Brush Size window.

Ctrl+5 Opens/closes Brush Behavior Window.

Ctrl+6 Opens/closes Paper Palette.

Ctrl+7 Opens/closes Expression Palette.



Ctrl+8 Opens/closes Brush Stroke Designer window.

Ctrl+9 Opens/closes Frisket Palette.

Ctrl+0 Opens/closes Fill Palette.





Buildup Methods

The Buildup methods all add color density to an image as you draw, as with dyes. Use lighter colors when
you draw to cut down on the amount of buildup. Adjust the amount of dye using the Concentration slider.



Soft Buildup

Use for non-grainy applications. Applies a smooth spread of dye on the image. Penetration has no effect 
on this method.



Grainy Soft Buildup

Rubs dye like a thin wax onto the image, and looks burnished into the grain.

Penetration has no effect on this method.



Grainy Edge Flat Buildup

Applies dye-like crayon strokes onto the image. The hard edge comes from the grain and the Penetration 
slider controls the amount of crayon that touches the tips of the grain.



Grainy Hard Buildup

Applies dye like a colored pencil, with a semi-anti-aliased grainy edge. The Penetration slider controls the 
amount of pencil tip that touches the peaks of the grain.



Soft Variable Buildup

Applies dye like a felt pen. The Penetration slider provides an exaggerated control over the thickness of 
dye deposited.



Cover Methods

Cover methods apply paint to partially or totally cover the image where you draw. Except for Grainy Edge 
Flat Cover, the Concentration slider controls the opacity of the stroke. These methods are used for chalk, 
charcoal, oil paints, spray paints, acrylics, and all other media that can hide what they are applied to with 
a solid color.



Flat Cover

A hard edge is generated with this brush. The stroke is filled with color flatly. Warning: this method 
generates computery-looking, aliased strokes. Penetration has no effect on this method.



Soft Cover

A soft edge is generated with this brush. Similar to an airbrush with an infinitely fine spray. Penetration 
has no effect on this method.



Grainy Flat Cover

A cloudy flat-edged stroke is produced using this method. Penetration has no effect on this method.



Grainy Soft Cover

A cloudy stroke, similar to burnished chalk is produced using this method. Penetration has no effect on 
this method.



Grainy Edge Flat Cover

A hard-edged grainy stroke is produced using this method. This is good for making acrylic paint on a 
brush with rough paper. The Penetration slider controls the amount of the grain that the brush tip comes 
in contact with. The Concentration slider has no effect on this method.



Grainy Hard Cover

A somewhat grainy stroke is produced using this method. This is good for chalk. The Penetration slider 
controls the amount of the grain that the chalk comes in contact with.



Soft Paper Color

This method draws using the paper color (as defined for the document in the New Picture Size dialog 
box). The new stroke covers the old stroke. The Concentration slider is used to control the opacity of the 
new stroke with this method.



Soft Paint Remover

This method causes strokes to remove density from the image, tending toward white. The saturation of 
the color is preserved in this operation. It works like bleach, erasers, or anything that can be used to 
remove deposited pigment from an image. This method is used for photographic dodging as well. The 
Concentration slider controls the amount of the image which is removed.



Soft Paint Thickener

This method causes strokes to increase the existing density of the image, tending toward strong saturated
colors and black. The saturation of the color is increased during this operation. This method is used for 
photographic burning operations. The Concentration slider controls the amount of dye or pigment 
increase.



Soft Mask Colorize

This method draws in strokes that cover the underlying strokes. The color of the stroke is a mixture 
between the primary and secondary colors, determined by the frisket. This is useful in coloring cartoon 
cels.



Drip Methods

Drip methods pull the image around like a liquid. For these methods, the Concentration slider controls the 
amount of additional paint applied as well (using cover). Also, the Penetration slider controls the amount 
of pull (distortion) effect that the brush has on the image.



Drip

Applies a smooth distortion of the image in the direction of your stroke.

Useful in spreading and pushing images around like taffy, with a soft result.



Hard Drip

Applies a coarse distortion of the image in the direction of your stroke. Useful in spreading and pushing 
images around like taffy with a hard textured result.



Grainy Drip

Applies a smooth distortion of the image in the direction of your stroke. The grain affects the distortion, 
producing traces of the grain in the stroke direction. Useful in producing clean, bristled brush look.



Grainy Hard Drip

Applies a coarse distortion of the image in the direction of your stroke. The grain affects the distortion, 
producing traces of the grain in the stroke direction. Useful in producing jaggy, bristled brush look.



Cloning Methods

Use Cloning methods to bring textures and snippets of an image from an original image into a clone 
image. You must be working in a clone, with the original still open, to work with a brush that uses this 
method. Combine these methods with random cloning to get more complex image textures. For these 
methods, the Concentration slider controls the amount of opacity of the strokes.



Hard Cover Cloning

This method paints with the original image into the clone image, creating hard-edged strokes. The 
Concentration slider controls the opacity of the stroke. The Penetration slider has no effect on this 
method.



Soft Cover Cloning

This method paints with the original image into the clone image, creating soft-edged strokes. The 
Concentration slider controls the opacity of the stroke. The Penetration slider has no effect on this 
method.



Grainy Hard Cover Cloning

This method paints with the original image into the clone image, creating semi-anti-aliased strokes like a 
magic form of chalk. The Concentration slider controls the opacity of the stroke. The Penetration slider is 
used to control the amount of the paper grain that this tool comes in contact with.



Grainy Soft Cover Cloning

This method paints with the original image into the clone image, creating cloudy strokes like a magic form 
of burnished charcoal. The Concentration slider controls the opacity of the stroke. The Penetration slider 
has no effect on this method.



Drip Cloning

This method paints with distorted image parts of the clone.



Wet Methods

These methods work exclusively in the Wet Layer. You must choose Options: Wet Paint before using a 
brush that employs one of these methods. Use the Wet Fringe slider in the Brush Behavior window to 
control the darkness of the water color stroke fringes. Use the Diffuse Amount slider to control the amount
of feathering of the water-color strokes due to over-wetting the brush. The color deposited in the wet layer
serves to increase the image density.



Grainy Wet Abrasive

Deposits color into the Wet Layer, so you are required to turn on Wet Paint before working with a brush 
that uses this method. The strokes replace the color beneath them, providing a lighter color mix than 
Grainy Wet Buildup.



Grainy Wet Buildup

Deposits color into the Wet Layer, so you are required to turn on Wet Paint before working with a brush 
that uses this method. The strokes build up over the color beneath them, providing a true water-color feel.



Wet Remove Density

Removes color from the Wet Layer, so you are required to turn on Wet Paint before working with a brush 
that uses this method. This can be used to construct erasers in the Wet Layer (something that is usually 
impossible with traditional water color).



3D Brush Strokes

The difference between the clone image and the original image. After cloning with a brush, this becomes 
a texture-dependent upon the brush strokes.



Adjust Dye Concentration

In the Effects menu. Use Adjust Dye Concentration to adjust color intensity and to add surface texture. It 
can be used to lighten an underexposed photo, or to darken an overexposed one. Provides control over 
the optical density of the image.



Anti-Aliased

Brush strokes are said to be anti-aliased when the transition between them and the adjacent image is 
smooth and without noticeable jaggies (stair steps). Anti-aliased images use intermediate levels of color 
to smooth out a hard edge.



Apply Screen

In the Effects menu. Apply Screen is another way to add texture to your image. It adds image luminance 
to another value, such as the current paper texture or original luminance. The result is thresholded to 
produce a posterization of the image in three colors.



Apply Surface Texture

In the Effects menu. Adds a three-dimensional surface texture to your image. You'll use this option for 
something as simple as adding a paper texture to a complex move like creating an oil painting.



Bitmap

An image formed by a matrix of rectangular dots. On a computer screen, the dots are called pixels. Each 
pixel has its own color. Unlike vector objects or Bezier curves, bitmaps are resolution dependent.



Bleed

Bleed is the amount of color picked up off the image and controlled by the Bleed slider in the Brush 
Behavior window. Moving the slider to the right increases bleed, moving it to the left reduces bleed.



Brightness

The variance of a color from dark to light resulting from an increase or decrease in illumination.



Brush

All of Painter's painting and drawing tools are called brushes. They are accessed in the Brush Palette.



Brush Behavior Window

Controls space between the brush dabs that together combine to form a brush stroke. Also controls how 
colors will mix together on-screen.



Clone

(n.) Copy of an image.

(v.) Make a copy of an image.



Clone Document;

Copy of a document.



Cloner
A brush in the Brush Palette that clones an image transferring colors from the original into the clone.



Color Overlay

In the Effects menu. Lets you add a tint and paper texture to an image. Also used for shadowing effects.



Color Palette

Choose brush stroke and image-editing colors in the Color Palette.



Color Ramp

A blend of the primary and secondary colors in the Color Palette. Used with the Color Ramp radio button 
in the Fill Palette.



Color Squares

Pre-set default colors for each brush. Located on the right-hand side of the Color Palette. Clicking on a 
square automatically chooses a predominant hue in the triangle, and shows you that color. A square can 
also contain color variability. Option-click to set the color of a square.



Comp

Comprehensive or composite artwork -- a layout combining type, graphic and photographic material, used
for presentations, usually by advertising agencies to clients.



Concentration

Concentration, controlled by the Concentration slider in the Brush Palette, works in one of two ways, 
depending on the brush's method. In the case of buildup brushes, moving the Concentration slider to the 
left makes strokes less intense in color, moving it to the right makes them oversaturate to primary colors 
or black.

As for cover brushes, moving the Concentration slider to the left will make strokes more transparent, 
moving it to the right will make them more opaque.



Contiguous Pixels

All similar-colored pixels next to the pixel you click on when using the Paint Bucket and the Fill Palette. 
Click and drag with the paint bucket over the set of colors you want to fill.



Continuous Tone Image

An image that consists of an infinite range of gray levels or colors that has not been broken down into 
halftone dots or any other method of simulating tones.



Contrast

The tonal spread between the lightest and darkest areas of an image.



Dot Gain

The difference paper absorption causes between the printed dot area and the film dot area for a 50% dot 
on film.



Equalize

In the Effects menu. Improves contrast, adjusting black and white points and distributing the pixels' 
brightness levels throughout the entire range of available brightness levels in an image.



EPS

Encapsulated PostScript. File format supported by page-layout programs and vector-type draw programs.



Expression Palette

Determines the way Painter's brushes will react to a mouse or stylus.



Fade

A partial undo of the most recent operation, making the results of that operation transparent.



Feathering

The softening of an edge by defocusing or diffusion.



Frisket

A mask placed on artwork to shield certain areas during painting or retouching. Also, a selection defining 
an irregular area, such as text.



Gamma

Brightness. Painter uses the Brightness slider in the Brightness/Contrast dialog box for adjusting image 
gamma.



Halftone

A process by which continuous tone images are simulated by a matrix of dots of varying size, or lines of 
varying thickness. Smaller dots represent lighter parts of the image; larger dots represent darker parts. 
Painter can print halftones on PostScript-compatible printers such as the LaserWriter and Linotronic 
series of imagesetters.



Halftone Resolution

The spacing of the dot matrix in a halftone image, usually measured in lines per inch (lpi).



Highlights

The lightest parts of an image.



Highpass

In the Effects menu. Suppresses low frequency areas containing gradual or smooth transitions of 
brightness levels.



HSV

Natural color system that stands for Hue, Saturation and Value, where perceptual quantities such as 
predominant color and lightness are controlled separately.



Image Buffer

The amount of your computer's RAM (random access memory) available to hold an image and the 
system/application instruction set--effectively, the area of an image that can be displayed and edited at 
one time.



Jitter

This is the randomness of brush dabs that together make up brush strokes. What will determine jitter is 
controlled in the Jitter pop-up menu in the Expression Palette. How much jitter a stroke will have is 
determined in the Dab Location Variability Amount slider in the Brush Behavior window.



LPI

Lines per inch--the units in which halftone resolution (screen frequency) is measured. The term comes 
from the original process used to create a halftone screen by etching lines vertically and horizontally on a 
glass plate. This was then used to expose a photographic film. The intensity of light passing through the 
intersections of the lines determined the size of the dot; the spacing of the etched lines determined the 
frequency.



Luminance

The amount of light emitted by a visual display. Luminance is a measure of combined lightness and 
brightness.



Method

Determines the nature of Painter's brush strokes. Method determines: if the edges will be smooth, jagged 
or somewhere in between; if they'll muddy to black or become opaque; if they'll paint, smear, erase, clone 
or darken; and if they will interact with paper grain.



Mid-tones

A printing term used to define those parts of the image with colors of intermediate value--that is, areas 
with 25%-75% value range.



Min Spacing

The Min Spacing slider in the Brush Behavior window specifies the minimum spacing in pixels between 
dabs of paint along the brush stroke. The effect of moving the slider to the right is to space out paint dabs,
giving you a dotted line.



No. of Bristles

Moving the No. of Bristles slider in the Brush Behavior window to the right increases the hairs in bristle 
brushes.



Original Luminance

The luminance (brightness) of the original image, when used in the clone image.



Overlapping Rectangles

In the Color Palette, display the primary and secondary colors that form brush strokes when the Color 
pop-up menu in the Expression Palette has been activated. Also used to determine the color ramp in the 
Fill Palette.



Paper Palette

Holds Painter's paper textures.



Penetration

In the Brush Palette, the Penetration slider controls how much paper texture will show through brush 
strokes made by brushes with the word grainy in their method. Moving the slider to the right will cause the
stroke to penetrate paper more, resulting in a darker appearance. Moving the slider to the left will reveal 
more paper texture.



Pixels

Short for picture elements, which are dots that together form a digital image on a computer monitor.



Plug-ins

Software programs that work with PhotoShop to drive scanners and printers, allow additional file format 
support and offer special-effects filters. Also applies to Aldus Gallery Effects. Plug-ins can be accessed 
and used in Painter.



Posterize

In the Effects menu. Adjusts the number of color levels in an image.



PostScript

A system of describing graphic and typographic elements on a page, developed by Adobe Systems Inc. 
PostScript files are device-independent--they can be used with any compatible printing or typesetting 
device, regardless of its resolution.



PrsPower

Pressure Power slider in the Set Scaling dialog box determines the amount of effort required within the 
range you set in the Pressure Scale to achieve a stroke.



PrsScale

The Pressure Scale slider in the Set Scaling dialog box determines the maximum amount of pressure you
can get out of your stylus.



Resaturation

Resaturation is the amount color is replenished in a stroke. Moving the Resaturation slider in the Brush 
Behavior window to the right will increase resaturation, making the color last longer through the stroke, 
moving it to the left will reduce resaturation, causing the stroke to run out of color sooner.

 



Resolution

The degree of fineness of image reproduction--normally measured in elements per unit, for example dots 
per inch (dpi), pixels per inch or lines per inch (lpi). Computer screens usually have a relatively low 
resolution, such as 72 dpi. A laser printer has a higher resolution, typically from 300 to 600 dpi. 
Imagesetting machines have still higher resolution, from 1200 to 3500 dpi. A resolution-independent 
image is one capable of being printed on any compatible device while taking advantage of the highest 
available resolution on that device.



RGB

Additive color system that stands for red-green-blue where combining colors adds up light.



Screen

A film-based plastic sheet with a matrix of dots used to create halftones in traditional graphic arts. The 
screen is placed over a continuous-tone image when it is photographed to separate the colors into 
variable dots or lines. PostScript simulates the screening process.



Screen Angle

The angle at which a halftone screen rests on an image. The typical angle is 45°.



Screen Frequency

Represents the fineness of a halftone screen. This grid is measured in lines per inch (lpi). The higher the 
lpi is, the crisper the image is.



Shadows

The darkest parts of an image--those with values ranging from approximately 75% to 100%.



Sharpen

In the effects menu. Heightens contrast by intensifying highlights and shadows.



Size

In the Brush Size window, the Size slider affects brush stroke width. Moving it to the right widens brush 
strokes, moving it to the left makes them more narrow.



Soften

In the Effects menu. Increases the transition from one part of image to another, enhancing the anti-
aliasing of strokes.



Spectrum Slider

Key to the Color Palette. Lets you select predominant hues.



Spot

On an imagesetting machine, the basic printed marks, traditionally called dots, out of which images are 
formed. In Painter, spot choices include round, line, ellipse and custom.



Triangle

Located in the Color Palette, offers all the available colors within a predominant hue.



Use Clone Color

Located in the Color Palette, when checked, turns a non-cloning brush into a cloner.



Variant

Variation of a brush, accessed in the Variant pop-up menu in the Brush Palette. Variants are mixtures of 
Painter's customizing features.



Vel Power

The further the Velocity Power slider in the Set Scaling dialog box is to the left, the easier it is to get a thin
stroke when you move your hand slowly.



Vel Scale

The further the Velocity Scale slider in the Set Scaling dialog box is to the right, the faster you have to 
move your hand to create a brush stroke.



Virtual Memory

The temporary storage of an entire file as a working file on a hard disk when the computer's image buffer 
is not large enough to display the entire file at once. This lets you display and work on images of any size,
with an immediate editable area determined by the size of the image buffer. Any operations that you apply
to the whole image will be computed to the working file.



Wet Fringe

A slider in the Brush Behavior window that adjusts the pooling of color in the edges of watercolor strokes 
in the wet layer.



Wet Layer

Water Color brush variants paint in the wet layer, activated by choosing Options: Wet Paint. To send 
watercolor strokes to the image layer choose Options: Dry (Ctrl+Y). Choose Options: Wet Paint again 
to shut off the wet layer.



Zoom Box

The little square in the upper right-hand corner of Painters' palettes. Sometimes called the grow box. 
Clicking on this square expands a palette and reveals its hidden contents.






